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Access Tutorial 1: Introduction to Microsoft Access

The purpose of these tutorials is not to teach you
Microsoft Access, but rather to teach you some
generic information systems concepts and skills
using Access. Of course, as a side effect, you will
learn a great deal about the software—enough to
write your own useful applications. However, keep in
mind that Access is an enormously complex, nearly-
industrial-strength software development environ-
ment. The material here only scrapes the surface of
Access development and database programming.

1.1 Introduction: What is Access?

Microsoft Access is a relational database manage-
ment system (DBMS). At the most basic level, a
DBMS is a program that facilitates the storage and
retrieval of structured information on a computer’s
hard drive. Examples of well-know industrial-strength
relational DBMSes include

* Oracle

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 24-Aug-1997

1. Introduction to Microsoft Access

« a full-featured procedural pro grammin g lan-
guage—essentially a subset of Visual Basic,

» a simplified procedural macro lan guage unique
to Access;

* arapid application development environment
complete with visual form and report develop-
ment tools;

* a sprinkling of objected-oriented extensions ;
and,

* various wizards and builders
ment easier.

to make develop-

For new users, these “multiple personalities” can be
a source of enormous frustration. The problem is
that each personality is based on a different set of
assumptions and a different view of computing. For
instance,
« the relational database personality expects you
to view your application as sets of data;

« Microsoft SQL Server
* |IBM DB2
* Informix

Well-know PC-based (“desktop”) relational DBMSes
include

« Microsoft Access

« Microsoft FoxPro

» Borland dBase

1.1.1 The many faces of Access

Microsoft generally likes to incorporate as many fea-
tures as possible into its products. For example, the
Access package contains the following elements:

« a relational database system that supports two
industry standard query languages: Structured
Query Language (SQL) and Query By Example
(QBE);

[Fone] [fmms] 1ol

Introduction: What is Access?

« the procedural programming personality expects
you to view your application as commands to be
executed sequentially;

« the object-oriented personality expects you to
view your application as objects which encapsu-
late state and behavior information.

Microsoft makes no effort to provide an overall logi-
cal integration of these personalities (indeed, it is
unlikely that such an integration is possible). Instead,
it is up to you as a developer to pick and choose the
best approach to implementing your application.

Since there are often several vastly different ways to
implement a particular feature in Access, recogniz-
ing the different personalities and exploiting the best
features (and avoiding the pitfalls) of each are impor-
tant skills for Access developers.

The advantage of these multiple personalities is that
it is possible to use Access to learn about an enor-
mous range of information systems concepts without

20f17
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1. Introduction to Microsoft Access

having to interact with a large number of “single-per-
sonality” tools, for example:
* Oracle for relational databases
» PowerBuilder for rapid applications development,
» SmallTalk for object-oriented programming.

Keep this advantage in mind as we switch back and
forth between personalities and different computing
paradigms.

1.1.2 Whatis in an Access database
file?

Although the term “database” typically refers to a col-
lection of related data tables, an Access database
includes more than just data. In addition to tables, an
Access database file contains several different types
of database objects :

» saved queries for organizing data,

« forms for interacting with the data on screen,

* reports for printing results,

Learning objectives

* macros and Visual Basic programs for extending
the functionality of database applications.

All these database objects are stored in a single file
named <filename>.mdb . When you are running
Access, a temporary “locking” file named <file-
name>.ldb is also created. You can safely ignore
the *.Idb file; everything of value is in the *.mdb file.

1.2 Learning objectives
O How do | get started?
O How do | determine the version | am using?
O How do | create or edit a database object?
O What is the database window and what does

it contain?
O How do | import an Excel spreadsheet?

O How do | delete or rename database objects?

[ M Home | [4Previous | 30f17
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O How do | get help from the on-line help
system?

O How do | compact a database to save space?

1.3 Tutorial exercises

In this tutorial, you will start by creating a new data-
base file.

1.3.1 Starting Access

« To start Access, you double click the Access icon
( for version 8.0 and 7.0 or

_ &3l for version
2.0) from within Microsoft Windows.

If you are working in the Commerce PC Lab, you will
be working with Access version 2.0. If you are work-
ing at home, you will able be to tell what version you
are using by watching the screen “splash” as the pro-
gram loads. Alternatively, select Help > About

Tutorial exercises

Access from the main menu to see which version
you are using.

All the screen shots in these tutorials are
taken from Access version 7.0 (released as
part of Office 95). Although there are some
important differences between version 2.0
and version 7.0, the concepts covered here
are the same for both. Version 8.0 (released
as part of Office 97) is only slightly different
from version 7.0.

2 Whenever the instructions given in the tutorial
differ significantly from version 7.0, a warning
box such as this is used.

1.3.2 Creating a new database

« Follow the directions in Figure 1.1 to create a
new database file called myfile.mdb

[ M Home | [4Previous |  40f17




1. Introduction to Microsoft Access

Tutorial exercises

FIGURE 1.1: Select the name and location of your new (empty) database.

&, Microsoft Access

File Tools Help

§|&|2‘ﬁ| i ||E\|“‘§|EIEH So| el EE =

File New Database

Sawve in: ICIWS Assignment

=] Bl Gl B [l

|

_1lmages SunivP_w2.mdb
% BOSC V2mdb

% BOSC W7 .mdb

%] Copy of univ_w?.mdh
] dumrmy_w7.mdhb

% Kitchen Supply Co.mdh
% product source.mdh
2 tut-1.mdh

S univl_w2 mdh

% univl_w? mdb

Create I

Mameal I

a2 Create a new database by seleckilg >
New from the main menu or by clicking the
“new database” button on the tool bar.

Type in a new database name and peEgger.

b Note that you are limited to 8-letter names in
version 2.0.

Imy’file

File name:

=~

Sawve as type: IMichsof‘t Access Databases * mdhb)

-
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» Examine the main features of the database win-
dow—including the tabs for viewing the different
database objects—as shown in Figure 1.2.

1.3.3 Opening an existing database

Since an empty database file is not particularly inter-
esting, you are provided with an existing database
file containing information about university courses.
For the remainder of this tutorial, we will use a file
called univ0_v7.mdb , which is available from the
tutorial’s Internet site.

If you are using version 2.0, you will need to

é use the univ0_v2.mdb  database instead.
Although you can open a version 2.0 data-
base with version 7.0, you cannot open a ver-
sion 7.0 database with version 2.0. Importing
and exporting across versions is possible,
however.

Tutorial exercises

If you are using version 8.0, you can use
either univ0_v2.mdb  or univ0_v7.mdb for
the tutorials. When you open the file, Access
will ask you if you want to convert it to version

8.0. Select yes and provide a new name for
the converted file (e.g., univ0_v8.mdb )

* Open the univ0_v x.mdb file and examine the
contents of the Sections table, as shown in
Figure 1.3.

1.3.4 Importing data from other

applications

Access makes it easy to import data from other
applications. In this section, you will create a new
table using data from an Excel spreadsheet.
* Select File > Get External Data > Import from the
main menu and import the depts.xls  spread-

6 of 17
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1. Introduction to Microsoft Access Tutorial exercises

FIGURE 1.2: The database window contains all the database objects for a particular application.

@ The database window is always
available from th&Vindow menu.

@, Microsoft Access

Tables — File Edit Wiew Inser Tools Windowe Help
contain data | )] Slmlv] b mle] ] | B g fa == m 2]
Modules —
columns. &= myfile : Database %%m%m Visual
Sl

B Tables | Oueriesl Farms | B Repur‘(sl & Macros | 8 Mudulesl procedures and
A

&l functions.
Queries — allow the pooe | _
information in Macros — are sets of high-
level commands that can be

tables to be sorted
— used to process data and

filtered, and shown S
in different ways. perform repetitive tasks.

Forms — are for Reports —are
displaying for organizing
information on and printing
the screen. information.
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FIGURE 1.3: Open the univO0_vx.mdb file for the version of Access that you are using and then
open the Sections table

[l Tools Help =2 SelectFile > Open Database @ You can open a
database object for
s viewing, for

New Database...

Open Database...

S modification, or
S create a new object.
8 e =0
g= univl_v7 : Database M=l E3
Tables | Oueriesl Farms | B Repur‘(sl b Macrusl o3 Mudulei
Catalog Yiew Open
Courses
Design
Select the Mew f
correct file an
open the H Sections : Table [_ O] =]
Sections Departmeni Course ni Section| Session |CatalogNul Term | Meeting days =
table. [COM 290 001 Sy 44411 10 W

COMM 290 002 94y 57455 1WF
2O 290 003 a4y 48516 1WF
2O 290 004 ady 71845 1MW
COMM 290 005 a4y 69495 1MF
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1. Introduction to Microsoft Access

sheet as a new table called Departments
Figure 1.4).

(see

In version 2.0, the menu structure is slightly
different. As such, you must use File > Import.

» Use the import wizard specify the basic import
parameters. You should accept all the defaults
provided by the wizard except for those shown in
Figure 1.5.

» Double click the Departments
was imported correctly.

table to ensure it

If you make a mistake, you can rename or
delete a table (or any database object in the
database window) by selecting it and right-
clicking (pressing the right mouse button
once).

Tutorial exercises

1.3.5 Getting help

A recent trend in commercial software (especially
from Microsoft) is a reliance on on-line help and doc-
umentation in lieu of printed manuals. As a conse-
guence, a good understanding of how to use the on-
line help system is essential for learning any new
software. In this section, you will use Access’ on-line
help system to tell you how to compact a database.
* Press F1 to invoke the on-line help system. Find
information on compacting a database, as shown
in Figure 1.6.
« Familiarize yourself with the basic elements of
the help window as shown in Figure 1.7.

1.3.6 Compacting your database

« Follow the directions provided by the on-line help
window shown in Figure 1.7 to compact your
database.

9 of 17
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FIGURE 1.4: Import the dept.xls

I|=@ Eclit “iew [nsert Tools Window Help
MNew Database...
Open Database...

Get External Data

Cloze
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spreadsheet as a table called Departments

Link Tahles...

e
Says As/Export..

hfodule]

ren_|

atabase Propedies...

pesign | Import

/

= SelectFile > Get External Data >

Import from the from the main menu
and move the directory containing the
file you want to import.

Backorders and Received xls
deplsxls g
Inverntory xls

hat match these criteria:

@ Double-clickdepts.xls . |
Advanced... |

‘b Select files of typé&.xls  (files
with that extension will show in

File name: I

~ the file window).
A/j I Xt O Bropery: | Id| Eing o |

Files of type: |Microsoft Excel (*xls)

F Last madified: Ianytime 'l Mew Search |

- Microsoft Access |
Mot 3l file N S 5]
Diata ACCESE Text Files (% tet® cav* tab™ asc)

b mdue? « |

other file types, run the Setup program, click Add/Remowve,
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1. Introduction to Microsoft Access

Tutorial exercises

FIGURE 1.5: Use the spreadsheet import wizard to import the Excel file.

B Import Spreadsheet Wizard H a

hicrosoft Access can use your column headings as field names for your table. Does the firs
specified contain column headings?
M First Row Contains Colurn Headings =

Select thdirst row contains
column headings option so
that the column headings in the
spreadsheet are not interpreted
as data.

B Import Spreadsheet Wizard [ X]
Microsoft Access recommends that you define a primary key for
== wour new table. A primany key is used o uniguely identify each
record inyour table. It allows vou to retrieve data mare quickly.
| BERRC R
g i © LetAccess add Primary Key.
DeptCode 2 i unm ' .
11Ok g Choose my own Primany Key. I j
|2]°RWR o
3ENGL i .
o \ Since we have not talked
[ShUSC about primary keys yet,
[EEDLIC DeptCode [DeptHame B selectno primary key.
| | 1COMM Fommerce and Business Administration BNGU =
| |ZICEWR Creative Writing BUCH
|3ENGL English EUCH
KIN [4hATH Math MATH
EMT TS nede BT TS
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Tutorial exercises

:
FIGURE 1.6: Use the help system to find

Type in the first few
=

Contents  Index |Find |AnswerWizard|

are looking for.

1 Type the first few of the word wou're looking for.

|comp

2 Click the index entry you want, and then click Display. b

comman field
CompactDatab
compacting databases .

compacting databases i
comparny logos

Compare
comparing dates in DAD = R s i e c
comparing strings ) "
comparing text
comparing walues
comparison operatars
compatibility with previow
@ Thelndex is the best place to @
start when you are looking for a
specific topic. If you need more

structured information or are :
- looking for an overview, use the Display | Cancel |

Contents tab. _
[ a—

the list (i.e., “compacting
databases”) and double-
click to get a list of topics.

e rnethod

Click a topic, then click Display.

Startup command-line options
Troukleshoot compacting databases

Select the best match from

letters of the topic you information on a specific topic

Double click the most
promising entry in this list
to get the actual help topic.

For most students, the help
system in Access version
2.0 is easier to navigate.
Use the “cue cards” in
version 2.0 to get step-by-
step instructions for many
operations.
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Tutorial exercises

FIGURE 1.7: Follow the instructions provided by help to compact your database

B Microsoft Access for Windows 95

Options

Help Topics Back

@ Minimize (rather than close) help
when you are working so that you can

Compact a database to defragment the
file and free disk spave

If wvou delete tables, your database can becorms
fragmented and use disk space inefficiently.
Compacting the database makes a copy of the
datahase, rearranging how the database file is stored
on disk.

environment, confirm that all users have closed
the database.

2 Onthe Toaols menu, point to Database Utilites,
and then click Compact Database.

3 Inthe Database To Compact From dialog box,
specify the database you want to compact.

4 Inthe Compact Database Into dialog box, specify

a name, drive, and folder for the compacted
database.

= use theBack button to return to
j previously visited topics without
repeating the search.

L @ Presshelp topics to return to the
index.

| @ Words underlined with a dashed line
provide important definitions.
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1.4 Discussion

1.4.1 The database file in Access

The term “database” means different things depend-
ing on the DBMS used. For example in dBase IV, a
database is a file (<filename>.dbf ) containing a
single table. Forms and reports are also stored as
individual files with different extensions. The net
result is a clutter of files.

In contrast, an Oracle database has virtually no rela-
tionship to individual files or individual projects. For
instance, a database may contain many tables from
different projects/applications and may also be
stored split into one or more files (perhaps on differ-
ent machines).

Access strikes a convenient balance—all the
“objects” (tables, queries, forms, reports, etc.) for a
single project/application are stored in a single file.

[ M Home | [4Previous |
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1.4.2 Compacting a database

As the help system points out, Access database files
can become highly fragmented and grow to become
much larger than you might expect given the amount
of data they contain (e.g., multiple megabytes for a
handful of records). Compacting the database from
time to time eliminates fragmentation and can dra-
matically reduce the disk space requirement of your
database.

1.4.3 Renaming a database

It is often the case that you are working with a data-
base and want to save it under a different name or
save it on to a different disk drive. However, one
command on the File menu that is conspicuous by its
absence is Save As.

However, when compacting your database, Access
asks for the name and destination of the compacted
file. As a result, the compact database utility can be
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used as a substitute for the Save As command. This
is especially useful in situations in which you cannot
use the operating system to rename a file (e.qg.,
when you do not have access to the Windows file
manager).

1.4.4 Developing applications in Access

In general, there are two basic approaches to devel-
oping information systems:
* in-depth systems analysis, design, and imple-
mentation,
* rapid prototyping (in which analysis, design, and
implementation are done iteratively)

Access provides a number of features (such as
graphical design tools, wizards, and a high-level
macro language) that facilitate rapid prototyping.
Since you are going to build a small system and
since time is limited, you will use a rapid prototyping
approach to build your application. The recom-

Discussion

mended sequence for prototyping using Access is
the following:

1. Model the information of interest in terms of enti-
ties and relationships between the entities (this is
covered in the lecture portion of the course).

2. Create a table for each entity (Tutorial 2).

3. Specify the relationships between the tables
(Tutorial 3).

4. Organize the information in your tables using
queries (Tutorial 4, Tutorial 5, Tutorial 10)

5. Create forms and reports to support input and
output transactions (Tutorial 6, Tutorial 7).

6. Enhance you forms with input controls
(Tutorial 8)

7. Create action queries (Tutorial 11), macros
(Tutorial 13), or Visual Basic programs
(Tutorial 12, Tutorial 14) to perform the transac-
tion processing functions of the application.
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8. Create “triggers” (procedures attached to events)
to automate certain repetitive tasks (Tutorial 15).

1.4.5 Use of linked tables

Most professional Access developers do not put their
tables in the same database file as their queries,
forms, reports, and so on. The reason for this is sim-
ple: keep the application’s data and interface sepa-
rate.

Access allows you to use the “linked table” feature to
link two database files: one containing all the tables
(“data”) and another containing all the interface and
logic elements of the application (“interface”). The
linked tables from the data file show up in the inter-
face file with little arrows (indicating that they are not
actually stored in the interface file).

In this way, you can modify or update the interface
file without affecting the actual data in any way. You
just copy the new interface file over to the user’s

Application to the assignment

machine, update the links to the data file, and the
upgrade is done.

Do not used linked tables in the assignment.
The links are dependent on the absolute
directory structure. As a result, if the directory
structure on your machine is different from
that on the marker’s machine, the marker will
not be able to use your application without
first updating the links (a time consuming pro-
cess for a large number of assignments).

1.5 Application to the assignment

After completing this tutorial you should be ready to
create the database file that you will use for the
remainder of the course.

1. Create an empty database file called <your
grouplD>.mdb . Remember that your group
number consists of eight digits.

16 of 17
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2. Import the inventor.xls spreadsheet as your
Products table.

3. Use the compact utility to make a backup copy of
your database (use a different name such as
backup.mdb ).
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Access Tutorial 2: Tables

2.1 Introduction: The importance
of good table design

Tables are where data in a database is stored; con-
sequently, tables form the core of any database
application. In addition to basic data, Access permits
a large amount of domain knowledge (such as cap-
tions, default values, constraints, etc.) to be stored at
the table level.

Extra time spent thinking about table design

A can result in enormous time savings during
later stages of the project. Non-trivial changes
to tables and relationships become increas-
ingly difficult as the application grows in size
and complexity.

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 25-Aug-1997

2. Tables

2.3.1 Datasheet basics

« If you have not already done so, open the
univO_v x.mdb database file from Tutorial 1.

* Open the Departments table. The important
elements of the datasheet view are shown in
Figure 2.1.

» Use the field selectors to adjust the width of the
DeptName field as shown in Figure 2.1.

* Add the Biology department (BIOL) to the table,
as shown in Figure 2.2.

* Delete the “Basket Weaving” record by clicking
on its record selector and pressing the Delete
key.

2.3.2 Creating a new table

In this section you will create and save a very basic
skeleton for table called Employees . This table
could be used to keep track of university employees

2.2 Learning objectives

O How do | enter and edit data in the datasheet
view of a table?

a

How do | create a new table?

Q

How do | set the primary key for a table?

O How do | specify field properties such as the
input mask and caption?

O Why won't an autonumber field restart
counting at one?

0 What are the different types of keys?

2.3 Tutorial exercises

In this tutorial, you will learn to interact with existing
tables and design new tables.

10f18
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such as lecturers, department heads, departmental
secretaries, and so on.
* Return to the database window and create a new
table as shown in Figure 2.3.
* In the table desi gn window shown in Figure 2.4,
type in the following information:

Field name Data type D(?)Z%rc')%t;?)n
EmployeelD Text use employee
S.I.N.
FName Text First name
LName Text Last name
Phone Text
Salary Currency

*» Select File > Save from the main menu (or press
Control-S) and save the table under the name

Employees .

[ Home | [4Previous |
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FIGURE 2.1: The datasheet view of the Departments table.

The field names are shown n the field Resize théeptName column by clicking near
selectors” across the top of the columns, _
. A the column border and dragging the border to

the right.

@ You can temporarily sort the records
in a particular order by right-clicking
any of the field selectors.

E Nepartments : Table

DeptCode Depthk ame ' }uilding
Basket Weawng ANGL

| |[COMM Commerce and ANGU

CRWR Creative Vyriting BLUCH

EDUC Education SCRF

ENGL English BUCH

kATH hdath kATH

MUSC Music The asterisk (*) indicates a

-+ place holder for a new record.

The records are shown as rows. — 4

The black triangle indicates the
“current record”.

The grey boxes are “record selector,

The “navigation buttons” at the bottom of the window
indicate the current record number and allow you to
directly to the first, previous, next, last, or new record.

Record: H| al | 1k |DI |He| of 7
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FIGURE 2.2: Adding and saving a record to the table.

= 1 Add a new record by clicking in tHeeptCode field @ Itis seldom necessary to
of the “new record” field (marked by the asterisk).

explicitly save new
records (or changes to
existing records) since

& Departments - Table Access automatically
DeptCode DeptName Bwldlng saves Whenever you

|| BSKW move to another record,

| |COMM DeptCode DeptName Building close the table, quit

| |CRWR | |BSKW Basket Weaving ANGU Access, etc.

| |EDUC | |COMM Commerce and Business Administration | ANGU

| |ENGL | |CRWR Creative Writing BUCH

| |MAIH | |[EDUC Education SCRF

¥ | |ENGL English BLUCH

J1BIOL | [maTH Math MATH

* MUSC Music MUSC

Biology

b To permanently save the change to the
data, click on the record selector (note the
icon changes from a pencil to a triangle).
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FIGURE 2.4: Use the table design window to enter the field properties for the

Enter the field names and
data types for the five fields:

A

The “description” column allows
you to enter a short comment
about the field (this information—__
is not processed in any way by
Access).

The “field properties” section
allows you to enter information

about the field and constraints on—»

the values for the field.

2. Tables
FIGURE 2.3: Create a new table.
g= univil_v? : Database =] 3
Click theNew button to
a create a new table Tables | Oueriesl FDrmsl B Repurtsl ] Macrusl &3 Mudulesi
Catalo Open |
Courses :
Departments Design |
Sections
RE
MNew Table
Table W
T —— ; : Impor Tabl
Select “design view” (avoid using__—— L Tl
the table wizard at this point). S}fﬁte A BN
8] I Cancel |
[ M Home | [4Previous | 50f18
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Employees table.

B Employees : Table |_ (O] ]
Field Name Data Type Description -
¥ [EmployeslD Text use employee S.LN. _|
Currency _|
Field Properties
General | Lookup |
Field Size 50 Al stz
Format can be upto
Input Mask B4 characters
Caption long,
Default value including
‘alidation Rule Spaces.
Validation Text Press F1far
Reguired Mo he'ﬁa?:;:ld
Allow Zero Length - Mo '
Inclexed “es (Duplicates OK)

[ Home | [4Previous |
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2.3.3 Specifying the primary key
Tables normally have a primary key that uniquely
identifies the records in the table. When you desig-
nate a field as the primary key, Access will not allow
you to enter duplicate values into the field.
* Follow the steps in Figure 2.5 to set the primary
key of the table to EmployeelD .

2.3.4 Setting field properties

In this section, you will specify a number of field
properties for the EmployeelD field, as shown in
Figure 2.6.
 Since we are going to use the employees’ Social
Insurance Number (S.I.N.) to uniquely identify
them, set the Field Size property to 11 characters
(9 for numbers and 2 for separating spaces)
 Set the Input Mask property to the following:
000\ 000\ 000;0
» Set the Caption property to Employee ID

Tutorial exercises

FIGURE 2.6: Set the field properties for the
EmployeelD field.

2 Employees : Table

| Field MName Diata Type
¥ | EmployeelD Text use employves SN,
FMarme Text first hame
LMame Text last name
Fhone Text
Salary Currency
General | Lookup |
Field Size 11
Format |
Input task 000y, 000y, 0oo;0
Caption Employee D

Default Yalue
Yalidation Rule
Yalidation Text

Fequired Mo
Allow Zero Length Mo
Indexed Yes (Mo Duplicates)

[P ] [mms] 7o
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FIGURE 2.5: Set the primary key for the

2, Microsoft Access
File WSGOM “iew |nsert Tools ‘Window Help

- Undo Propery Setting  Ctrl+2 h E
Cut Cirl+
Copy Ctrl+C
Baste gl
Delate Del ol Narms
Delete Row D
Select Al Crl+4,

Primary

W=zt el ) Rule

Tutorial exercises

Employees table.

= Click on the grey box beside the field (or
fields) that form the primary key.

To select more than one field for use as the
primary key, hold down th€ontrol key
while clicking on the grey boxes.

‘b Either click the key-shaped icon in the tool bar or
selectEdit > Primary Key from the menu.

[ M Home | |[4Previous | 80f18




2. Tables

* Select View > Datasheet from the main menu to
switch to datasheet mode as shown in Figure 2.7.
Enter your own S.1.N. and observe the effect of
the input mask and caption on the EmployeelD
field.

* Select View > Table Design from the main menu
to return to design mode.

 Set the field properties for FNameand LName
(note that Length and Caption are the only two
properties that are relevant for these two fields)

2.3.5 Using the input mask wizard

In this section, you will use the input mask wizard to
create a complex input mask for a standard field
type. You will also use the help system to learn more
about the meaning of the symbols used to create
input masks.
 Select the Phone field, move the cursor to the
input mask property, and click the button with

Discussion

three small dots (L) to invoke the input mask
wizard.

 Follow the instructions provided by the wizard as
shown in Figure 2.8.

* Press F1 while the cursor is still in the input mask
property. Scroll down the help window to find the
meaning of the “0”, “9”, “>" and “L” input mask
symbols.

2.4 Discussion

2.4.1 Key terminology

A key is one or more fields that uniquely determine
the identity of the real-world object that the record is
meant to represent. For example, there is a record in
the student information system that contains infor-
mation about you as a student. To ensure that the
record is associated with you and only you, it con-

[ M Home | [4Previous | 90f18
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FIGURE 2.7: Observe the effect of the input mask and caption properties on the behavior of the
EmployeelD field during data entry

= Try entering various characters and
numbers into th&mployeelD
field.

If a caption is specified, it replaces the
field name in the field selector.

Note that the input mask will not let you

‘b Press th&scape key when you are

done to clear the changes to the record.

B Empiayees : Table

Employee D

FMName LMName Phone Sal

type any characters other than numbers}_
from 0-9. In addition, the spaces betweefe=| 123 456 789
the groups of numbers are added * |

automatically.

@ Input masks provide a relatively easy way to

avoid certain basic data input errors without
having to write complex error checking
programs. Note, however, that it is possible to
over-constrain a field so that users are unable to
enter legitimate values.

10 of 18
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Discussion

FIGURE 2.8: Use the input mask wizard to create an input mask.

Select “phone
a P

list of commonly-
used field types.

@ The items in this
list depend on the
“international

settings” specified

Social Insurance MNurnber

Input Mask Wizard

number” from the  which input mask matches howyou want data to look?

To see how a selected mask works, use the Try It hox,
\[ & change the Input Mask list, click the Edit List button.

Data Look:

555 333 555

Input Mask Wizard

How do wou want to store the data?

. With the symbols inthe mask, like this:
(20R) BRE-1212

' “Withoutthe symbaols in the mask, like this:
2065551212

S oo o0 | fpostl Code A

le C_Ode may Passward . .

show instead of Medium Datel " Do youwant ta change the input mask? Since the input mask controls how
“Postal Code”). Short Date the information in the field looks, it

Input Mask Name:

: RUMea
‘b In Step 2, you mw
edit the input ma:

What placeholder character do you want

e.g., remove the
((';lrega code sectlon) Edit List | Flaceholders are replaced as wou enter ¢

Flaceholder character: I ! |

Phone Nurmber

1(9949) 000-0000

is possible to save some disk space
by storing the data without the
extras symbols, spaces, etc. For the
size of system we are building,
however, this savings is negligible.

Cancel | ¢ Back I Mt > I

2. Tables

tains a field called “student number” that is guaran-
teed to be unique.

The advantage of using student number as a key
instead of some other field—like “student name”—is
that there may be more than one person with the
same first and last name. The combination of stu-
dent name and address is probably unique (it is
improbable that two people with the same name will
at the same address) but using these two fields as a
key would be cumbersome.

Since the terminology of keys can be confusing, the
important terms are summarized below.

1. Primary key — The terms “key” and “primary
key” are often used interchangeably. Since there
may be more than one candidate key for an
application, the designer has to select one: this is
the primary key.

2. Concatenated key : The verb “concatenate”
means to join together in a series. A concate-

[ M Home | [4Previous | 110f18
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nated key is made by joining together two or
more fields. Course numbers at UBC provide a
good example of a concatenated key made by
joining together two fields: DeptCode and
CrsNum. For example, department alone cannot
be the primary key since there are many courses
in each department (e.g., COMM 335, COMM
391). Similarly, course number cannot be used as
a key since there are many courses with the
same number in different departments (e.g.,
COMM 335, HIST 335, MATH 335). However,
department and course number together form a
concatenated key (there is only one COMM 335).
Foreign key : In a one-to-many relationship, a
foreign key is a field (or fields) in the “child”
record that uniquely identifies the correct “parent”
record. For example, DeptCode and CrsNum in
the Sections table are foreign keys since these
two keys taken together are the primary key of
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the Courses table. Foreign keys are identified in
Access by creating relationships (see Tutorial 3).

2.4.2 Fields and field properties
2.4.2.1

Access places relatively few restrictions on field
names and thus it is possible to create long, descrip-
tive names for your fields. The problem is that you
have to type these field names when building que-
ries, macros, and programs. As such, a balance
should be struck between readability and ease of
typing. You are advised to use short-but-descriptive
field names with no spaces.

Field names

For example, in Section 2.3.2 you created a field
with name FName However, you can use the caption
property to provide a longer, more descriptive label
such as Firstname . The netresult is a field name
that is easy to type when programming and a field
caption that is easy to read when the data is viewed.

Discussion

In addition, you can use the comment field in the
table design window to document the meaning of
field names.

It is strongly recommended that you avoid all
A non-alphanumeric characters whenever you
name a field or database object. Although
Access will permit you to use names such as
Customer# , non-alphanumeric characters
(suchas #,/,$, %, ~, @, etc.) may cause
undocumented problems later on.

2422

The field's data type tells Access how to handle the
information in the field. For instance, if the data type
is date/time, then Access can perform date/time
arithmetic on information stored in the field. If the
same date is stored as text, however, Access treats
it just like any other string of characters. Normally,

Data types
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the choice of data type is straightforward. However,
the following guidelines should be kept in mind:

1. Do not use a numeric data type unless you are
going to treat the field as a number (i.e., perform
mathematical operations on it). For instance, you
might be tempted to store a person's student
number as an integer. However, if the student
number starts with a zero, then the first digit is
dropped and you have to coerce Access into dis-
playing it. Similarly, a UBC course number (e.g.,
335) might be considered a number; however,
since courses like 439B have to accommodated,
a numeric data type for the course number field is
clearly inappropriate.

2. Access provides a special data type called Auto
Number (Counter in version 2.0). An autonum-
ber/counter is really a number of type Long Inte-
ger that gets incremented by Access every time
a new record is added. As such, it is convenient

Discussion

for use as a primary key when no other key is
provided or is immediately obvious.

Since an autonumber is really Long Integer
A and since relationships can only be created
between fields with the same data type, it is
important to remember that if an autonumber
is used on the “one” side of a relationship, a
long integer must be used for the “many” side.

2.4.2.3 “Disappearing” numbers in

autonumber fields

If, during the process of testing your application, you
add and delete records from a table with an auto-
number key, you will notice that the deleted keys are
not reclaimed.

For instance, if you add records to your Customer
table (assuming that CustlD is an autonumber), you
will have a series of CustID values: 1, 2, 3... If you
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later delete customer 1 and 2, you will notice that
your list of customers now starts at 3.

Clearly, it would be impossible for Access to renum-
ber all the customers so the list started at 1. What
would happen, for instance, to all the printed
invoices with CustlD =2 on them? Would they refer
to the original customer 2 or the newly renumbered
customer 27?

The bottom line is this: once a key is

A assigned, it should never be reused, even if
the entity to which it is assigned is subse-
quently deleted. Thus, as far as you are con-
cerned, there is no way to get your customers
table to renumber from CustiID = 1.

Of course, there is a long and complicated way to do
it, but since used an autonumber in the first place,
you do not care about the actual value of the key—
you just want it to be unique. In short, it makes abso-

Discussion

lutely no difference whether the first customer in your
customers table is CustID =1 or 534.

2424

An input mask is a means of restricting what the user
can type into the field. It provides a “template” which
tells Access what kind of information should be in
each space. For example, the input mask >LLLL
consists of two parts:

Input masks

1. The right brace > ensures that every character
the user types is converted into upper case.
Thus, if the user types comm) it is automatically
converted to COMM

2. The characters LLLL are place holders for letters
from A to Z with blank spaces not allowed. What
this means is that the user has to type in exactly
four letters. If she types in fewer than four or
types a character that is not within the A to Z
scope (e.g., &, 7, %), Access will display an error
message.

[ M Home | [4Previous | 150718
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There are a large number of special symbols used
for the input mask templates. Since the meaning of
many of the symbols is not immediately obvious,
there is no requirement to remember the character
codes. Instead, simply place the cursor on the input
mask property and press F1 to get help. In addition,
the wizard can be used to provide a basic input mask
which can later be modified.

24.2.5

To have the input mask automatically insert a char-
acter (such as a space or a dash) in a field, use a
slash to indicate that the character following it is a lit-
eral.

Input masks and literal values

For example, to create an input mask for local tele-
phone numbers (e.g., 822-6109), you would use the
following template: 000\-0000;0  (the dash is a lit-
eral value and appears automatically as the user
enters the telephone number).

Discussion

The semicolon and zero at the end of this input mask
are important because, as the on-line help system
points out, an input mask value actually consists of
three parts (or “arguments”), each separated by a
semicolon:
« the actual template (e.g., 000\-0000 ),
e avalue (0 or 1) that tells Access how to deal with
literal characters, and
* the character to use as a place holder (showing
the user how many characters to enter).

When you use a literal character in an input mask,
the second argument determines whether the literal
value is simply displayed or displayed and stored in
the table as part of the data.

For example, if you use the input mask 000\-

0000;1 , Access will not store the dash with the tele-
phone number. Thus, although the input mask will
always display the number as “822-6109”, the num-
ber is actually stored as “8226109". By using the

16 of 18
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input mask 000\-0000;0 , however, you are telling
Access to store the dash with the rest of the data.

é If you use the wizard to create an input mask,

it asks you a simple question about storing lit-

eral values (as shown in Figure 2.8) and fills
in the second argument accordingly. How-
ever, if you create the input mask manually,
you should be aware that by default, Access
does not store literal values. In other words,
the input mask 000\-0000 s identical to the
input mask 000\-0000;1 . This has impor-
tant consequences if the field in question is
subject to referential integrity constraints (the
value “822-6109" is not the same as
“8226109").

Application to the assignment

2.5 Application to the assignment

You now have the skills necessary to implement your
tables.
 Create all the tables required for the assignment.
« Use the autonumber data type (counter in version
2.0) for your primary keys where appropriate.
 Specify field properties such as captions, input
mask, and defaults where appropriate.

é If you create an input mask for ProductiD
ensure you understand the implications of
Section 2.4.2.5.

* Set the Default property of the OrderDate field
so that the current date is automatically inserted
into the field when a new order is created (hint:
see the Date() function in the on-line help sys-
tem).

17 of 18
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Do not forget to modify your Products table (the
data types, lengths, and field properties of
imported tables normally need to be fine tuned)

* Populate (enter data into) your master tables. Do
not populate your transaction tables.

For the purpose of the assignment, the term
@ “transaction” tables refers to tables that con-
tain information about individual transactions
(e.g., Orders , OrderDetails , Ship-
ments , ShipmentDetails ). “Master”
tables, in contrast, are tables that either do
not contain information about transactions
(e.g., Customers ) or contain only summary
or status information about transactions (e.g.,
BackOrders ).

Application to the assignment

18 0of 18
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Access Tutorial 3: Relationships

3.1 Introduction: The advantage of

using tables and relationships

A common mistake made by inexperienced data-
base designers (or those who have more experience
with spreadsheets than databases) is to ignore the
recommendation to model the domain of interest in
terms of entities and relationships and to put all the
information they need into a single, large table.
Figure 3.1 shows such a table containing information
about courses and sections.

* If you have not already done so, open the

univ0_v x.mdb database.

» Open the Catalog View table.

The advantage of the single-table approach is that it
requires less thought during the initial stages of
application development. The disadvantages are too
numerous to mention, but some of the most impor-
tant ones are listed below:

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 22-Aug-1997
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FIGURE 3.1: The “monolithic” approach to database desi

1.

Wasted space — Note that for COMM 290, the
same basic course information is repeated for
every section. Although the amount of disk space
wasted in this case is trivial, this becomes an
important issue for very large databases.
Difficulty in making changes — What happens if
the name of COMM 290 is changed to “Mathe-
matical Optimization”? This would require the
same change to be made eight times. What if the
person responsible for making the change for-
gets to change all the sections of COMM 290?
What then is the “true” name of the course?
Deletion problems — What if there is only one
section of COMM 290 and it is not offered in a
particular year? If section 001 is deleted, then the
system no longer contains any information about
the course itself, including its name and number
of credits.

[P [mmms]  1ofo0

Introduction: The advantage of using tables and relation-

gh—the Catalog View table contains

information about courses and sections.

The course “COMM 290" consists
of many sections.

B Catalog Yiew : Table

Each section has some information
unique to that section (such as
Time, Days, Building

Roon); however, the basic course
information (e.g.Title

Credits ) is the same for all
sections of a particular course.

CatalogNum | DeptCode | CrsNum Title Section
COMM 290 Introduction to Qual 006
COMM 290 Introduction to Qual 001
COMM 290 Introduction to Qiual 005
O 290 Introduction to Qiual 002
O 290 Introduction to Qual 003
COMM 290 Introduction to Qual 004
COMM 2390 Introduction to Qual 007
COMM 290 Introduction to Qual 008
C oA 291 Applied Statistics in 002
O 291 Applied Statistics in 003

[ Home | [4Previous |
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4. Addition problems — If a new section is added to
any course, all the course information has to be
typed in again. Not only is this a waste of time, it
increases the probability of introducing errors into
the system.

3.1.1 “Normalized” table design

The problems identified above can be avoided by
spitting the Catalog View  table into two separate
tables:

1. Courses — information about courses only
2. Sections — information about sections only.

The key to making this work is to specify a relation-
ship between Courses and Sections so that when
we look at a section, we know which course it
belongs to (see Figure 3.2). Since each course can
have one or more sections, such a relationship is
called “one-to-many”.

Introduction: The advantage of using tables and relation-

FIGURE 3.2: A one-to-many relationship between
Courses and Sections

Sections

Section
Session
Cataloghum

Term LI

Access uses relationships in the following way:
Assume you are looking at Section 004 of

COMM 290. Since Dept and CrsNum are included in
the Sections table, and since a relationship line
exists between the same two fields in the Courses
table, Access can trace back along this line to the
Courses table and find all the course-specific infor-
mation. All other sections of COMM 290 point back

[Froe] [mmms] 3010
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to the same record in the Courses table so the
course information only needs to be stored once.

3.2 Learning objectives

0 Why do | want to represent my information in
multiple tables connected by relationships?

a

How do | create relationships in Access?

a

How do | edit or change relationships?

a

What is referential integrity and why is it
important?

3.3 Tutorial exercises

3.3.1 Creating relationships between
tables

* Close the Catalog View
the database window.

table and return to

Learning objectives

 Select Tools > Relationships from the main
menu.

In version 2.0 the menu structure is slightly
different. As such, you select Edit > Relation-
ships instead.

» To add a table to the relationship window, select
Relationships > Show Table from menu or press
the show table icon (g]) on the tool bar.

« Perform the steps shown in Figure 3.3 to add the
Courses and Sections tables.

« Specify the relationship between the primary
key in Courses and the foreign key in Sec-
tions . This is shown in Figure 3.4.

f Do not check cascading deletions or updates
unless you are absolutely sure what they
mean. See on-line help if you are curious.

4 of 10
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FIGURE 3.3: Add the Courses and Sections tables to the relationship window.

@ The rectangular “field list” represents a = Select the table you wish to add and either
table. Note that the key (or keys) composing double-click or presAdd. Repeat as necessary.
the primary key are shown in bold type.

== Relati~1ships

@ If you accidently add a table more than once, it sy
will show up with a<table name>_1 label.
To delete the extra version, click anywhere on

the unwanted rectangle and press the delete key.

[ M Home | [4Previous | 50f10
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FIGURE 3.4: Create a relationship between the two tables.
:
] ‘b Drag the selected fields on to the

= Select the primary key ( _
on the “one” side of the | [E foreign key on the “many” side of the
relationship. 4 [T relationship.
To select a concatenated| ' rymrmm—rs ' —
ps T
@ key (more than one o If done
fleld) hold down the _C Table/Cueny: Felated Table/Cuery: Create correctly, _the
Control key while Courses |Sections - — connect|V|ty(1
SeIeCting. DeptCode DeptCode [ Cancel to oo) ShQWS 0!”]
Crshium — ' R the relationship
e re— e line).
C Ensure that the correct Seciion
fle_lds are aSSOC|ate_d Enforce Referential Inl Sessian =2 Relationships
with each other (this Cataloghum
must be done manually o Tem
for concatenated keys). I=| Caseanl Delpte Feld Davs _
Time - 2 [ CraMum
ChECk the bOX t(_) Relationship Type: One-To-Many SEdi'_:'"
enforce referential o Session
integrity. Cataloghum
Term LI
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3.3.2 Editing and deleting relationships

There are two common reasons for having to edit or
delete a relationship:

1. You want to change the data type of one of the
fields in the relationship — Access will not let you
do this without first deleting the relationship (after
you change the data type, you must re-create the
relationship).

2. You forget to specify referential integrity — if the
“1" and “«” symbols do not appear on the rela-
tionship line, then you have not checked the box
to enforce referential integrity.

In this section, assume that we have forgotten to
enforce referential integrity between Courses and
Sections
 Perform the steps shown in Figure 3.5 to edit the
relationship between Courses and Sections

Discussion

Note that simply deleting the table in the rela-
tionship window does not delete the relation-
ship, it merely hides it from view.

3.4 Discussion

3.4.1 One-to-many relationships

There are three types of relationships that occur in
data modeling:

1. one-to-one — A one-to-one relationship exists
between a student and a student number.

2. one-to-many — A one-to-many relationship
exists between courses and sections: each
course may consist of many sections, but each
section is associated with exactly one course.

3. many-to-many — A many-to-many relationship
exists between students and courses: each stu-
dent can take many courses and each course
can contain many students.

[ M Home | [4Previous |  70f10
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Discussion

FIGURE 3.5: Edit an existing relationship.

= Select the relationship by clicking on

the joining line (click on either line if
the key is concatenated). If you do
this correctly, the line becomes

darker. T

‘b With the relationship selected, right-

click to get the edit/delete pop-up — |
menu. If you do not get this menu,
make sure you have correctly
selected the relationship.

@ The missing “1” and &” symbols
indicate that referential integrity has
not been enforced.

=2 Relationships

Sectiong

Edit Relationship...
Delete Relationshi

CatalogMum

Tem =l
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Although the data modeling technique used most
often in information system development—Entity-
Relationship diagraming —permits the specifica-
tion of many-to-many relationships, these relation-
ships cannot be implemented in a relational
database. As a consequence, many-to-many rela-
tionships are usually broken down into a series of
one-to-many relationships via “composite entities”
(alternatively, “bridging tables”). Thus to implement
the student-takes-course relationship, three tables
are used: Students , Courses , and Student-
TakesCourse .

3.4.2 Referential integrity

One important feature of Access is that it allows you
to enforce referential integrity at the relationship
level. What is referential integrity? Essentially, refer-
ential integrity means that every record on the

Discussion

“many” side of a relationship has a corresponding
record on the “one” side.

Enforcing referential integrity means that you cannot,
for instance, create a new record in the Sections
table without having a valid record in the Courses
table. This is because having a section called
“BSKW 101 Section 001” is meaningless unless
there is a course called “BSKW 101”". In addition, ref-
erential integrity prevents you from deleting records
on the “one” side if related records exist on the
“many” side. This eliminates the problem of
“orphaned” records created when parent records are
deleted.

Referential integrity is especially important in the
context of transaction processing systems. Imagine
that someone comes into your store, makes a large
purchase, asks you to bill customer number “123",
and leaves. What if your order entry system allows
you to create an order for customer “123” without

[ M Home | [4Previous | 90f10
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first checking that such a customer exists? If you
have no customer 123 record, where do you send
the bill?

In systems that do not automatically enforce referen-
tial integrity, these checks have to be written in a pro-
gramming language. This is just one example of how
table-level features can save you enormous pro-
gramming effort.

Enforcing referential integrity has obvious

A implications for data entry: You cannot popu-
late the “many” side of the table until you pop-
ulate the “one” side.

3.5 Application to the assignment
 Specify all relationships—including referential
integrity constraints—between tables in your sys-
tem. You are not responsible for cascading
updates/deletions in this assignment.

Application to the assignment

A primary key and a foreign key must be of

A the same data type before a relationship can
be created between them. Because of this, it
is important to remember that the autonumber
data type (or counter in version 2.0) is really a
long integer.

It never makes sense to have a relationship

A between two autonumber fields. A foreign key
cannot be an autonumber since referential
integrity constraints require it to take on a an
existing value from a parent table.

10 of 10
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Access Tutorial 4: Basic Queries Usin

4.1 Introduction: Using queries to

get the information you need

At first glance, it appears that splitting information
into multiple tables and relationships creates more of
a headache than it is worth. Many people like to
have all the information they need on one screen
(like a spreadsheet, for instance); they do not want to
have to know about foreign keys and relationships
and so on.

Queries address this problem. They allow the user to
join data from one or more tables, order the data in
different ways, calculate new fields, and specify cri-
teria to filter out certain records.

The important thing is that the query itself contains
no data—it merely reorganizes the data from the
table (or tables) on which it is built without changing
the “underlying tables” in any way.

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 25-Aug-1997

4. Basic Queries Usin g QBE

0 What is a non-updatable recordset? How do |
tell whether a query results in a non-
updatable recordset?

4.3 Tutorial exercises

4.3.1 Creating a query

» Use the New button in the Queries pane of the
database window to create a new query as
shown in Figure 4.1.

» Add the Courses table to the query as shown in
Figure 4.2.

» Examine the basic elements of the query design
screen as shown in Figure 4.3.

» Save your query (Control-S) using the name
gryCourses

g QBE

Once a query is defined, it can be used in exactly the
same way as a table. Because of this, it is useful to
think of queries as “virtual tables”. Similarly, in some
DBMSes, queries are called “views” because they
allow different users and different applications to
have different views of the same data.

4.2 Learning objectives

Do queries contain any data?
How do | create a query?
What can | do with a query?

How do | create a calculated field?

aaaaaaq

Why does Access add square brackets
around field names?

a

What names should | give the queries |
create?

O What does the ampersand operator (&) do?

1of27
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4.3.2 Five basic query operations

4321

Projecting a field into a query simply means includ-
ing it in the query definition. The ability to base a
guery on a subset of the fields in an underlying table
(or tables) is particularly useful when dealing with
tables that contain some information that is confiden-
tial and some that is not confidential. For instance,
the Employees table you created in Tutorial 2 con-
tains a field called Salary . However, most of the
gueries seen by end-users would not include this
information, thereby keeping it private.

« Perform the steps shown in Figure 4.4 to project
the DeptCode , CrsNum, and Title  fields into
the query definition.

 Select View > Datasheet from the menu to see
the results of the query. Alternatively, press the
datasheet icon (&) on the tool bar.

Projection

2o0f27
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FIGURE 4.1: Create a new query.

Select theQueries tab in — Lt e R =10 ]
a the database window. Takles Oueriesl Farms | B Repunsl Z Macros | Wit Mudulesl

DRE |

[DEsiEn |
‘b Press thélew button to
create a new query. —  [New |

New Query EHE

P\'/j’ |mpe uWize_lrd
@ Avoid the use of the query wizard/ e Ei?;%iﬁlﬁ;?ggzzear;dwuard
at this p0|nt. Querles are very ) Find Unmatched Queny YWizard
important and it is best to learn to Llfeiis a1 iz gulz6 il

using awizard.

create them from scratch.

0K I Cancel

[ M Home | [4Previous | 30f27
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FIGURE 4.2: Add tables to your query using the “show table” window.

Show Tabla X
File  Edit “iew Inzert JEENE Window Help

Tablesl Queriesl EiDthl

| = 1 = e 4

E‘E Unj - Queryl : Sele

= Add theCourses table to the query

by selecting it and pressidgld
(alternatively, you can simply double-
click on the table you want to add).

PresLClose when done (the “show The “show table” window is always
table” window is “modal’—you can | available from th&uery > Show Table
not do anything else in Access until a menu. Alternatively, you can press the
modal window is closed). “show table” button on the tool bar.
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Tutorial exercises

FIGURE 4.3: The basic elements of the query design screen.

=¥ Queryl : Select Query (O] x|

The upper
pane contains
field lists for
the tables on —|
which the
query is based.

Lol |

@ If you “lose” tables in the top

pane, you have to use the — %
horizontal and vertical scroll
bars to return to the upper-left
corner of the pane.

Field row— shows the name of the

fields included in the query.

Frad
The lower e geP‘CDdE‘/ Table row— shows the name of the
pane contains O table that the field comes from. To get
the actual Show: ] table names in version 2.0, selg@w
query Criteria: \ > Table Names from the menu.
=

definition.
/v*||

Criteria row — allows you
to specify criteria for
including or excluding
records from the results set.

Sort row— allows you to specify the
order in which the records are
Show boxes— determine displayed

whether fields included

in the query are actually

displayed.

4. Basic Queries Using QBE
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FIGURE 4.4: Project a subset of the available fields into the query definition.

@ To project all the fields in the
Courses table (including

any that might be added to the |

table after this query is
created) drag the asterisk (*)
into the query definition grid.

@ To save time when
projecting fields, select more
than one field at once (by
holding down theControl
key) and dragging all the
fields as a group.

a2 Select the field you wish to project and
drag it into the query definition grid.
Alternatively, double-click the field.

& qryCourses : Select Query

Ki| _'I_I
Field: | DeptCode CraMNum ‘ =
Table: | Courses Courses oo
Sort:
Show: ]
Criteria:

ar: =
| »
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« Select View > Query Design to return to design
mode. Alternatively, press the design icon (k))
on the tool bar.

4322

When you use a query to sort, you do not change the

physical order of the records in the underlying table

(that is, you do not sort the table). As a result, differ-

ent queries based on the same table can display the

records in different orders.

» Perform the steps shown in Figure 4.5 to sort the

results of gryCourses by DeptCode and
CrsNum.

Sorting

@ Since a query is never used to display data to
a user, you can move the fields around within
the query definition to get the desired sorting
precedence. You then reorder the fields in the

form or report for presentation to the user.

Tutorial exercises

43.2.3

You select records by specifying conditions that each
record must satisfy in order to be included in the
results set. In “query-by-example” you enter exam-
ples of the results you desire into the criteria row.
» Perform the steps shown in Figure 4.6 to select
only those courses with a DeptCode = “COMM”

43.2.4

It is also possible to create complex selection criteria
using Boolean constructs such as AND, OR, and
NOT.
 Project the Credits field into the query.
« Perform the steps shown in Figure 4.7 to create a
query giving the following result:
“Show the department, course humber, and title
of all courses in the Commerce department for
which the number of credits is greater than
three.”

Selection

Complex selection criteria

7 of 27
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FIGURE 4.5: Sorting the results set on one or more fields.

= Select “ascending” for thBeptCode field

and “descending” for th€ErsNum fiel%‘
&! qryCourses : Select Query _ (O]
| |Department | Course number Title
|’ | 439 Advanced Topics in Information Syst
| | COMM 351 Financial Accounting
| |[COMM 291 Applied Statistics in Business
Ll | , | comm 290 Introduction to Quantative Decision b
Ficld: [Dopitode 7 — 1 t CRWR 496 Poetry Tutorial
Table CDUI’SES * Course p ES\L\;{:R ggé ((Elriitl\:ri |’r:'rﬂo:r:i lnctrictinn im Haslth
S Ascendlng Desce”d'/ EvE 301 @ When multiple sort fields are specified,
Criteria: 1 MaTH 407 the sorting precedence is from left to
or. | 8w tyrey 203 right (e.g.,DeptCode is sorted first
View the results and noti — and therCrsNum is sorted within each
| the order of the records. | MUSC 105 set of matchindeptCode s).

8 of 27
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FIGURE 4.6: Select a subset of records from the

= gryCourses : Select Query

<

Tutorial exercises

Courses table matching a specific criterion.

- [O] x|

Type the expressioctCOMM”in the criteria row
of theDeptCode field. You could also type
“COMM”but the equal sign is always implied
unless another relational operator is used.

1
View the results. Only records

4
-_I—I b matching the criteria are shown.
Field: [DeptCode CrgMum !'I:itle !—I
| “
Show: Department | Course number Title
Criteriar ["COMM" [COnng 290 Introduction to Quantative Decision b
o o COMM 291 Applied Statistics in Business
COnRA 351 Financial Accounting
COMM 439 Advanced Topics in Information Syst

9 of 27
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Tutorial exercises

FIGURE 4.7: Select records using an AND condition.

& qryCourses : Select Query @

d Show the result.

When multiple criteria are placed in the
same row, they are AND-ed. In other
words, the records in the results set
must satisfyDeptCode = “COMM”

AND Credits > 3

1
& qryCourses : Select Query

Department | Course number

Title Note that the number

[COMM 291 Applied Statistics in E 3 is not in quotation
[« | ] marks whereas the
: string of characters
Field: | DeptCode CrsMNum Title Credits = “COMM” is.
Table: | Courses Courges CH Courses s
Sort:
Shaw. A T
Criteria: |"COkb" >3
ar: 4 \% Uncheck the “show”
4] B C box (Credits is
| , o | L used as a criterion but
= ‘I‘Enter th:a first criteria: In the same row, enter the second it is not displayed in
COMM >3 the results sef)

10 of 27
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 Perform the steps shown in Figure 4.8 to create a
guery giving the following result:
“Show the department, course number, and title
of all courses from the Commerce department
and also show those from the Creative Writing
department for which the number of credits is
greater than three.”

4.3.2.5

In Tutorial 3, you were advised to break you informa-
tion down into multiple tables with relationships
between them. In order to put this information back
together in a usable form, you use a join query.
* Close gryCourses
» Open the relationships window and ensure you
have a relationship defined between Courses
and Sections . If you do not, create one now (do
not forget to enforce referential integrity).
* Create a new query called gryCatalogNum
based on the Courses and Sections tables.

Joining

Tutorial exercises

* Project Title  from the Courses table and
DeptCode , CrsNum, Section  and Catalog-
Numfrom the Sections table (see Figure 4.9).

* Follow the instructions in Figure 4.10 to move
CatalogNum to the far left of the query definition
grid.

Access performs an automatic lookup of information
from the “one” side of the relationship whenever the
a valid value is entered into the foreign key of the
“many” side of the relationship. To see how this
works, create a new section of “MUSC 105

« Scroll to the bottom of the query in datasheet
mode and click on the department field.

* Enter “"MUSC".

« Enter “105” in the course number field.

Once Access knows the DeptCode and CrsNum of
a section, it can uniquely identify the course that the
section belongs to (which means it also knows the

values of Title , Credits , Activity , etc.)
[ M Home | [4Previous | 1l of27
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FIGURE 4.8: Select records using an AND and an OR condition.

When multiple criteria are placed in

@ different rows, then they are OR-ed. IN o emer——rrm—rc—
other words, the records in the resultggses .
A ’f!! Department |C b Titl
must satisfyDeptCode = “COMM” = [ ke MeMT [ OUrse NUMer e

OR (DeptCode = “CRWR” AND B} Orn 290 Introduction to Quantative Decision b
Credits > 3 ). - 291 Applied Statistics in Business
Lo | 351 Financial Accournting
CrsMum | |COMM 438 Advanced Topics in Information Syst
Title | |CRWR 202 Creative Forms
Credit - .
Af;iv:; - CRWER 498 Foetry Tut Emefthe. Credits
criterion in the
Coy Shiring A second row.
DeptCode 3 7
criteria in Field: |DeptCode CraMum Title Credits / =
different rows. Takle: |Courses Courses Courses Coursgh —
Sort |Ascending Ascending /
Show: []
riteria: | COhkdhd"
ar: | "CRwWR" >3
| _'I_I
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A

FIGURE 4.9: Create a query that joins Courses and Sections

Bring Courses andSections
Note that the relationship between the tables

into the query.

inherited from the relationship window.

To

Tutorial exercises

=t gqryCatalogNum : Select Query

4. Basic Queries Using QBE

&F qryCatalogNum : Select Query

— |DeptCode

Sections

*® -

CrsNum
Secdlion
Session
CatalogMum | =]

=l E3

Field:
Takle:
Sor:
Show:
Criteria:
ar:

Title DeptCode CrsMurn Section
Courses Sections Sections Sections

FIGURE 4.10: Move a field within the query definition grid.

A

To

[ Home | [4Previous |

Title Departmen|Course nut| Section |CatalogMur
: | * | Introduction COMM 290 001 44411
&' jryCataloghum : Select Query | |Introduction COMM 290 002 57455
Sections || Introduction COMM 290 003 48516
* ~| || Introduction COMM 290 Q04 71845
= | DeptCode || Introduction COMM 240 Q05 69495
CrsNum || Introduction COMM 290 Q06 34134
Sechion | |Introduction COMBM 290 007 45938
gEfT'U"N <l Introduction COMM 290 008 27839
= T S [ | Applied Stat COMM 291 a1 84203
| |Applied Stat COMM 291 aoz 83920
Field: | Title ~ | DepiCode CrsMum Section CatalogMum | —
Table: | Courses Sections Sections Sections Sections -
Sort:
Shaovw: |
ritm o
Project fields from both tables into _ILI
the query definition. 3
[ M Home | [4Previous | 130f27
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Click once on the grey
“column selector”
above the field you
want to move (if
properly selected, the
column turns black).

To delete a field from
the query definition,
select it and press the
Delete key.

Drag the selected column to
its new location.
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4.3.3 Creating calculated fields

A calculated field is a “virtual field” in a query for
which the value is a function of one or more fields in
the underlying table. To illustrate this, we will create
two calculated fields:

1. one to combine DeptCode and CrsNum into one
field,
2. one to translate the Credits field into a dichoto-

mous string variable (full year or half
year ).
The syntax of a calculated field is always the same:

<calc field name>: <definition>

For example, the syntax for the calculated field
called Course is:
Course: DeptCode & CrsNum

The calculated field name can be just about any-
thing, as long as it is unique. The definition is any
expression that Access can evaluate. In this case,

Tutorial exercises

the expression involves two fields from the Courses
table (DeptCode and CrsNum) and the ampersand
operator (see Section 4.4.2 for more information on
using the ampersand operator).
« Create a new query called gryCourseLengths
based on the Courses table.
 Follow the instructions in Figure 4.11 to create
the calculated field Course
* Run the query to verify the results, as shown in
Figure 4.12.

When you use field names in expressions,
Access normally adds square brackets. This
is not cause for concern because in Access,
square brackets simply indicate the name of a
field (or some other object in the Access envi-
ronment). However, if your field name con-
tains blank spaces (e.g., Dept Code ), the
square brackets are NOT optional—you must

[ M Home | [4Previous | 15027
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FIGURE 4.11: Create a calculated

@

The zoom

Tutorial exercises

field based on two other fields.

window provides more room to type than the tiny

space in the query definition grid. Invoke the zoom window

by moving to the area of the grid in which you wish to type
and either right-click or press tishift-F2 keys.

Put the cursor in
theField row of
the first column
and invoke the
zoom window.

Qa

Type in the name
and the definition
of the calculated

To

& gqryCourselengths : Select Query

E Zoom
Course: DeptGode & GrsNum il 0K
/( Cancel |
PresOK when you
C Y

have finished typing
the expression.

field. The name
cannot be the sam Criteria;
as that of an at: -
existing field. N
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FIGURE 4.12: The resulting calculated field.

The name of the

calculated field shows in

*®

DeptCode
CrsNum

: - Title
When the zoom window is Credits

closed, Access adds square | |, .,
brackets to the field names.

the field selector.

! gryCourselenc as : Select Query

Course
L O 200

COMM2a1

Since the field names in this~«l_| || COMM351
example do not contain : \& | |COMM439
spaces, the brackets are Field Course: [DeptCode] | | | CRWR20Z
optional. Tasb'ii CRWR496
art: |

Show | |EDUC306

Criteria

ar:

KN

@ The ampersand operator (&) simply tacks
CrsNum onto the end dDeptCode .
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type them every time you use the field name
in an expression.

4.3.3.1 Refining the calculated field

Instead of having DeptCode and CrsNum run
together in the new Course field, you may prefer to
have a space separating the two parts.
* Edit the Courses field by clicking on the field row
and invoking the zoom box.
» Add a space (in quotation marks) between the
two constituent fields:
Course: DeptCode & " " & CrsNum
» Switch to datasheet mode to see the result.

4.3.3.2 A more complex calculated field

To create a calculated field that maps Credits to a
dichotomous string variable, we need a means of
testing whether the value of Credits exceeds a
certain threshold (e.g., any course with more than

Tutorial exercises

three credits is a full-year course). To do this, we will
use the “immediate if’ (iif ) function.
« Search on-line help for information about the
iif() function.
Basically, the function uses the following syntax:
iif(<expression>, <true part>,
<false part>)
to implement the following logic:
IF <expression> = TRUE THEN
RETURN <true part>
ELSE
RETURN <false part>
END IF
* Create a new calculated field called Length :
Length: iif(Credits > 3, “full
year”, “half year”)
« Verify the results, as shown in Figure 4.13.
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FIGURE 4.13: Create a calculated field using the “immediate if” function

=2 Create a calculated field calleeéngth with the following expression:
Length: iif(Credits>3, “full year”, “half year”)

B Zoom

& qryCourselengths : Select Query

Field: | Course: [DeptCode

Criteria:
or:

Length: f{[Credits]=3,"full year" "half yvear™) |

Course Length

- P [COMM 290 half year
|| COmMM 291 full year
|| COMM 351 half year
|| COMM 438 half year
| |CRWR 202 full year
| |CRWR 496 full year
| |EDUC 306 half year
| |EMNGL 301 half year
| |[MATH 303 half year
| |MATH 407 half year
| |MUSC 105 half year
*
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4.3.4 Errors in queries

It may be that after defining a calculated field, you
get the “enter parameter” dialog box shown in
Figure 4.14 when you run the query. This occurs
when you spell a field name incorrectly. Access can-
not resolve the name of the misspelled field and thus
asks the user for the value. To eliminate the problem,
simply correct the spelling mistake.

FIGURE 4.14: A spelling error in a calculated

field.
|
Creditz Access cannot find the

| - field namedCreditz

o]

Cancel |

[ M Home | [4Previous |
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4.4 Discussion

4.4.1 Naming conventions for database
objects

There are relatively few naming restrictions for data-
base objects in Access. However, a clear, consistent
method for choosing names can save time and avoid
confusion later on. Although there is no hard and fast
naming convention required for the assignment, the
following points should be kept in mind:

* Use meaningful names — An object named
Tablel does not tell you much about the con-
tents of the table. Furthermore, since there is no
practical limit to the length of the names, you
should not use short, cryptic names such as
s96w_b . As the number of objects in your data-
base grows, the time spent carefully naming your
objects will pay itself back many times.

20 of 27
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4. Basic Queries Using QBE

» Use capitalization rather than spaces to separate
words — Unlike many database systems, Access
allows spaces in object names. However, if you
choose to use spaces, you will have to enclose
your field names in square brackets whenever
you use them in expressions (e.g., [Back
Orders] ). As such, it is slightly more efficient to
use a name such as BackOrders than Back
Orders .

» Give each type of object a distinctive prefix (or
suffix) — This is especially important in the con-
text of queries since tables and queries cannot
have the same name. For example, you cannot
have a table named BackOrders and a query
named BackOrders . However, if all your query
names are of the form gryBackOrders , then
distinguishing between tables and queries is
straightforward.

Discussion

« Stick to standard alphanumeric characters — You
should limit yourself to the characters [A...Z],
[a...z], [0...9], and perhaps underscore (_) and
dash (-). Although Access allows you to use virtu-
ally any character, undocumented problems have
been encountered in the past with non-alphanu-
meric characters such as the pound sign (#).

Table 4.1 shows a suggested naming convention for
Access database objects (you will discover what
these objects are in the course of doing the tutorials).

4.4.2 The ampersand (&) operator

The ampersand operator is like any other operator
(e.g., +, -, X, =) except that it is intended for use on
strings of characters. What the ampersand does is
simply add one string on to the end of another string
(hence its other name: the “concatenation” operator).
For example, the expression

“First string” & “Second string”

[ M Home | [4Previous | 2Lof27
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Table 4.1: A sugges ted nhaming conven tion for
Access database objects.

Object type |Prefix Example
table (none) |OrderDetails
query qry gryNonZeroBackOrders
parameter pary pgryltemsIinOrder
query
form frm frmOrders
sub form sfrm sfrmOrderDetails
switchboard |swb swbMainSwitchboard
form
report rpt rptinvoice
sub report srpt srptinvoiceDetails
macro mcr mcrOrders
Visual Basic |bas basUtilities

module

Discussion

yields the result

First stringSecond string
However, if a space is include within the quotation
marks of the second string (* Second string” )s
the result is:

First string Second string

4.4.3 Using queries to populate tables
on the “many” side of a
relationship

In Section 4.3.2.5, you added a record to the Sec-
tions table to demonstrate the automatic lookup
feature of Access. However, a common mistake
when creating queries for entering data into tables
on the “many” side of a relationship is to forget to
project the table’s foreign key. That is, faced with two
tables containing the fields DeptCode and CrsNum,
you project the fields from the wrong table (the “one”
side) into your query definition.
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To illustrate the problem, do the following:
» Open the gryCatalogNum  query and make the
changes shown in Figure 4.15.
» Attempt to save the new section of “MUSC 105"
as shown in Figure 4.16.

There are two ways to avoid this error when deciding
which fields to project into your join queries:

1. Always show the table names when creating a
query based on more than one table. That way,
you can quickly determine whether the query
makes sense.

Always ask yourself: “What is the purpose of this
query?” If the answer is: “To add new records to
the Sections table,” you automatically have to
include all the fields from the Sections table.
Fields from the Courses table are only shown
for validation purposes.

Discussion

4.4.4 Non-updatable recordsets

Another problem that sometimes occurs when creat-
ing join queries is that the query is not quite right in
some way. In such cases, Access will allow you to
view the results of the query, but it will not allow you
to edit the data.

In this section, will look at a nonsensical query that
results from an incompletely specified relationship.
As you will probably discover, however, there are
many different way to generate nonsensical queries.
« Create a new query called gryNonUpdate
based on the Courses and Sections tables.
 Delete the CrsNum relationship but leave the
DeptCode relationship intact, as shown in
Figure 4.17.

The result of this query is that every section in a
Commerce course will be associated with every
Commerce course. Since allowing the user to update

[ M Home | [4Previous | 230f27
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Discussion

FIGURE 4.15: Create a data-entry query without a foreign key.

i gqryCatalogMum : Select Query

Reorder the fields (by
dragging and dropping) so

== | CrsNum

In version 2.0 you have t
selectView > Table
Names to display the

@

DeptCode

thatDeptCode and _ table row.
CrsNum are on the far leff> Secion

Session

CatalogMum x| /

‘b Change the source table fof«| | \ _.|_|
DeptCode andCrsNum !
from Sections  to ield: |DeptCode g dershum Cataloghlum [ Title Sectian =
Courses . Talk: | Courses Courses Sections Courses Sections —

Sart
S.hu.WE
Switch to datasheet mode =~ “M"®

c ar: <
and attempt to add a new o | ,
section of “MUSC 105".
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FIGURE 4.16: The result of attempting to save a record in which the foreign key is missing

@ Since the fields are bound to the
Departmen|{Course nur|CatalogNur Section Courses table, you are
MUSC 105 84545 Aural Skills 003 attempting to replace the

current record in th€ourses

| |comm 439 57167 Advanced T 007 = .
CRWR 202 28456 Creative For 001 table with *MUSC 105”. But

— : since a “MUSC 105" already

| |CRWR 202 38804 Creative For 901 exists, you get an error

| |CRwWR 202 00834 Creative For 902 o y '
WIISC 105 Microsoft Access

& Duplicate walue inindex, primary key, or relationship. Changes were unsuccessiul.

Attempt to save the
a :

new section by oK Help
clicking its record
selector.
[#Artome | [€Previous | 250f27
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FIGURE 4.17: Create a non-updatable recordset.

‘b Project fields from both tables and
- view the query in datasheet mode
(i.e., view the “recordset”).

Sections

= qryNonUpdate : Select Query

Department cc/Course numbe Section |
| [COomMM 437 001
| [COMmM 437 002
/, o B! C Atemptto
Field: [PeptCode [ Crshum Secion__— -~ change a value in
[Courses Courses Sections || COMM 437 the recordset.
/ COMM 437 e
: | [comm 437 003
; COMM 437 001
[l
ecord: 4] 4| 1 et v k] of 108
To create a nonsensical query, delete the .
A CrsNum relationship by clicking on it Note the absence of the asterisk and the “new record”
and pressing thBelete key. Leave the row. This is a sure sign that the recordset is non-updatable.

DeptCode relationship intact.
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the values in this recordset would create anomalies, should appear automatically. If they do not, see
Access designates the recordset as non-updatable. Section 4.4.3.
« Create a calculated field in your gryOrderDe-

A common mistake is to build data entry tails  query that calculates the extended price
forms on nonsensical queries and to assume (quantity shipped x price) of each order detail.
that there is a mistake in the form when the « Enter the first order into your system by entering
forms do not work. Clearly, if a query is non- the information directly into tables or queries.
updatable, a form based on the query is also This involves creating a single Orders record
going to be non-updatable. A quick check for and several OrderDetails  records. You must
a “new record” row in the query can save time also consult the Products and BackOrders
and frustration. tables to determine the quantity of each item to
ship.
4.5 Application to the assignment P
 Create a query to sort the Products table by @ Entering orders into your system will be much
ProductID less work once the input forms and triggers
* Create a query that joins the OrderDetails are in place. The goal at this point is to get
and Products tables. When you enter a valid you thinking about the order entry process
ProductID , the information about the product and ways in which it can be automated.

(such as name, quantity on hand, and so on)
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Access Tutorial 5: Basic Queries usin

5.1 Introduction: The difference

between QBE and SQL

Query-By-Example (QBE) and Structured Query
Language (SQL) are both well-known, industry-stan-
dard languages for extracting information from rela-
tional database systems. The advantage of QBE (as
you saw in Tutorial 4) that it is graphical and rela-
tively easy to use. The advantage of SQL is that it
has achieved nearly universal adoption within the
relational database world.

With only a few exceptions (which you probably will
not encounter in this assignment) QBE and SQL are
completely interchangeable. If you understand the
underlying concepts (projection, selection, sorting,
joining, and calculated fields) of one, you understand
the underlying concepts of both. In fact, in Access
you can switch between QBE and SQL versions of
your queries with the click of a mouse.

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 22-Aug-1997
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FIGURE 5.1: Open a query in SQL mode

@, Microsoft Access

File Edit BEEZHE Insert Query Tools Window Help
] e

& Queryl : Select Query

||SELECT DISTINCTROW:;

5.3.1 Basic SQL queries

A typical SQL statement resembles the following:
SELECT DeptCode, CrsNum, Title FROM
Courses WHERE DeptCode = “COMM”;

There are four parts to this statement:

1. SELECT <field 4, field », ..., field n>
— specifies which fields to project (the DIS-
TINCTROWpredicate shown in Figure 5.1 is
optional and will not be discussed in this tutorial);

[DEtashiEet

Timtals
v ekl el Emes

g SQL

Although you normally use QBE in Access, the ubig-
uity of SQL in organizations necessitates a brief
overview.

5.2 Learning objectives

O What is the difference between QBE and
SQL?

O How do | create an SQL query?

5.3 Tutorial exercises

In this section, you will create a few simple queries in
SQL.
» Create a new query but close the “show table”
dialog box with out adding tables.
» Select View > SQL to switch to the SQL editor as
shown in Figure 5.1.

e | ¢ e JEOE

Tutorial exercises

2. ... FROM <table> ... — specifies the underlying
table (or tables) for the query;

3. ... WHERE <condition ; AND/OR
condition  ,, ..., AND/OR condition
specifies one or more conditions that each record
must satisfy in order to be included in the results
set;

4. ; (semicolon) — all SQL statements must end
with a semicolon (but if you forget it, Access will
add it for you).

n>_

These can now be put together to build an SQL
query:
 Type the following into the SQL window:
SELECT DeptCode, CrsNum, Title FROM
Courses WHERE DeptCode = “COMM”;
* Select View > Datasheet to view the results.
» Select View > Query Design to view the query in
QBE mode, as shown in Figure 5.2.
» Save your query as qryCoursesSQL .
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Tutorial exercises

FIGURE 5.2: The SQL and QBE views are interchangeable.

e=f Queryl : Select Query

WHERE DeptCode = "COMM";

& Queryl : Select Query

When you return to SQL mode
after viewing your query in QBE
mode, you will notice that Access

@

M=l 3

SELECT DeptCode, CrsNum, Title FROM Courses

(=] E3

has added some additional text. Ll | _>|_I |
This optional text does not —~
Change the query |n any Way Field: CeptCode CraMum Title —
Tahble: | Courses Courses Courses -
Sort:
Showy:
Criterig: |"CObb"

ar: hd

o | _'l_I
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5.3.2 Complex WHERE clauses

You can use AND, OR, and NOT conditions in your
WHERE clauses in a straightforward manner.
» Change your query to the following to get all

Commerce courses with more than three credits:

SELECT DeptCode, CrsNum, Title
FROM Courses

WHERE DeptCode = “COMM” AND Credits
>3

AN\

Note that since DeptCode is a text field, its
criterion must be a string (in this case, the lit-
eral string “COMM”). However, Credits is a
numeric field and its criterion must be a num-
ber (thus, there cannot be quotation marks
around the 3).

Tutorial exercises

5.3.3 Join queries

Join queries use the same elements as a basic
select query. The only difference is that the FROM
statement is replaced with a statement that
describes the tables to be joined and the relationship
(i.e., foreign key) between them:
... FROM table 1 INNER JOIN table
table ,.field =table ,.field ..
Note that since both tables contain the fields Dept-
Code and CrsNum, the <table name>.<field
name> notation must be used to remove any ambi-
guity.
« Create a new SQL query containing the text:
SELECT Courses.DeptCode,

Courses.CrsNum, Courses.Title,
Sections.CatalogNum

FROM Courses INNER JOIN Sections ON
Courses.CrsNum = Sections.CrsNum

» ON

[ Home | [4Previous |

4 0of5




5. Basic Queries using SQL

AND Courses.DeptCode =
Sections.DeptCode

WHERE Courses.DeptCode="COMM";

5.4 Discussion

Although the syntax of SQL is not particularly diffi-
cult, writing long SQL queries is tedious and error-
prone. For this reason, you are advised to use QBE
for the assignment.

In the real world, however, when you say you know
something about databases, it usually implies you
know the “data definition” and “data manipulation”
aspects of SQL in your sleep. If you plan to pursue a
career in information systems, a comprehensive

SQL reference book can be a worthwhile investment.

[ M Home | [4Previous |
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Access Tutorial 6: Form Fundamentals

6.1 Introduction: Using forms as

the core of an application

Forms provide a user-oriented interface to the data
in a database application. They allow you, as a
developer, to specify in detail the appearance and
behavior of the data on screen and to exert a certain
amount of control over the user’s additions and mod-
ifications to the data.

Like queries, forms do not contain any data. Instead,
they provide a “window” through which tables and
gueries can be viewed. The relationship between
tables, queries, and forms is shown in Figure 6.1.

In this tutorial, we are going to explore the basic ele-
ments of form creation using Access’ form design
tools. In subsequent tutorials, we will extend the
functionality and ease-of-use of our basic forms with
subforms (Tutorial 7), “combo box” controls

(Tutorial 8), and triggers (Tutorial 13).

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 24-Aug-1997

6. Form Fundamentals
8 How do | make the contents of a field on a
form read-only?

O Whatis an unbound text box? How do | create
one?

a

How do | create a form using the form wizard?

8 What is the difference between a columnar
(single-column) and tabular form?

6.3 Tutorial exercises

6.3.1 Creating a form from scratch

Although Access provides an excellent wizard for
creating simple forms, you will start by building a
form from scratch. This will give you a better appreci-
ation of what it is the wizard does and provide you
with the basic knowledge needed to customize and
refine the wizard’s output.

FIGURE 6.1: The relationship between forms,
queries, and tables.

i forms

gueries

tables

Courses Departments Employees

6.2 Learning objectives
O Do forms contain data?

O How do | create a form?

P [mmms] 1o

Tutorial exercises

« Create a new blank form based on the Courses
table, as shown in Figure 6.2.

* The basic elements of the design screen are
shown in Figure 6.3. Use the View menu to dis-
play the toolbox and field list if they are not
already visible.

6.3.1.1 Addin g bound text boxes
» Add a “bound” text box for the DeptCode field by
dragging DeptCode from the field list to the form
background, as shown in Figure 6.4.
» Reposition the DeptCode text box in the upper
left of the form.

@

Remember that you can always use the
“undo” feature to reverse mistakes. Select
Edit > Undo from the menu or simply press
Control-Z (this works the same in virtually all
Windows applications).

20f15
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FIGURE 6.2: Create a new form to display data from the  Courses table.

= univl_v? : Database =] E3

Tablesl Oueries Faorms | B Repor‘csl Z Macros | P Modulesl
| P |

Hew Form

Select thd=orms tab from
= |

the database window. Vi
Farm Wizard

AutoForm: Columnar
AutoFarm: Tabular
AutoForm: Datasheet
Chart WWizard
FivotTable Wizard

rm without using

Bind the form to the
C Courses table.

‘b SelectDesign View (do not
use the wizard at this point)

Choose the table or queny where j
the ohject's data comes from:

Catalog Wiew

Ok Departments

@ Since you can build a form on top of a table ora————__|FmEmees
query, both are shown in this list (here is wherea——® 172 "0,
meaningful naming convention starts to pay off) aryCourses

Sections

[P [mmms] 9015
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FIGURE 6.3: The basic elements of the form design screen.

& Form! : Form A=

File Edit Insert Format Tools ‘Window
El-|-]-|-2-|-3-|-5-|-r-|-g-|-9-|-]g-|-

[ [ Detai H © FormDesion ol =)
- | | | |

Form
! | . IFDI‘I’T’I Datashest E |
N @ To change the size of
— the form, drag the edges——
- of the detail section.

Properties

- , \ - - . Tak Order..
2 ‘ ‘ ’ v ‘ Code
v Buler
3 ' : S Courses B4 y arid
- Dey de v Toolbox

CrsNum
Title

Credits
Activity

Page Heade
Form Header/Fosger

- Toolhars...
1]

The field list — shows the fields The toolbox — the icons in the @ If the field list and toolbox
in the table or query to which the toolbox are used to create graphical are not displayed, use the
form is bound. items and controls on the form. View menu or toolbar icons.
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FIGURE 6.4: Create a bound te

@

If no caption is specified, the field name (el2ep
time editing labels, choose your captions with

Tutorial exercises

xt box for the  DeptCode field.

Access uses the field’s caption property as the default label for the text box.
tCode ) is used. To save
this feature in mind.

B Form1 : Form

Drag the highlighted field on

'I'l'l'2'l'?'l'4'l'5'l's'I'l"l

To

to the form’s detail section.

l_l XDetaiI

i

:

To move an object and its
e epar

e

o
H

label, drag the center of th ment co Ebepu:ade

object (the cursor becomes DES
a white arrow). To move // < Alabl
just the object or just the

label, drag the upper left

a5
| TL

handle (the cursor becomes
a pointing finger).
a

Select theDeptCode
field in the field list.

8 Courses E

L |

B8]
B | B

+
[
]

1

Credits
Artivity

s
0
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 Drag the remaining fields on to the form, as
shown in Figure 6.5 (do not worry about whether
the fields are lined up perfectly).

* Select View > Form to see the resulting form.
Alternatively, press the form view icon (E).

 Select View > Form Design or press the design
view icon (k£)) to return to design mode.

6.3.1.2 Using a field’s properties to protect its

contents

Every object on an Access form (e.g., text box, label,
detail section, etc.) has a set of properties that can
be modified. In this section, you are going to use the
Locked and Enabled properties to control the user’s
ability to change the information in a field.
 Select the DeptCode text box and right-click to
bring up its property sheet, as shown in
Figure 6.6.

Tutorial exercises

 Scroll down the property sheet to the Locked
property and set it to Yes, as shown in
Figure 6.7.

« Switch to the form view and attempt to change
the contents of the DeptCode field.

A stronger form of protection than locking a field is
“disabling” it.

» Return to design mode and make the following
changes: reset the Locked property to No; set the
Enabled property to No.

» Attempt to change the contents of the DeptCode
field in form view, as shown in Figure 6.8.

« Save the form as frmCourses

6.3.1.3

All the text boxes created in the previous section
were “bound” text boxes—that is, they were bound to
a field in the underlying table or query. When you
change the value in a bound text box, you are mak-

Adding an unbound text box
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Tutorial exercises

FIGURE 6.5: Add the text boxes and switch to form view to see the resulting form.

Text boxes are simply

@

D|-|-1-|-2- Fogr gl gl g g g g g |-11-| f‘Windows”on_tothefields
[*0eai in the underlying table.

_ |Depatmentc: de:| |Dept(_“;ode zE] urm1 Form I I

] {‘“w. Eritrik .:I I’“rsNulm | | - Deparment code: |COMM

- |Tit|e Course number: |29E|

2 it ICrEdiTIS | | Title: |Introdudi0ntu Quantati,

; 5ctivitly Credits: | 3

'_ Activity: |LEC

Add the remaining
a fields to the form.

@

button when selecting the fields from the field li

SelectView > Form from the
main menu to view the form.

You can add more than one field to the form with ak T e e of 11
drag-and-drop operation by holding down @mntrol

st.
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FIGURE 6.6: Bring up the property sheet for the

[ M Home | [4Previous |
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DeptCode text box.

Right-click once on the selected

object to get the pop-up menu.
D|'I'1'I'2'I'3'I'4'I'5'I's'I'P'I'a'l'/v/Y'm'lw
[ ][* Detai .
- ——=— = SelectProperties to get the
- epaftment chde: | @eptclode. | ﬁ Ic Pr0pelrty sheet.
1 s numbar R |crshiur Build Event... Jl= TextBox DeptCode K
- ITiﬂE Contral ieard.. Formatl Data I Ewvent I Other All |
2 Treie |Credits 0] sjj=1e F = MName.............. DeptCode -
_ Contral Source .. . .. DeptCode
- Activi%ll/ [Activiy Change To " | Fomnat. ... -
3 i | | Align » | | Decimal Flaces. ... Auto
- / Input bask ... >LLLL
Select the object (e.g., the = - DIGEIEAENE oo :
| 9. Co validation Ful The properties are broken down
DeptCode text box) for py sieaton Fule. /.. -
p ; Paste Validation Text /.. into four groups. To see all the
which youwish to see the o . Stetus Bar Tey! properties, select thall tab.

properties. When an object
has been selected, it is

LRy

~

bordered by six dark
“handles”.

Some properties of the text box (such as
input mask) are inherited from the field
to which the text box is bound.

@
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FIGURE 6.7: Change the Locked property of
DeptCode to Yes.

Srrnll Bars

A

Use the scroll bar to find
theLocked property.

l:“"'l'"2"'3"'4"'5"'8'"?'
[ ][* Detsil
T S |!
- epaftment c de:| EleptCDde [
- I B o
1 _E\.FIIIFC::I Anrnbdr | [rretlim
)
E Furmatl Data | Ewent | Other All |
—E Enter Key Behawior. Default -
- E Allow AutoCarrect. . Yes
= Wisible ... “rEs
- Display When ... ... Alwrans
N Enabled .. ........ Tes
Locked ... .........
_ FilterRookup .......
Auto Tab e ... ..
5 Tab Stop. .\, ...
‘_I TabIndex.... \...

Tutorial exercises

ing the change directly to the data in the underlying
table.

It is possible, however, to create objects on forms
that are not bound to anything. Although you will not
use many “unbound” text boxes in the assignment, it
is instructive to see how they work.
e Create a new empty form bound to the Courses
table and save it using the name
frmCoursesUB .
* Select the text box tool (abl) from the toolbox and
create and unbound text box, as shown in
Figure 6.9.

6.3.1.4

The only difference between a bound and an
unbound text box is that the Control Source property
of a bound text box is set to the name of a field. In
this section, you are going to change the unbound
text box shown in Figure 6.9 to a bound text box.

Binding an unbound text box to a field

90f15
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FIGURE 6.8: Set the Enabled property of DeptCode to Noand attempt to change the value in the
field.

1

-
v | et |t

|_“-|-1-|-2-|-3-|-4-|-5-|-5-|-?
¥ Detail
T T n— T ’
ERETEnb e eptCDde. :
| |
_E‘.nlqul:l ke | [Cestlirn
E ¥ Text Box: DepiCode
Formatl Diata I Ewent I Cther
—E Enter key Behavior. Default
|: Allow AutoCorrect. . Yes
| —
| = Visible .. . “es 8 Form1 - Form
Display‘When ... ... Al
Enabled ... ... No Depattmenteade:
Locked . ........... Mo Course nurmbar
Filter Loakup .. ... .. Databas _
AutoTab. ... .. Ma Title:
TabStop.......... Yes Crrailia:
Tabindex.......... 0
Srrnll Rars Nrna Activity:

Qa

SetlLocked toNo and
Enabled to No.

Switch to form view
to see the result.

@

When a form object is disabled, it
cannot receive the “focus” (that is,
you cannot put the cursor on it).

|COMM

|2an

By default, disabled form objects are

|Intr0du1:1i0n to Cluantatiy

greyed out. To override this feature,

set theLocked property toYes and
3 the Enabled property toNo.

|LEC
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 Bring up the property sheet for the unbound text
box. Change its Control Source property from null
to DeptCode , as shown in Figure 6.10.

FIGURE 6.9: Create an unbound text box.

= 1 Select the text box tool from the toolbox.
The cursor becomes a small text box.

6.3.2 Creating a single-column form
B frmCoursesUB : Form using the Wizard

%l;;;t;ll IEAEEE SENS SR AR AN | Now that you understand the basics of creating and
- I I I modifying bound text boxes, you can rely on the form
- || el funbound wizard to create the basic layout of all your forms.

! /‘ « Create a new form bound to the Courses table

s
7

&
=

A

. ™= using the form wizard, as shown in Figure 6.11.

- & * Use the form wizard to specify the fields you want

2 Click anywhere on the EH on your form and the order in which they appear,

- b detail section to create a as shown in Figure 6.12. Select “columnar” when

new unbound text box. prompted for the form type.
- = .
- “Columnar” forms are called “single column”
forms in version 2.0.
[ M Home | [4Previous | 11 ofl5
6. Form Fundamentals Tutorial exercises
FIGURE 6.10: Set the Control Source property FIGURE 6.11: Create a new form using the form
of an unbound text box. wizard.

New Form HE

B frmCourseslUB : Form

—_—_—_ n "
|—||III1III2IIIFIII4III5IIIEIIITIII o Design Yiew
¥ Detail x% \ toForm: Colurnar

- | [ - | - utoForm: Tabular
- extE:J %ept&:de I . : AutoForm: Datasheet
- | | = | m This wizard automatically Chart YWizard

l creates wour farm, based on the . :

- T Text Box: Text? ST e el FivotTakle Wizard

iy FDrmatl Data | Ewent I Other All |

ii = Select the form
: wizard.

Choose the table or queny where -
the object's data comes from: ICDWSES J

Input hask......... Title A

4 Defaultvalue . .. ... Credits .

- walidation Bule .. ... Ativity Ok b Bind the form to the
‘alidation Text. .. .. Courses table.

Status Bar Text. ...

a2 Use the pull-down list to set
the Control Source property
to DeptCode .

[ M Home | [4Previous | 120f15




6. Form Fundamentals

Tutorial exercises

FIGURE 6.12: Use the form wizard to determine the order of fields on your form.

The order in which
the fields appear in
this pane is the order
in which they will

appear on the form.
Use the< and<<
buttons to move
fields back to the

Form Wizard
YWhich fields do you want on your form?
%é? ) o You can choose from more than one table ar guery.
Tahbles/CQueries:
ITabIe: Courses J
Available Fields: Selected Fields:
Title DeptCode
Credits 2 |
> |
_< |

to show a field, either double-
click it or press the- button.
1

pane on the left.

@ To show all the fields, press the
>> putton.

Cancel |

ok [ meas | Einish |

13 0f 15
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6. Form Fundamentals

The primary advantage of the wizard is that it auto-
matically creates, formats, and aligns the bound text
boxes. Of course, once the wizard has created a
form, you are free to modify it in any way.

@ If you make a mistake when creating a form
(e.g., you put the fields in the wrong order) it
is often easier to use the wizard and start over
than to fix the problem manually.

6.4 Discussion

6.4.1 Columnar versus tabular versus
datasheet forms

Columnar forms show one record per page. Tabular
forms, in contrast, show many records per page and
are used primarily as subforms. There is also a a
datasheet form type, but it is seldom used since it
gives the developer relatively little control over the

Discussion

look and behavior of the data. The three different
types of forms are shown in Figure 6.13.

6.5 Application to the assignment
* Use the wizard to create columnar forms for all
your master tables. Note that in some cases
(e.g., BackOrders ) you will want to base the
form on a join query rather than table in order to
show important information such as CustName
and ProductName .

14 of 15
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6. Form Fundamentals Application to the assignment

FIGURE 6.13: The same information displayed as a columnar, tabular, and datasheet form.

— Courses =] I A | f disol
» B columnar rorm dispilays
Department code ICOMM - one record per page.
Course number IEQD ||
Title - B Courses (tabular) S [=] E3
|_ Department coc Course numbe Title Credits  Activity
Credits I_ p || CORM 290 Introcluction to Quantative Decision Making 3 |LEC
ey 1= COhdARA 291 Applied Statistics in Business 4|LEC
Ety = o Y 36 Financial Accounting JIEC
Record: 14| 4] 1 COMM 439 & Courses (datasheet) = B3
CRWR 20z Title i Activity
CRWR 4% | |COMN290  Introduction to Quantative Decisio 3LEC
A tabular form EEEE 3318 | |COMN291  Applied Statistics in Business 4 LEC
displays more tham——#= T 55— || COM! 351 Financial Accounting 3LEC
one record per page. MATH a0 | [COMMN439  Advanced Topics in Information 5 3LEC
YIS 105 | |CRW|202 | Creative Forms 6 SEM
= | |CRWW|496  Poetry Tutorial 6 TUT
.. . S EDUC 306  Curriculum and Instruction in Hea 3 LEC
C‘i gxtgfgigmgrg: asugr?/ntgiﬁlcfaoi:g?v%zt?ﬁgee—L | |ENGL 301 Technical and Business Writing 3 LEC
H . ) ‘ | N} Tl - . 4
designer very little control over the format of thé— Ir\\HA{ e :tr?_df:fr; to EtOThQSt'C Procest g tgg o
data, it is generally inappropriate for use in an || PRIED WIELX ANEl SIS b
end-user application. Record: 141 4] 3 b [ b1 [pk] of 11 JCN — iy
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Access Tutorial 7;: Subforms

7.1 Introduction: The advantages of
forms within forms

A columnar/single-column main form with a tabular
subform is a natural way of representing information
from tables with a one-to-many relationship. For
example, the form shown in Figure 7.1 is really two
forms: the main form contains information about a
specific course; the subform shows all the sections
associated with the course.

In the Courses and Sections example, the foreign
key (DeptCode and CrsNum) provides a link
between the two forms. This connection allows
Access to synchronize the forms, meaning:
» when you move to another course record, only
the relevant sections are shown in the subform;
» when you add a new section, the foreign key in
the Sections table is automatically filled in (in

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 25-Aug-1997

7. Subforms

fact, there is no need to show DeptCode and
CrsNum in the subform).

Although you will quickly learn to take a feature such
as form/subform synchronization for granted, it is
worthwhile to consider what this feature does and
what it would take if you had to implement the same
feature using a programming language.

7.2 Learning objectives
O What is form/subform synchronization?
O How do | create a form/subform combination?

O How do | link a form with a subform?

7.3 Tutorial exercises

Although there are a number of different ways to cre-
ate a subform within a main form, the recommended
procedure is the following:

[P [mmms] o119

Tutorial exercises

FIGURE 7.1: A typical form/subform combination.

Because a link is established between the main form
and the subform, only the sections that belong with
“COMM 351" are displayed in the subform.

The main part of the form is
8 Courses

columnar (one record per pages

and displays information from Depariment code Credits| 7]
theCourses  table. Course number Al:tivity

Title |Financial Acm/unting

CatalogMNum Sectionéessiun

Term Meeting days Meetingtime Building Room =
p [[13713 oot Jlasw | 1| [za0-1000 JlanGU [laze |
. g2937 ooz Jlasw | 1] [t W [fooo-1130 JlanGu Jlaze |
The subform is a separate |
tabular form that disglays ///" 23832 ooz Jlssw | 1w [gan-z130 Jlancu Jlain [
information from the *|| I | I ] I | [ |-
Sections table.
[#riome ] [€Previous ] 20719




7. Subforms Tutorial exercises

1. create and save both forms (one columnar, one space they occupy. A number of editing issues
tabular) separately; are highlighted in Figure 7.5.
2. drag the subform on to the main form; and, » Save the form as sfrmSections  and close it.
3. verify the linkage between the two forms.
7.3.3 Linking the main form and subform
7.3.1 Creating the main form In this section, you are going to return to the main
* Use the wizard to create a columnar form based form and drag the saved subform from the database
on the Courses table. window to an appropriate position on the main form.
» Rearrange the fields so that they make efficient » Open the main form (frmCoursesMain ) in
use of the top part of the form, as shown in design mode.
Figure 7.2. » Select Window > univO_vx: Database to open the
» Save the form as frmCoursesMain . database window in the foreground. Alternatively,
you can press the database window icon (f£l) on
7.3.2 Creating the subform the tool bar.
« Use the wizard to create the subform, as shown * Perform the steps shown in Figure 7.6 to drag the
in Figure 7.3 and Figure 7.4. subform on to the main form.
« Subforms created by the wizard typically require * The result of the drag-and-drop operation are
some fine tuning in order to reduce the amount of shown in Figure 7.7. The advantage of the drag-

and-drop method of creating a sub form is that

[P [mmms] 0119
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FIGURE 7.2: Rearrange the text boxes on the main form to make room for the subform.

.
= Use the wizard to create a D
columnar form based on

Courses . : # Form Header
-_ |Departmentc:|de||Depth|
Enter form design mode and || ; T =]
] —feaurae-ﬁtrrr CrsMun } ety
b rearrange the text boxes to - JWH — 1,
make room for the subform.  ||- Jitle] [Title
5 — L
: —
: (VEE N L
Save the form under the name || 2 Achvi o
) : ty| |Aactivitl [/ |
C frmCoursesMain . - \I— ‘
* Form Footar

@ To move more than one form object at a time, either
hold down theshift key when selecting or drag a box
through the objects (click and drag to create a box).
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7. Subforms Tutorial exercises

FIGURE 7.3: Use the wizard to create the Sections subform (part 1).

There is no need to include
DeptCode andCrsNum since they

New Form Kk are shown in the main form.
§% \ AutoFarm: Co Form Wizard

AutaForm: Te
AutoForm: D
This wizard automatically CEE?H \?\:ir;ardf §% %

creates your farm, based anfhe PivatTahle W % v

fields you selact @ The order in which the fields are added to
the right-hand pane determines their order

(from left to right) on the form. Use the

and> buttons to get the desired ordering.

YWhich fields do wou want on your farm?

“ou can choose from more than one tahle o

Tahbles/Cueries:

ITabIe: Sections

Awailable Fiel
DeptCode

= Select the form wizard and bind the
new form to theSections table.

[ M Home | [4Previous | 50f19
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FIGURE 7.4: Use the wizard to create the Sections subform (continued)

Fom Wizgrd |

‘What layout would yau like for your farm? @ In version 7.0, the title appears in the bar
across the top of the form’s window. In

version 2.0, however, the wizard creates a

title in a form header. As such, you

' Columnar should ensure this is blank if you are

& Fahuise using version 2.0.

¢ Datasheet
Form Wizard

What title do you want for your form?

»

Since a subform is embedded in a main
form, you do not have to provide a title.

That's all the infarmation the wizard needs to create your form.

Do youwant to open the form or modify the form's design?

Cancel
@ SeleCMOdify the form’s design to " Open the form to wview or enter information.
enter form design mode directly. & & padifythe form's design.
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7. Subforms Tutorial exercises

FIGURE 7.5: Edit the subform to reduce the amount of space it uses.

Reduce the vertical space by moving the fields up to the
“detail band” and bringing the “form footer” band up

= § s dee 1z Terlzonil Space L g against the fields (to move a band, drag it using the mouse).

by the headings and fields.

BEal e /o @ To split the headings into two
R R R A R R or more lines, place the cursor
# Form Hader at the desired split location and
B Catalog‘ kAestin ‘ MeetingH/ | preSSShlﬁ'Enter'
M Bection [ Sessioh | | Ter de tie Building | Rogrm
* Cietail

aEiaID_gNumrEegiDnﬁLEes_siunﬁrerﬁn WS _ ﬁ'l'ime - ﬂ'@uilﬁingﬁhugm EI

# FornrFont
FormTT T ooteET

@ To move all the fields at once,

drag a “selection box” so that it
touches each field. Note that the
box does not have to enclose
objects for them to be selected.

[P ] [fmms] 7o
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FIGURE 7.6: Drag the subform on to the main form.

Open the main form_
El |-3-|-4a|ndeS|gnmode R R

# Form Header
* Detail

Position the database
) window so that the

! [ e Hes eS| CreNun subform’s target

N Title| Tils destination is visible.

_ || |Depaftment c:de| |De|pth| /
I

g= univl_v? : Database

3
E k Tablesl Queries Farms | B Repors| 2 Macmsl <3 Mudulesl

4 frmCourses Open
- \ frmCoursesMain :

- frmCoursesUB Design
. sfrmSections |

_I # Form Footer Mew

- Drag the subform on
- C to the main form.

if
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7. Subforms Tutorial exercises

the width of the subform control (the white win- Since both the forms created in Section 7.3.3 were
dow) is automatically set to equal the width of the built on tables, Access could automatically deter-
subform. mine the relationship.
* Verify the link between the form and the subform
If you make changes to the size of your sub- by examining the property sheet of the subform
form once the subform control is created, you control, as shown in Figure 7.8.
may have to resize the subform control by
clicking and dragging a corner handle. The terminology “link child field” and “link
master field” is identical to “foreign key” and
7.3.4 Linking forms and subforms “primary key”. The main form is the parent
manually (“one” side) and the subform is the child
If both the form and the subform are based on (“many” side).

tables, and if relationships have been defined
between the tables, Access normally has no problem
determining which fields “link” the information on the
main form with the information in the subform. How-
ever, when the forms are built on queries, Access
has no relationship information to rely on. As such,
you have to specify the form/subform links manually.

 View the resulting form. Notice that as you move
from course to course, the number of sections
shown in the subform changes (see Figure 7.9).

[P [mmms] 90119
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FIGURE 7.7: The drag-and-drop operation creates a subform control.

B frmCoursesMain : Form

C[rrvrzrirar e s e tip et s L0 L0 2 U Tha white arealis a
3 # Form Header “subfor_m contr(_)I". It is
# Deteil essentially a window
_ |Departmentc::ude||Delpth| through which the subform
I

shows.

Ativite] [Activit]

i {’“u FEETHTT b.:.HCrslNunI
N Titie [Title

sl [ [ [ T [ T [ T T ¥

timSections You may want to

T delete the label
N created with the
4= subform window. To
- delete the label only,

This is the name of the form to which ]
5 the subform control is bound. SDF”elﬁa%'t and press

l I | | |
b 2

B f
_I ¥ Form Footer

@ The form footer is pushed down when the subform control is created. You
may move the footer to create more or less area at the bottom of the form.
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7. Subforms

Tutorial exercises

FIGURE 7.8: Verify the link fields for the form/subform.

B frmCoursesMain : Form

I_“"'1"'2""3"'4"'5"'8"'?" '

g

¥ Form Header

|

# Detail

I
_ || |Depattment chde| |DeptCd
I

1 i““u FE T b.:.HCrsNunI
- I

- Title| [Title

o N

_'sfrmSer:tiDns

Format | Data | Ewvent | Other All
MName.. ... ... .. Sections

- Source Object. .. ... sfrmSections

Link Child Fields .. .. DeptCode:CraMNurm
Link baster Fields .. DeptCode:CraMNurm
Status Bar Text.. ...

Select theéSections  subform
control (the white window) and bring
up its property sheet.

Verify that Access has correctly
determined the link fields.

When there are more than one link
fields (i.e., the foreign key is
concatenated), separate the field
names with a semicolon. In Access

8 —=F wishle.. . ... Yes version 7.0, a builder is available to
4 Display When ... ... Abrays select the field names from a list.
[ M Home | [4Previous | 11of19
7. Subforms Tutorial exercises
FIGURE 7.9: A synchronized main form/subform.
B frmCoursesMain
a2 Note that for COMM C For COMM 291, four )
290, eight courses ate sections are listed in~g—{-Lepariment code |2
listed in the subform. the subform. m
ey R —y——— Title |Applied Statistics in Business
s ) Sections
Click the “next Coursexumber 290 Catalog Meeting
b record” navigation MNum ction Session  Term days
. § Introduction to tati
button on the main U > :;‘:gg gg; gx E :“V\“FV
form to move to the :
Sections
next course. 30293 o3 EISW\ 2((rd
Catalog 53209 004 55 2[[MW
Mum Sectiol\ Session * 0
P[4 oo W Fecord: 4] 4] 10 | v |e#] of 4
ENES nnz2 BN
@ There are two sets of TN T
navigation buttons: 1645 Tz IEE Recordt WU 2 p Iyiplofn
one for the main form 53495 \&05 vy 1[[MF [[300-1430 [amGU [[415 |;*
(bottom) and one for Record: 14] 4 1 |1 [r] of 8 <] 8
the subform (at the = !

bottom of the
subform window).

<ﬁecord: 4] 4 || 1 | e e of 11

12 of 19
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7. Subforms

7.3.5 Non-synchronized forms

In this section, you will delete the link fields shown in
Figure 7.8 in order to explore some of the problems
associated with non-synchronized forms.

* Return to form design mode and delete the link
fields (highlight the text and press the Delete
key).

* View the form. Note that all records in the Sec-
tions table (not just those associated with a
particular course) are shown.

» Attempt to add a new section to COMM 290 as
shown in Figure 7.10.

» Re-establish the correct link fields and save the
form.

7.3.6 Aesthetic refinements

In this section, you will modify the properties of sev-
eral form objects (including the properties of the form

Tutorial exercises

itself) to make your form more attractive and easier
to use.

In Figure 7.11, the basic form created in the previous
sections is shown and a number of shortcomings are
identified.

7.3.6.1 Changing the form’s caption
« Select the form as shown in Figure 7.12.
» Change its Caption property to “Courses and
Sections”.

7.3.6.2 Eliminating unwanted scroll bars and

navigation buttons

Scroll bars and navigation buttons are also form-
level properties. However, in this case, you need to
modify the properties of the subform.
¢ To quickly open the subform in design mode,
double-click the subform control when viewing
the main form in design mode (this takes some
practice)

13 0f 19
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FIGURE 7.10: A non-synchronized main form/subform.

; 5 frmCoursesMain =] E3
A figsiorme || | copemeneat
SUbe!‘m control Course nurmber ACtivity
raggu?{:ﬁ\évf@rem Title |Introduction to Quantative Decision Making
Sections
‘. Catalog heeting heeting -
SNe(z:ttelotrl;]Satsﬁlcl)v:?Z Turm Section Session Term dawys time Building Roorn
the subform n\\ 37358 oo 95 O[T Th 1030 MUSC 307
(movin to a \%Lw ooz LY O[T Th 1130 MUSC |30
diﬁerer?t course Gl R | EEL O[T Th 1430 MUSC_[[301
#F ||00007 N 0
has no effeCt)' / * { Tl Microsoft Access
Pécard: 4] 4] a7 b | e[| of 37
c Add a new & Index or primary key can't contain a null value.
catalog number% /
k R o 4] 4 I Tk |kl |r¥| of 11
and click the eoonc: 1] 2 1M IrH o

record selector
to try to save the
new record.

@

Since the forms are not synchronized, the
DeptCode andCrsNum fields of theSections
table are not automatically filled in by Access.

0K
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7. Subforms

Tutorial exercises

FIGURE 7.11: A form/subform in need of some basic aesthetic refinements.

The caption of the form shows the form’s name.
A more attractive/descriptive caption is required.

H frmCoursesMain [ (O]
4 Departrment code [ Cradits
Course number Activity
Title |(Introduction to Quantative Decision Making
Sections
Catalog teeting Meeting =
MHum Section Session  Term days time Building Room
P [|44411 oo EEINY [ W 830-1000 AMGU (1413
57455 ooz LRIy 1w F g30-1000 ANGL 41V
48516 003 LRI 1| F 1030-1200  ||ANGU 5
71845 0o4 LRIy [ W 1000-1130  [[ANGLU A]413
69495 0os LRI 1||md F 1300-1430 AN% 415 =
Record: 14] « || T r kol - 4] []
Fecord: 14 4 II Tk | m ek of 11 - 4

Since the subform control
was automatically sized to
fit the underlying form, a
horizontal scroll bar is not
necessary.

The navigation buttons for
the subform are too easily
confused with the
navigation buttons for the
main form

7. Subforms

FIGURE 7.12: Select the entire form.

A

Click on the square where the vertical
and horizontal rulers meet in order to

get the property sheet for the form.

B fr+CoursesMain : Form

@|'I'1'\I'2'I'3'I'4'I'5'I's'l'?'l'a

¥ Form Heﬁder

# Detail |

\ T
_ |Department\c:nde||Depth|

- Saclior Fecord Source . ...
- pr—— Filter. ............ ..
3 OrderBy...........
- Allow Filters ... ..
Caption............
Default Wiew . ... ..
Wiews Allowed ...
Allow Edits ...
Allow Deletions . ..

<E| _

Courses

Yes
frrmCourseshain
Single Form
Both

Yes

Al |

_ | I
1 l“‘_u._.:..u e Cratunk
_ &7 Form

FDrmatI Data I Ewent I Other

[ M Home | [4Previous |
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Application to the assignment

 Bring up the property sheet for the form and scroll
down to change its Scroll Bars and Navigation
Button properties, as shown in Figure 7.13.

The net result, as shown in Figure 7.14, is a more
attractive, less cluttered form.

7.4 Application to the assignment
 Create a form and subform for your Shipment

and ShipmentDetails

information. You will

use this form to record the details of shipments
from your suppliers

Note that both forms should be based on queries:
 the Shipment form should be based on a “sort”
query so that the most recent shipment always

shows first;

 the ShipmentDetails

form should be based

on a join query so that validation information
(such as the name of the product) is shown when
a product number is entered.

[ Home | [4Previous |
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7. Subforms

FIGURE 7.13: Change the scroll bars and
navigation buttons of the subform.

B sfrmSections : Form

Set theScroll Bar

Application to the assignment

Create a form/subform to show customer orders
that have already been placed (such as the one
you entered manually in Section 4.5). The top
part of the form should contain information about
the order plus some information about the cus-
tomer; the subform should contain information
about what was ordered and what was actually
shipped.

The form you created in the preceding step is
used for viewing existing orders, not for add-
ing new orders. To add new orders, the form
must be more complex. For example, it has to
show the quantity on hand and the back
ordered quantity for each item so the user can
decide how many to ship. You will create a
form for order entry in the latter tutorials.

Set the Allow Additions and Allow Edits proper-
ties of the “order viewing” form to No. This pre-

17 of 19

mrTe T & property to “Vertical

¥ Form Header Only” and theNavigation

- Catalug‘ Buttons property to “No”.
M Bection | Sessich| [Terin| | diys |

¥ Detail

Cataloghlu Format | Diata | Ewent | Cther

L Allow Filters ... .. res ;I @
_ Caption ............ Sections

Default View ... ... . Continuous Forms —I
! Wiews Allowed .. ... Both
- Allow Edits ... r'es
'2 Allow Deletions ... Yes
- Allow Additions .. ... r'es
N DataEntry .. ..., Mo
3 Recordset Type ... Dynaset
_ Fecord Locks . ..... Mo Locks
- ScrollBars ... ... Yertical Only
4 Fecaord Selectars ..
- Mavigation Buttons . | .
5 Dividing Lines . ... ..
- Auto Fesize . ... ... 0 -
7. Subforms
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Application to the assignment

FIGURE 7.14: A form without subform scroll bars or navigation buttons.

H Courses and Sections [ (O]
4 Depardment code || Credits
Course number Activity
Title (Introduction to Quantative Decision Making
Sections
Catalog Meeting Meeting -
Num Section Session  Term days time Building Room
P [[|44411 oo LRI [ b 830-1000 AMGU [{413
57455 ooz EEINY [ F 830-1000 AMGL [{415
48516 oo3 LRIy 1w F 10301200 [JANGL {415
71845 on4 LRI [ b 1000-1130  [JANGU [{413
69445 oos LRIy 1| F 1300-1430  [JANGL {415
34134 006 94 1f b 1300-1430  JIANGU  [[413 <
Fecard: 14 4 || 1 | M e of 11 2
M Home | [4Previous | 180f19




7. Subforms Application to the assignment

vents the user from changing the details of an
order that has already been invoiced or attempt-
ing to use the form for order entry.
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Access Tutorial 8: Combo Box Controls

8.1 Introduction: What is a combo
box?

So far, the only kind of “control” you have used on
your forms has been the text box. However, Access
provides other controls (such as combo boxes, list
boxes, check boxes, radio buttons, etc.) that can be
used to improve the attractiveness and functionality
of your forms.

A combo box is list of values from which the user can
select a single value. Not only does this save typing,
it adds another means of enforcing referential integ-
rity since the user can only pick values in the combo
box. For example, a combo box for selecting course
activities from a predefined list is shown in

Figure 8.1.

Although advanced controls such as combo boxes
and list boxes look and behave very differently than
simple text boxes, their function is ultimately the

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 25-Aug-1997

8. Combo Box Controls

It is important to realize that combo boxes
A have no intrinsic search capability. Combo
boxes change values—they do not automati-
cally move to the record with the value you
select. If you want to use a combo box for
search, you have to program the procedure
yourself (see Tutorial 15 for more details).

8.2 Learning objectives

How do | create a bound combo box?

a

O Can | create a combo box that displays values
from a different table?

O How do | show additional information in a
combo box?

0 How do | prevent certain information from
showing in the combo box?

O Can | change the order in which the items
appear in a combo box?

FIGURE 8.1: A combo box for fillin g in the

Activity field.
L4 Department code: |COMM

Course number: |290
Title: |Introduc’tion to Cluantative Decision kal
Credits: | 3
Activvity: !ﬁ -I

L&B

TUT

same. For example, in Figure 8.1, the combo box is
bound to the Activity field. When an item in the
combo box is selected, the string (e.g., “LEC") is
copied into the underlying field exactly as if you had
typed the letters L-E-C into a text box.

P o] 10123

Learning objectives

O What is tab order? How do | change it so that
the cursor moves in the correct order?

O Should | put a combo box on a key field?

8.3 Tutorial exercises
» Open your frmCourses form in design mode.
« Ensure the toolbox and field list are visible (recall
Figure 6.3).

8.3.1 Creating a bound combo box

Although Access has a wizard that simplifies the pro-
cess of creating combo boxes, you will start by build-
ing a simple combo box (similar to that shown in
Figure 8.1) with the wizard turned off. This will give
you a better appreciation for what the wizard does
and provide you with the skills to make refinements
to wizard-created controls.

 Delete the existing Activity text box by select-

ing it and pressing the Delete key.
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8. Combo Box Controls

* The wizard toggle button (i]) in the toolbox
allows you to turn wizard support on and off.
Ensure the button is out (wizards are turned off).

« Click on the combo box tool (E)). The cursor
turns into a small combo box.

» With the combo box tool selected, drag the
Activity field from the field list to the desired
location on the form’s detail section, as shown in
Figure 8.2.

The process of selecting a tool from the toolbox, and
then using the tool to drag a field from the field list
ensures that the control you create (text box, combo
box, etc.) is bound to a field in the underlying table or
query.

If you forget to drag the field in from the field
list, you will create an unbound combo box, as
shown in Figure 8.3. If you accidently create

Tutorial exercises

an unbound combo box, the easiest thing to
do is to delete it and try again.

FIGURE 8.3: An unbound combo box (not what

you want).

Dl-|-]-|-2-|-3-|-4-|-5-|-5-
[ ][ Deti
- |Depatmentc: de:| |DeptCDde

| | |
1 !Cuur E numkb r'! !CrsNum L
- 1 1 1
- [Title
- |
2 L,redlta iCredits i
- [ |
3 Efumb anllmd - _TE_
- B Courses | |
) Since the control
- is unbound, no
: field name
5 shows and the
. label is generic.
4
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FIGURE 8.2: Create a bound combo box.

B frmCourses : Form

—To

D|-|-1-|-2-|-3-|-4-|-5-|-5-|-?-|-g-|-
[ ] #Detsi
0 To...
- |Depatmentc de:| |DeptCDde
| |
1 !Cuur E nurmb r'! !CrSNum
- 1 |
- [Title
- I
2 L,redlta iCredits
- | ]

Ensure the wizard button is not
= R

depressed.

Click on the combo box button to
activate the combo box tool.

Select theActivity
the field list.

field from

d Drag theActivity

field on to the detail area. If you

have done this correctly, the name of the underlying

field should show in the combo box and the label

should take the value of the field’s caption
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8. Combo Box Controls

8.3.2 Filling in the combo box properties

In this section, you will tell Access what you want to
appear in the rows of new combo box.
» Switch to form view and test the combo box.

At this point, the combo box does not show any list
items because we have not specified what the list
items should be. There are three methods of specify-
ing what shows up in the combo box list:

1. enter a list of values into the combo box’s Row
Source property;

2. tell Access to get the value from an existing table
or query;

3. tell Access to use the names of fields in an exist-
ing table (you will not use this approach).

Although the second method is the most powerful
and flexible, you will start with the first.
* Bring up the property sheet for the Activity
combo box.

Tutorial exercises

» Change the Row Source Type property to Value
List as shown in Figure 8.4. This tells Access to
expect a list of values in its Row Source property.

FIGURE 8.4: Set the Row Source Type property.

FDrmatI Data I Event I Other All |
Mame. ... Activity -
Control Source .. ... Activity

Farmat.............

Decirmal ™2 a0 muw

wputbask .o >LLL

Fow Source Type .. Table/Query R

Fuowe Saurce . ... ... Tahle/Query
ol Count . ﬂ

Column Heaas .. ... LS e

Column Widths ...

Bound Calurnn ... .. 1

ListRows ... ... i

ListWidth ... ... Auto

Status Bar Test . ...

Limit TaList. ... .. o j
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« Enter the following into the Row Source property:
LAB;LEC;TUT
» Set the Limit To List property to Yes.

If the Limit To List property is set to No, the

A user can ignore the choices in the combo box
and simply type in a value (e.g., “SEM”). In
this particular situation, you want to limit the
user to the three choices given.

» Switch to form view and experiment with the
combo box.

Notice that the combo box has some useful
built-in features. For example, if you choose
to type values rather than select them with a
mouse, the combo box anticipates your
choice based on the letters you type. Thus, to
select “TUT”, you need only type “T".

Tutorial exercises

8.3.3 A combo box based on another
table or query

An obvious limitation of the value-list method of cre-
ating combo boxes is that it is impossible to change
or update the items that appear in the list without
knowing about the Row Source property.

A more elegant and flexible method of populating the
rows of a combo box is to have Access look up the
values from an existing table or query. Although the
basic process of setting the combo box properties
remains the same, it is more efficient to rely on the
wizard when building this type of combo box.

Before you can continue, you need a table that con-
tains appropriate values for course activities.
« Switch to the database window and create a new
table called Activities
* The table should consist of two fields: one called
Activity and the other called Descript , as
shown in Figure 8.5.

6 of 23
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8. Combo Box Controls

FIGURE 8.5: Create a table containing course

activities.

B Activities : Table
I Field Name Data Type

B [ Activity Tet three-letter code
Descript Text description
General | Lookup |
Field Size 3 H Activities : Table
Farmat I_I—Ii
Input Mask S . Activity | Description
Caption LAB Lab
Default Value LEC Lecture
Yalidation Rule TUT Tutorial
YWalidation Text *
Reguired Mo
Allow Zero Length Mo
Inclexed res (No Duplicates)
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» Populate the table with the same values used in
Section 8.3.2.

The result is a table containing all the possible
course activities and a short description to explain
the meaning of the three-letter codes. You can now
return to creating a combo box based on these val-
ues.

 Delete the existing Activity combo box.

« Ensure the wizard button ([:\) in the toolbox is
depressed (wizards are activated).

* Repeat the steps for creating a bound combo box
(i.e., select the combo box tool and drag the
Activity field from the field list on to the detail
section). As shown in Figure 8.6, this activates
the combo box wizard.

The wizard asks you to specify a number of things
about the combo box:

1. the table (or query) from which the combo box
values are going to be taken;

8. Combo Box Controls
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FIGURE 8.6: Create a combo box using the combo box wizard.

B frmCourses : Form

Create a bound
combo box.

A

Have Access look up the

B Courses

D|-|-|-|-2-|-3-|-4-|-

[ ][* Detsi

- |Depatmentc de:| |DeptC‘%Dde | |

1 !Cuur B numk r'! !CrSNulm | e

- [Title | | il 2
2 @ﬂ iCreditS f

- Clivify: %ctivi:ly :: ;E__ ==

values from a table or query.

et e | ]

This wizard createg’a combo box. which displays alist of values you
can choose frargy

guantyour combo boxto get its values?

|'want the combo box to look up the wvalues in a table or queny.

T willtype in the values that | want.

[ M Home | [4Previous | 80f3




oo

. Combo Box Controls

2. the field (or fields) that you would like to show up
as columns in the in the combo box;

3. the width of the field(s) in the combo box (see
Figure 8.7);

4. the column from the combo box (if more than one
field is showing) that is inserted into the underly-
ing field; and,

5. the label attached to the field (see Figure 8.8).

When you are done, the combo box should look sim-

ilar to that shown in Figure 8.1. However, updating or

changing the values in the combo box is much easier
when the combo box is based on a table.
» Add “SEM” (Seminar) to the Activities table.
* Return to the form, click on the Activity combo
box, and press F9to requery the combo box.
« Verify that “SEM” shows up in combo box.

Access creates the rows in a combo box
when the form is opened. If the values in the

Tutorial exercises

source table or query change while the form is
open these changes are not automatically
reflected in the combo box rows. As a conse-
guence, you have to either (a) close and re-
open the form, or (b) requery the form.
Although you can automate the requery pro-
cess, we will rely on the F9 key for the time
being.

8.3.3.1 Showing more than one field in the

combo box

One problem the combo boxes created so far is that
they are not of much use to a user who is not familiar
with the abbreviations “TUT”, “SEM”, and so on. In
this section, you will use the Descript  field of the
Activities table to make the combo box more
readable, as shown in Figure 8.9.

* Delete the existing combo box and start again.

90f23
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Combo Box Wizard

Combo Box Wizard

| Catalog Viey —
1—_[ Courses o
I HERHEY il D it te M EER RS KR
epanments oy
Employees HREEOREE REE RN
Sections I_”“”””“ .I
a The new
Activities

tables contains
the values for # ——
the combo box. Tables

De

Combo Box Wizard

Cance

Auwgilable Fields:

[ M Home | [4Previous |
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FIGURE 8.7: Fill in the combo box
wizard dialog sheets.

YWhich table or guery should provide the values for yvour combo box?

Which fields contain the values you want included in your combo

The fields wou select become columns in wour combo box.

The combo box can show
more than one field. Select
only Activity for now.

Selected Fields:

Howe wide would you like the columns in your combo box?

To adjust the width of & column. draqg its right edge to the width wou want or double-click the right
edge of the column heading to getthe best fit

Use the column selector (the grey bar
C ;

Activity t the top of the column) to resize the
> column to the desired width.
LEC

10 of 23
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Tutorial exercises

FIGURE 8.8: Fill in the combo box wizard dialog sheets (continued).

Combo Box Wizard

| Microsoft Access can store the selected walue from your combo box

d The combo box is already bound
to theActivity field, this step
is automatically filled in for you:.

perform atask.

inyour database. or remember the value soyou can use it later to

\f‘ Rermember the value for later use.

HHH HEH HHR HRR
HER HHN MM nNR

l:::x g | & Store that value in this field: EIAdivity d
= Combo Box Wizard

HHH HEH HHR HRR
-

Because the combo box is bound
theActivity  field’s captionis
provided as a default label.

e

What label would sou like for your combo box?

b.civin]

Those are all the answers the wizard needs to create your comkbo
alurd
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FIGURE 8.9: A combo box that shows two fields
from the source table or query.

B frmCourses : Form

4 Department code: ICOMM
Course number: IEQD
Title: |Intr0dudi0n ta Cuantative Decisian Ma
Credits: I 3
Activity e
[LAE Lab
TUT Tutorial

« Fill in the wizard dialog sheets as in Section 8.3.3
but make the changes shown in Figure 8.10.
« Verify that your combo box resembles Figure 8.9.

8.3.3.2 Hiding the key field

Assume for a moment that you, as a developer, do
not want users to even see the three-letter abbrevia-

[ M Home | [4Previous |
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tions and want them to select a course activity value
based solely on the Descript  field.

In such a case, you could include only the

Descript  column in the combo box. However, this
would not work because the Activity  field of the
Courses table expects a three-letter abbreviation.
As such, the combo box would generate an error
when it tried to stuff a long description into the rela-
tively short field to which it is bound.

In this section, you will create a combo box identical
to that shown in Figure 8.9 except that the key col-
umn (Activity ) will be hidden from view. Despite
its invisibility, however, the Activity column will
still be bound to the Activity  field of the underly-
ing table and thus the combo box will work as it
should.

 Delete the existing combo box and start again

using the combo box wizard.

12 0f 23
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8. Combo Box Controls

Combo Box Wizard

box?

HEEHRE NN N
Wi REH HRE
HEEHRE NN N

—

I ERREET] vI

Awailable Fields:

YWhich fields contain the values vou want included in your combo

Selected Fields:

Tutorial exercises

FIGURE 8.10: Use the wizard to
add more than one field to the
combo box.

The fields wou select become columns in your combo box,

Bring both fields from the
Activities table into the combo box.

Uncheck the “hide key” box and

Combo Box Wizard

How wide would you like the colum

Hryour combo box?

To adjust the width of acalumn, drag its right edoe to the width you want, or double—clickw c

resize the columns appropriately.
Note that Access version 2.0 does
not have the “hide key” feature

Select the column that provides
the value of interest (in this case,

edge of the column heading to getthe bhest fit

Combo Box Wizard

Activity ).

™ Hide key column (recommended)

When vou select a row in the combo baox, you can store awvalue from
that row in your database. oryou can use the value later to perfarm
an action. Choose afield that uniquely identifies the row.

Ayailable Fields:

13 0f 23
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* Include both the Activity and Descript  fields

in the combo box.
* Resize the Activity column as shown in

Figure 8.11. Note that users of version 7.0 can
simply leave the “hide key” box checked—the

result is the same.

 Ensure that the Input Mask property for the
combo box (which is inherited from the field’s

Input Mask property) is blank.

« Verify that the resulting combo box resembles

that shown in Figure 8.12.

Combo boxes with hidden keys can be con-
fusing. The important thing to remember is

that even though the description (e.g.

, ‘Lec-

ture”) now shows in the combo box, what is
really stored in the underlying field is the hid-

den key (e.g., “LEC").

Tutorial exercises

FIGURE 8.12: A combo box with a hidden key.

|COMM
|290

L Department code:

Course nurmber;

Title: IIntrodudiDn o Cluantative
Credits; | 3
Activity EM - I

Semminar
Tutorial

8.3.3.3 Changing the order of items in the

combo box

A combo box based on a table shows the records in
one of two ways:

1. If the table does not have a primary key, the
records are shown in their natural order (that is,
in the order they were added to the database).

14 of 23
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Tutorial exercises

FIGURE 8.11: Resize the columns to hide the key.

=2 Click on the right side of

the column selector and
drag the edge of the
Activity column to the
far left (i.e., make its width

How wide would you like the colurmns

To adjustthe width of & column, drag
dge of the column heading to get th

Combo Box Wizard

Hove wide would wou like the
Howe wide would you like the colu
To adjust the width of a colun

edge ofthe column heading®  To adjust the width of a colurn, ¢

ZEI'O) I Hide = o edge of the column heading to gr
> T column (recomr
i . e Leb DESCHPN : " Hide key caolumn (recommen
@ Hiding the key is such a i it Tﬂ‘ Descript :
common operation that = i —E e Descript
Access version 7.0 includes —+ 7 Tutorial T [T— .

the “hide key” check box.

T Tutorial Seminar

Tutorial
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2. If the table does have a primary key, then the
records are sorted in ascending order according
to the key.

It may be, however, that you want a different order
within the rows of the combo box. To achieve this,
you can do one of two thing:

1. Create a stand-alone query (in which the sort
order is specified) and use this query as the
source for the combo box.

2. Modify the “ad hoc” query within the Row Source
property of the combo box.

If you intend to make several major changes to the
basic information in the underlying table (e.g., joins,
calculated fields), it is usually better to create a
stand-alone query. In this way, the same query can
be used by many combo boxes.

o] [Greviows |

Tutorial exercises

If the changes are quite minor (for instance, sorting
the records in a different order), you may prefer to
modify the Row Source property.

In Section 8.3.2, you set the Row Source property to
equal a list of values. When the combo box is based
on values from a table or a query, however, the Row
Source is an SQL statement (recall Tutorial 5) rather
than a list of values. You can either edit the SQL
statement directly or invoke the QBE editor.

In this section, you will order the items in you combo
box according to the length of the Descript  field
(this is done merely for illustrative purposes).

« Bring up the property sheet for the Activity
combo box.

* Put the cursor in the Row Source property. As
shown in Figure 8.13, a builder button (=)
appears.

¢ Press the builder button to enter the “SQL
builder” (i.e., the QBE editor).

16 of 23

[ M Home | |[4Previous |




8. Combo Box Controls

FIGURE 8.13: Invoke the builder for the Row
Source property.
¥ Combo Box: Activity [ %]
Format | Data | Event | Other All |
MNarme .. ... Activity -
Control Source ... .. Activity
Farmat.............
Decimal Places ... Auto
Input Mask Ll
Cow Source Type . Table/Cueny
Fow Source. ... SELECT DISTINCTROMWY [, 2}
Lu.o=n Count ... 2

Column Heads ... .. o
Column Widths Ocm:2 54em
Bound Column ... .. 1

= Click the builder button to

bring up the QBE editor.
Alternatively, you can edit I
the SQL statement directly:

« Create a calculated field called DescLength
using the following expression:
DescLength: Len([Descript])

Tutorial exercises

(Len() is a built-in function that returns the
length of a string of characters).

e Sort on DescLength in descending order.

« Switch to datasheet view to ensure the query is
working as it should.

» Ensure the Show box for the field is unchecked,
as shown in Figure 8.14.

* Instead of saving the query in the normal way,
simply close the QBE box using the close button
().

If you save the query, it will be added to your

A collection of saved queries (the ones that are
displayed in the database window). However,
if you simply close the QBE window, the Row
Source property will be updated and no new
database object will be created.

17 of 23

[ M Home | [4Previous |

8. Combo Box Controls

FIGURE 8.14: Use the QBE editor to modify the
Row Source property.

=¥ SOL Statement : Query Builder

Descript

Add a calculated field
a calledDescLength .

o |
Fialdl: | Activity Descript DescLength: Len{[Descript])
Tahble: | Activities Activities
Sort: Descending
Shaw: W W
Criteria
or:
Sortonthe  — C Uncheck the-
calculated field. Show box
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8.3.4 Changing a form’s tab order

A form’s tab order determines the order in which the
objects on a form are visited when the Tab or Enter
(or Return) keys are pressed. Access sets the tab
order based on the order in which objects are added
to the form. As a result, when you delete a text box
and replace it with a combo box or some other con-
trol, the new control becomes the last item in the tab
order regardless of its position on the form.

To illustrate the problem, you are going to create a
combo box for the DeptCode field.
* Delete the DeptCode text box and replace it with
a combo box based on the Departments table.
« Switch to form view. Notice that the focus starts
off in the CrsNum field instead of the DeptCode
field.
* Press tab to move from field to field. Notice that
after DeptCode is left, the focus returns to the
CrsNum field of the next record.

18 of 23
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8. Combo Box Controls

« To fix the problem, return to form design mode
and select View > Tab Order from the main
menu.

g In Access version 2.0, the menu structure is
slightly different. As such, you must select
Edit > Tab Order.

 Perform the steps in Figure 8.15 to move Dept-
Code to the top of the tab order.

8.4 Discussion

8.4.1 Why you should never use a
combo box for a non-concatenated
key.
A mistake often made once new users learn how to
make combo boxes is to put a combo box on every-
thing. There are certain situations, however, in which
the use of a combo box is simply incorrect.

Discussion

For example, it never makes sense to put a combo
box on a non-concatenated primary key. To illustrate
this, consider the Departments form shown in
Figure 8.16. On this form, the DeptCode text box
has been replaced with a combo box that draws its
values from the Departments table.

FIGURE 8.16: A combo box bound to a key field.

B Departments

> Departrnent cade [COkbd j
BSEW BasketWeaving
Department name FTY] Commerce and Business Admir
o CRWER Creative Writing
Building | £ Education
EMGL English
Recard; 14| <[] MATH Math
MLISC husic

This combo box appears to work. However, if you
think about it, it makes no sense: The form in
Figure 8.16 is a window on the Departments table.
As such, when the DeptCode combo box is used,

19 of 23
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FIGURE 8.15: Adjust the tab order of fields on a form.

Drag the record  H=kelell

selector to the

To

Section

Custorm Order:

B3 Click on the record

a selector of the field

desired position in
the list.

@ Detail

) Earm Euater

Click ta select a row, or
click and drag to select
multiple rows. Drag
selected row(s) to move
thern to desired tab arder.

o |

Cancel

Ity
DeptCode

you wish to move.

@

(such as this one), you can présgo
Order to order them automatically.

For forms in which the fields are arranged
in a single column from top to bottom

Tab Order
Section Custom Order:
) Earm Hesder
CrsMNum
& Detail Title
) Bt Eoaier Cre.d!ts
Activity
Click to select a row, or
click and drag to select
| multiple rows. Drag
—  selected row(s) to maowve
them to desired tab order.
! ] .
| 5] | Canmet i P iuta Order
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one of two things can occur depending on whether a
new record is being created or an existing record is
being edited:

1. A new record is being created — If a new
record is being created (i.e., a new department is
being added to the information system), a unique
value of DeptCode must be created to distin-
guish the new department from the existing
departments. However, the combo box only
shows DeptCode values of existing depart-
ments. If the Limit To List property is set to Yes,
then the combo box prevents the user from enter-
ing a valid DeptCode value.

2. An existing record is being edited — tis
important to remember that a combo box has no
intrinsic search capability. As such, selecting
“CPSC” in the DeptCode combo box does not
result in a jump to the record with “CPSC” as its
key value. Rather, selecting “CPSC” from the

Discussion

combo box is identical to typing “CPSC” over
whatever is currently in the DeptCode field. This
causes all sorts of problems; the most obvious of
these is that by overwriting an existing value of
DeptCode , a “duplicate value in index, primary
key, or relationship” error is generated (there is
already a department with “CPSC” as its Dept-
Code).

Note that a combo box may make sense when the
key is concatenated. An example of this is the
DeptCode combo box you created in Section 8.3.4.

8.4.2 Controls and widgets

Predefined controls are becoming increasingly popu-
lar in software development. Although Microsoft
includes several predefined controls with Access
(such as combo boxes, check boxes, radio buttons,
etc.), a large number of more compex or specialized
controls are available from Microsoft and other ven-

[ M Home | [4Previous | 210f23
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dors. In addition, you can write your own custom
controls using a language like Visual C++ or Visual
Basic and use them in many different forms and
applications.

An example of a more complex control is the calen-
dar control shown in Figure 8.17. A calendar control
can be added to a form to make the entry of dates
easier for the user. Microsoft calls such components
“ActiveX controls” (formerly known as “OLE con-
trols”). Non-microsoft vendors provide similar com-
ponents but use different names, such as “widgets”.

There are two main advantages of using controls.
First, they cut down on the time it takes to develop
an application since the controls are predefined and
pre-tested. Second, they are standardized so that
users encounter the same basic behavior in all appli-
cations.

Application to the assignment

8.5 Application to the assignment

There are a number of forms in your assignment that
can be greatly enhanced by combo boxes.

» Create a combo box on your order form to allow
the user to select customers by name rather than
CustID . Since your CustID value is a counter, it
has no significance beyond its use as a primary
key. Generally, such keys should be hidden from
view.

« Create a combo box in your order details subform
to allow the user to select products. Since the
ProductID values are used by both you and
your customers, they have some significance
beyond the information system. As such, Pro-
ductlID should be visible in all combo boxes. In
addition, the items in the product list should be
sorted by ProductlD . This makes it easier to
select a product by typing the first few numbers.

« Create combo boxes on other forms as required.
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Application to the assignment

FIGURE 8.17: A calendar control on a form.

O

o

IR The calendar control can be bound

to date/time fields, thereby making

:l # Detall

it easier for users to enter dates.

August 1997 [august x| [1997 >
Sun | Mon | Tue | Wed | Thu Fri Sat
7 [ g o [ B I :
B 4 5 B 7 g ¥ Custom Control: OLEControl0 E3
Farrnat | Data  Ewvent | Other I All I
1 i
10 1 12 i 14 19 On Updated ... -]
17 158 &9 | |21 [2 OnEnter. ...
_ OnExit.... ...
25 2 27 28 29 OnGotFocus\ ...
- 31 ‘1 3 5 4 5 OnLostFocus .\ ...
2

@ Like other objects in Access, controls have
properties and events that determine the
appearance and behavior of the control.
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Access Tutorial 9;: Advanced Forms

9.1 Introduction: Using calculated

controls on forms

It is often useful to show summary information from
the subform on the main form. The classic example
of this is showing the subtotal from a list of order
details on the main order form.

In this tutorial, you are going to explore one means
of implementing this feature using calculated con-
trols. A calculated control is an unbound control for
which the Control Source property is set to an
expression that Access can evaluate.

Clearly, calculated controls have a great deal in com-
mon with the calculated query fields you created in
Section 4.3.3. Although there are no hard-and-fast
rules that dictate when to use a one over the other,
pushing your calculations to the lowest level (i.e.,
performing calculations in the query) is usually the
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9. Advanced Forms

half year ]. Recall that you have already imple-
mented this feature in Section 4.3.3.2 using a calcu-
lated query field.

* Perform the steps shown in Figure 9.1 to create
an unbound text box on your fmrCoursesMain
form.

» Set the Control Source property of the text box
using the syntax:
= <expression>
In this case, the expression should be an “imme-
diate if” function (see Section 4.3.3.2).

By default, Access interprets text in the Con-
trol Source property field as the name of a
variable (i.e., the name of a field or another
control). As such, you must remember to
include the equals sign when setting this

property.

best course of action. However, as you will see in the
context of subtotals, this is not always possible.

9.2 Learning objectives
O How do | create a calculated text box?

O What is the expression builder? When is it
used?

O Where can put an intermediate result of a
calculation on a form so that it does not
show?

9.3 Tutorial exercises

9.3.1 Creating calculated controls on
forms
In this section, you are going to create a simple cal-

culated text box to translate the Credits field into a
dichotomous text variable [full year

[Fe] [fmms]  ton
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« Test your form. Note that you are prevented from
editing the calculated field. If, however, you
change the value of Credits , the value of txt-
CourseLength  changes accordingly when you
leave the Credits field.

9.3.2 Showing a total on the main form

In this section, you will create a calculated text box
that displays the number of sections associated
with each course. The primary motivation for this
exercise is to illustrate some of the limitations of cal-
culated controls (as they are implemented in Access)
and to provide an opportunity to explore an interest-
ing work-around.

 Create a text box call txtNumSections

main form as shown in Figure 9.2.

on the

The logical next step is to set the Control Source of
the field to an expression that includes the Count()
function. However, Access has a limitation in this

2o0f11
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9. Advanced Forms Tutorial exercises

FIGURE 9.1: Create an unbound text box on your main form.

a Make some room by dragging tqi Select the text box
Credits text box to the left. — IEE— tool from the
|_|| R S A R R LI AR I toolbox and click on
# Form Header _an appropr_late space
# Detail / in the detail area.
I I
__ |Depanmentc:|de||Depth| Credits |Credits | ?I’ext12:| nbound AdeSt the tab order
- | | ‘ : o
e u.:.”CrSNur‘l thstivitpActvity | of the fields as
- el il ' necessary.
3 & frmCoursesMain : Form ] S
_ Sediuns|D| -|-i3-|-4-|-5-|-5-|-r-|-3-|-9-|-m-|-
:3 _sfrmSeu:tlc # Form Header =
- * Detall s
— I I I A |abl
_ Depaﬂmentc:de||Depth| Credits||Credits | F(Dursel=ngth| Einbuu_nd E I 9| 2
- T 1
1 ottt b.:.“““rsl.NunI g‘Texl Box: baCoursel ength
- [@I Title / Furmatl Data I Ewent I Other All |
2 MName.......... . tdCourselength ﬂ
) Seclons | | | | | Control Sowes ... =

d Edit the label and give the text box a meaningful n P

(e.g.,txtCourseLength ). Thetxt prefix is use Ezamims““ futo
here to indicate an unbound text box. Default Value ...
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FIGURE 9.2: Create an unbound text box to show the number of sections
associated with each course.

a Add an unbound text box calledNumSections
Since it is currently bound to nothing, it is blank.

# Courses and Sections
4 Department code |COkkd Sradits Course length  [half vear
Course number Murnber of sections: I:I Activity
Title [Introduction to Quantative Decision Making What you want
_ is a means of
Sections counting the
Catalog teeting heeting - records in the
Murm Section Session  Term days time Building Room subform and
P [[44411 ool 9w [ 830-1000 ANGL ({413 displaying the
57455 nnz g 1| F 830-1000 ANGL [{415 countin the
48516 o3 9 1| F 10301200 | |ANGL [|415 new text box
71845 nn4 gy [ 1000-1130 | |ANGL [|413 ’
639495 nns BRIy 1| F 13001430 ||ANGL [|415
34134 00e ELL [ b 13001430 | [ANGL []413
Fecord: 4] 4 || 1k [ ei]r¥| of 12 i
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9. Advanced Forms

regard: you cannot use an aggregate function
(Sum(), Avg() , Count() , etc.) on a main form that
refers to a field in a subform. As a consequence, you
have to break the calculation into two steps:

1. use the aggregate function to create a calculated
text box on the subform (i.e., a “dummy” field to
hold an intermediate result);

2. create a calculated control on the main form that
references the dummy text box created in the first
step.

It is important that you realize that this proce-
dure does not involve any immutable, funda-
mental information systems knowledge.
Rather, it is merely an example of the type of
work-around (hack, kludge, etc.) that is rou-
tinely used when using a tool like Access to
create a custom application.

Tutorial exercises

9.3.2.1 Calculating the aggregate function on

the subform

» Create an unbound text box on the subform as
shown in Figure 9.3.

« Save the subform but do not close it.

» Return to the main form and set the Control
Source of txtNumSections  to equal the value
of txtNumSectionsOnSub . Since the naming
conventions for objects on forms and subforms
can be tricky, use the expression builder (as
shown in Figure 9.4) to build the name for you.

The expression builder organizes all the elements of
the database environment into a hierarchical struc-
ture. You build an expression by “drilling down” to the
element you need and double-clicking to copy its
name into the text area.

The expression builder takes some practice.
One problem is that it is easy to double-click

50f11
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FIGURE 9.3: Perform the count on the subform.

Create a calculate control called
txtNumSectionsOnSub

A

and place it in the form header

(do not worry about its location, you will move it later).

B sfrmSections : Form

Set theControl Source

I:“'I']'I'z'I'F'I'4'I'5'I'5'I'F'I'g'l'

# Form Heacder
T I =
Catalol " Count([Section]) epting
MNurm Eection[Sessiofi] [Terfn] ds

# Detail

hdegting
time

R TR property to
=Count([Section]) .
. Note that any field can be
‘ Bui used as the argument for the
uilding || Rogrr,

Count() function.

|CataIDgNum ||Se|:ti0n |||Sessi0n | |Term | |Days ||Time

# Form Footer

B Text Box: bdMumSectionsOnSub

Formatl Data I Ewent I Other Al
1 MName. . ............ thumSectionsOnS
- Control Source . ... . =Count([Section])
- Format............
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9. Advanced Forms

Tutorial exercises

FIGURE 9.4: Use the builder to drill down to the calculated control on the subform.

C2 ), WG S M EHHIN i

FDrmatI Data I Ewent I Other
MName ............ .. tatlumSections

Contral Source ...

Note that when the main

Control Source property and drill
down to the calculated control you
just created on the subform.

All

—n

form and the subform are Ejg‘i‘;‘;l'm e Builde =
both OPE‘n,_the_SUbefm_ Input Mask [Sections]. Formi[tthumSectionsOnSub] ;I
appears twice in the builder: e v Cancel |
once as a “stand-alone” \alidation

form (under “Loaded Validation’ = o |

Forms”) and onces a Status Bar

+-;*|ﬂ=>(<>|#\nd Or Mot Like ()l

Paste | Help

componenbf the main form

(press the- sign on the
frmCoursesMain

[ Tahles
folder). You want to use the Queries
latter (you will never & Farms

access the subform in stand-

frmCoursesMain

Loaded Forms

alone mode). \\Ei

frrm Courseshain
ot = 11 S 3
O strmSections

KA E—

9. Advanced Forms

on the wrong thing. Another problem is that
Access attempts to guide you by inserting
«Expr» place-holders all over the place. The
solution to both problems is to click on the text
window and make liberal use of the Delete
key.

The point made about “stand-alone” and
“component” subforms in Figure 9.4 is
extremely important. The reason you use the
sfrm prefix is so you know that the form is
designed to be a component of another form.
If you select the stand-alone version the form
in the builder, the name created by the builder
will be incorrect and an error will result.

* Close the subform (in version 7.0 and 8.0, the
main form and subform cannot be open at the
same time).

« | |<Farm> -
<Field List» AfterlUpdate
CatalogMurn Lakel AllowAutoCorrect
Section Label AutoTab
Session Label BackColor
Term Label BackStyle
Days Lahel BeforeUpdate
Time Label BorderColor
Building Label v BarderLineStde

= | |Foom Label BorderStyle

> tetMlurnSections OnSi Borderwidth =l
[ M Home | [4Previous | 7ofll
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* Test the form. The value of txtNumSections

and txtNumSectionsOnSub

should be identi-

cal, as shown in Figure 9.5.

FIGURE 9.5: The number of sections on the main

form.

B Courses and Sections

4

Department code

Credits Co
Course nurnber Numberofsec’(iu/ni

Title |Introduction to QuaWecision Making

Sections
Catalog | Btvieeting
MNurm SeghOn_Sessan  erm days
p ||da411 Todr— TMaaas T 11Th 4 vt
= @ The “dummy” text box is visible in
T the subform. Although you will
T eventually hide it, it is useful to
= display it until you know both steps
% of the calculation are working
properly.
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9. Advanced Forms

9.3.2.2

The obvious problem in Figure 9.5 is that the dummy
text box shows on the subform. There are at least
two ways to get around this: one is to set the Visible
property of the text box to No; a slightly more elegant
approach is to use the page header or page footer
to hide the text box.

The page header and footer are areas on the form
that only show when the form is printed. Since you
will never print a form (reports are used for printed
material), these areas can be used to hide intermedi-
ate results, etc.
« In design mode, select View > Page Header/
Footer from the menu.

Hiding the text box on the subform

In version 2.0, the menu structure is slightly
different. As such, you must select Format >
Page Header/Footer.

Discussion

» Drag (or cut and paste) txtNumSectionsOn-
Sub from the form header to the page header, as
shown in Figure 9.6.

* Test the result.

9.4 Discussion

In Section 4.3.3.2 and Section 9.3.1, you accom-
plished the same thing (showing half year or

full year ) using different techniques. The advan-
tage of implementing this as a calculated query field
is that you can use this field repeatedly in other
forms. On the other hand, if you do the transforma-
tion on the form, you have to repeat the calculation
on every form that requires the calculated field.

In the case of the aggregate function, the situation is
slightly different. Although you can use the totals

feature of QBE (see on-line help) to count the num-
ber of sections for a particular course within a query,
the resulting recordset is non-updatable (and hence

[ MHome | [4Previous | 9of1l
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Discussion

FIGURE 9.6: Hide the intermediate result in the page header.

A

@, Microsoft Access
File Edit U= Inset  Format  Tools

Window Help

SelectView > Page Header/Footer from the
menu Format > Page Header/Footer in version
2.0) to show the page header and footer.

Drag (or cut and paste)
the field you want to hide
into the page header.

To

= |

El Eormgesign ﬂlglg El
——— \Fom =
L{tmmsed Datasheet _;[ L | I I o | E|

| | %] | 7ol = | il =

B sfrmSections : Form

Fage Header/Foaoter 1

Form Header/Footer

Toolbars...

|_""'1"'2"'3"'4"'5'/'8"'?'"8"'9"'10"'11"
# Form Header /
Catalopg ?/ epting he Iting
MHum Bection | Sessioh | | Tgn diys time Building | Rogm
¥ Page Header
I l= |
%Cuunt([SeEﬂDn]) E
| | |
# Detail
|Cata|0gNum||Sec:ti0n|||SessiDn||Term ||Days ||Time ||Bui|ding||RDDm |
# Page Footer
# Form Foaoter
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9. Advanced Forms Application to the assignment

not much use for editing course names, etc.). As a
result, you are forced to do the calculation on the
form rather than in the query.

9.5 Application to the assignment

To show the subtotal, tax, and grand total on your
order form, you use the same techniques illustrated
here. The only difference is that you use the Sum()
function instead of the Count() function to get the
subtotal for the order.

» Create a dummy field on your OrderDetails
subform to calculate the subtotal for the order.

* Calculate the tax (G.S.T. only for wholesale) and
grand total on the main form (traditionally, this
information is located near the bottom of the
form—but not in the form footer).

[ M Home | [4Previous | Lofll




Access Tutorial 10: Parameter Queries

The last few tutorials have been primarily concerned
with interface issues. In the remaining tutorials, the
focus shifts to transaction processing.

10.1 Introduction: Dynamic queries
using parameters

A parameter query is a query in which the criteria
for selecting records are determined when the query
is executed rather than when the query is designed.

For example, recall the select query shown in
Figure 4.6. In this query, the results set is limited to
records that satisfy the criterion DeptCode =
“COMM’ If you wanted a different set of results, you
would have to edit the query (e.g., change the crite-
rion to “CPSC”) and rerun the query.

However, if a variable (parameter) is used for the cri-
terion, Access will prompt the user for the value of
the variable before executing the query. The net

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 24-Aug-1997

10. Parameter Queries

10.3 Tutorial exercises

10.3.1 Simple parameter queries

« If you do not already have a qryCourses query
like the one shown in Figure 4.6, create one now
and save it under the name pgryCourses

* Replace the literal string in the criteria row
(“COMM’) with a variable ([X] ).

By default, Access expects criteria to be literal
A strings of text. As a result, it automatically
adds quotation marks to text entered in the
criteria row. To get around this, place your
parameter names inside of square brackets.

» Execute the query as shown in Figure 10.1.

When Access encounters a variable (i.e., something
that is not a literal string) during execution, it

result is that parameters can be used to create
extremely flexible queries.

When the concepts from this tutorial are combined
with action queries (Tutorial 11) and triggers
(Tutorial 13), you will have a the skills required to
create a simple transaction processing system with-
out writing a line of programming code.

10.2 Learning objectives

O What is a parameter query? How do | create
one?

O How do | prompt the user to enter parameter
values?

O How do | create a query whose results
depend on a value on a form?

[Fe] [fmms]  ton
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attempts to bind the variable to some value. To do
this, it performs the following tests:

1. First, Access checks whether the variable is the
name of a field or a calculated field in the query. If
it is, the variable is bound to the current value of
the field. For example, if the parameter is named
[DeptCode] , Access replaces it with the current
value of the DeptCode field. Since X is not the
name of a field or a calculated field in this particu-
lar query, this test fails.

2. Second, Access attempts to resolve the parame-
ter as a reference to something within the current
environment (e.g., the value on an open form).
Since there is nothing called X in the current envi-
ronment, this test fails.

3. As a last resort, Access asks the user for the
value of the parameter via the “Enter Parameter
Value” dialog box.

[ M Home | [4Previous | 20f1l




10. Parameter Queries Tutorial exercises
FIGURE 10.1: Convert a select query into a parameter query.

Run the query and supply a parameter value

To (here Access is asking for the valuedf

! pqryCourses - Select Query

Enter Parameter Value

*

|COMM

Field: | DeptCode Ok I Cancel |
Table: | Courses "
Sﬁmf Field: [DeptCode Crshlum Title
O D_W: - Tahle: | Courses Courses Courses
rlterla: COMM Sart | Ascending Ascending

ar. Show: (]

Criteria: | [X]

4
ar:

-

a2 Replace the literal criterion ~ [«] |
(“COMM)) with a parameterX)
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Note that the spelling mistakes discussed in
Section 4.3.4 are processed by Access as
parameters.

10.3.2 Using parameters to generate
prompts

Since the name of the parameter can be anything
(as long as it is enclosed in square brackets), you
can exploit this feature to create quick and easy dia-
log boxes.
» Change the name of your DeptCode parameter
from [X] to [Courses for which depart-
ment?] .
* Run the query, as shown in Figure 10.2.

10.3.3 Values on forms as parameters

A common requirement is to use the value on a form
to influence the outcome of a query. For instance, if
the user is viewing information about departments, it

[ M Home | [4Previous |
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may be useful to be able to generate a list of courses
offered by the department currently being viewed.
Although you could use a creatively-named parame-
ter to invoke the “Enter Parameter Value” dialog, this
requires the user to type in the value of DeptCode .

A more elegant approach is to have Access pull the
value of a parameter directly from the open form.
This exploits the second step in the operation of a
parameter query (Access will attempt to resolve a
parameter with the value of an object within the cur-
rent environment). The basic idea is shown in
Figure 10.3.

The key to making this work is to provide a parame-
ter name that correctly references the form object in
which you are interested. In order to avoid having to
remember the complex naming syntax for objects on
forms, you can invoke the expression builder to
select the correct name from the hierarchy of data-
base objects.

4 o0f 11
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FIGURE 10.2: Select a parameter name that generates a useful prompt.

‘b When Access asks for

the value of the
parameter, It uses the
Enter Parameter Value parameter’'s name.

Courses forwhich department?

[cOMM C Only records that satisfy
the criteria are included

oK. | Cancel | in the results set.

Field: | DeptCode
Tahble: | Courses
Sort: [Ascending

o | |Department| Course number Title
Criterie: [[Caurses forwhich deparment?] | ” | SO 290 Introduction to Quantative Decision h
o, . COhM 291 Applied Statistics in Business
o | | [comm 351 Financial Accounting
. COMM 439 Advanced Topics in Information Syst
*

= 1 Name the paramet@Courses
for which department?]

[Fme] [fmms]  son
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FIGURE 10.3: Using the value on an open form as a parameter in a query.

& pgryCourses : Select Query =] 3

# Departments M=] B

Department code ICOMM
]
Field: |DeptCode CrsMu Department name | ommerce and Business Administr
Tahle: Caurses Courss BuildingdarGU
Sort | Ascending Ascen
Show: Fecord: 4] 4 2 b [1|r#|of 7 4

Criteria: T
or: |
| b
KN ,

The current value in theeptCode field on
the form is used as a parameter in the query.
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 Create a very simple form based on the
Departments table and save it as frmDepart-
ments .

Leave the form open (in form view or design
mode, it does not matter).

Open pgryCourses in design mode, place the
cursor in the criteria row of the DeptCode field,
and invoke the expression builder as shown in
Figure 10.4.

Perform the steps shown in Figure 10.5 to create
a parameter that references the DeptCode field
on the frmDepartments  form.

Run the query. The results set should correspond
to the department showing in the frmDepart-
ments form.

Move to a new record on the form. Notice that
you have to requery the form (Shift-F9) in order
for the new parameter value to be used (see
Figure 10.6).

Application to the assignment

@ Although the naming syntax of objects in

Access is tricky, it is not impossible to com-
prehend. For example, the name
Forms![frmDepartments]![DeptCode]
consists of the following elements: Forms
refers to a collection of Form objects; [frm-
Departments] is a specific instance of a
Form object in the Forms collection; [Dept-
Code] is a Control belonging to the form. See
Tutorial 14 for more information on the hierar-
chy of objects used by Access.

10.4 Application to the assignment

You will use parameter queries as the basis for sev-
eral action queries (see Tutorial 11) that process
transactions against master tables. For now, simply
create the parameter queries that take their criteria
values from forms you have already created.

[ M Home | [4Previous | 7ofll
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Application to the assignment

FIGURE 10.4: Invoke the builder to build a parameter.

B Departments (O] x|

Place the cursor in the
Criteria row of the
DeptCode field and
right-click to bring up
the pop-up menu.

i=F pgryCourses : Select Query =100} %} nt code ICOMM

t narme ICummerce and Business Administr

Building [ANGU
i ‘ 2 v v of 7 4

—’|_I Create a simple form based on the
| A p

Departments table and leave it open

= in the background.

Field: | DeptCode CrsMum Title
Takle: | Courses Courses Courses —
Sort: | Ascending Agcending
Shaow: '
Criteria; .
ar:
Zoarm... _|;|
<| | »
Froperies
Totals
¥ Tahkle Names

SelectBuild to
€ ivoke the builder.
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10. Parameter Queries

Application to the assignment

FIGURE 10.5: Use the builder to select the name of the object you want to use as a parameter.

d

SelectForms to get a list of all
the forms in your database.

Since thermDepartments
form is open, click oi.oaded
Forms and select the form.

Move to the middle pane and
selectield List to get a list of the

fields on the form in the pane an——"1] |

the far right.

Double-clickDeptCode to move it to the text area. If you make
a mistake, move to the text area, delete the text, and try again.

+ Expression Builder
Farmsl[frmDepartments][DeptCode] = Ok
ncel
;I ndo
+ - 1|8 <> < o] and o Net Lke| ()|\_ Paste | Help |
O pryryCourses <Farm> BV din
# Tahles
Queti DeptCpde Label Depthame
ueries
F Dept®de
orms Deptilame Lahel
= Loaded Forms Depthlame e PressOK
W11, D) e it nts Building Label when done.
Al Farms FDrrilrILgeader The te>_<t will
@ Pe «| |Detail be copied
_>|_I Form Footer Into the
criteria row.
2|
[ MHome | [4Previous | 9of1l

10. Parameter Queries

Application to the assignment

FIGURE 10.6: Requery the results set to reflect changes on the form.

= pgryCourses : Select Query
Department | Course number

Move to a new record on the
form. Notice that the query is not

A

Title

P [Conm 290
L [CoMm
oMM
oM B Departments

5

Deparment ¢ "de |MATH

Deparment name IMath
Building IMATH
Record: 14 <[] B> [vip

To

parameter valueMATHN this case)
Is used to select records.

automatically updated.

& pgryCourses : Select Query - [O] x|

Department | Course number Title

PressShift-F9 to requery. The new

Introduction to Stochastic Proces
Applied Matrix Analysis

P IhiaTH 303

MATH 407
*

B Departments =] E3

Department code IMATH

Department name |Math

Building IMATH

Record: HI 1 || Bk |H |He| of 7
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10. Parameter Queries

 Create a parameter query to show all the order
details for a particular order.

 Create a second parameter query to show all the
shipment details for a particular shipment.

Each order may result in a number of changes being
made to the BackOrders table. For some items in
the order, more product is ordered than is actually
shipped (i.e., a backorder is created). For other
items, more product is shipped than is ordered (i.e.,
a backorder is filled).

In Tutorial 15, you are supplied with a “shortcut”
Visual Basic procedure that makes the changes to
the BackOrders table for you. However, the short-
cut procedure requires a query that lists the changes
that must be made to the BackOrders table for a
particular order. The requirements for this query are
the following:

* The name of the query is

pgryltemsToBackOrder

Application to the assignment

« It shows the change (positive or negative but not
zero) in backorders for each item in a particular
order.

» The query consist of three fields: OrderID , Pro-
ductlD and a calculated field Qty (i.e., the
change in the back order for a particular product).

« The name of the parameter is in this query is sim-
ply[pOrderID] . Since the value of this parame-
ter will be set by the Visual Basic shortcut before
the query is run, there is no need to set it to a
value on a form.

Since the query is accessed by a program,
the name of the query and all the fields must
be exactly as described above. In other
words, you are given a precise specification
for a database object that fills a role in a pro-
cess designed and implemented by someone
else. You will not understand how the query
fits in until Tutorial 15.

11 of 11
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Access Tutorial 11:

11.1 Introduction: Queries that
change data

11.1.1 What is an action query?

All of the queries that you have created to this point
have been variations of “select” queries. Select que-
ries are used to display data but do not actually
change the data in any way.

Action queries , in contrast, are used to change the
data in existing tables or make new tables based on
the query's results set. The primary advantage of
action queries is that they allow you to modify a large
number of records without having to write Visual
Basic programs.

Access provides four different types of action que-

ries:

1. Make table — creates a new table based on the
results set of the query;

© Michael Brydon (brydon@unixg.ubc.ca)
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ues. There are at least four different ways of accom-
plishing this task:

1. Create a calculated field called NewCredits that
multiplies the value of Credits by 1.5 — The
guery containing the calculated field can be used
in place of the Courses table whenever credit
information is required. Of course, the values
stored in the Courses table are still the old val-
ues. Although there might be some advantages
to keeping the old values, it may cause confusion
about which values to use. In addition, the use of
a calculated field creates a computational load
that becomes larger as the number of courses
increases.

2. Go through the Courses table record by record
and manually change all the values — This
approach is tedious and error prone. Further-
more, it is simply impractical if the number of
courses is large.

Action Queries

2. Append — similar to a make-table query, except
that the results set of the query is appended to an
existing table;

3. Update — allows the values of one or more fields
in the result set to be modified; and,

4. Delete — deletes all the records in the results set
from the underlying table.

Since the operation of all four types of action queries
is similar, we will focus on update queries in this tuto-
rial.

11.1.2 Why use action queries?

To motivate the examples in the first part of this tuto-
rial, we are going to assume that the number of cred-
its allocated to courses in certain departments need
to be changed. For example, assume that you need
to increase the number of credits for courses in the
Commerce department by 1.5 times their current val-

[P [mmms] 1o

Learning objectives

3. Write a Visual Basic program to automate Step 2.
This is a good approach; however, it clearly
requires the ability to write Visual Basic pro-
grams.

4. Create an update query that (a) selects only
those courses that require modification and (b)
replaces the value of Credits  with Credits *

1.5 . — This approach is computationally efficient
and allows you to work with the QBE editor rather
than a programming language.

11.2 Learning objectives

O What is an action query? Why would | want to
use one?

O How do | make a backup copy of one of my
tables?

O How to | undo (rollback) an action query once
| have executed it?
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O How do | update only certain records in a
table?

O How do | create a button on a form? How do |
make an action query execute when the
button is pressed?

11.3 Tutorial exercises

11.3.1 Using a make-table query to create
a backup

Since action queries permanently modify the data in
tables, it is a good idea to create a backup of the
table in question before running the query. An easy
way to do this is to use a make-table query.
» Create a select query based on the Courses
table and save it as qryCoursesBackup
 Project the asterisk (*) into the query definition so
that all the fields are included in the results set.

Tutorial exercises

« While still in query design mode, select Query >
Make Table from the main menu and provide a
name for the target table (e.g., CoursesBackup )
as shown in Figure 11.1.

» Select Query > Run from the main menu to exe-
cute the action query, as shown in Figure 11.2.

f Action queries do not execute until you explic-
itly run them. Switching to datasheet mode
only provides a preview of the results set.

« Save the query. If you switch to the database win-
dow, you will notice that the new make-table
guery has a different icon than the select queries.

11.3.2 Using an update query to rollback
changes
Having a backup table is not much use without a

means of using it to restore the data in your original
table. In this section, you will use an update query to

30f16
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Tutorial exercises

FIGURE 11.1: Use a make-table query to back up and existing table

@, Microsoft Access

File Edit Mew [nsert EIELRY

B B E|&[v] s B
= qryCoursesBackup how Table..

Tools  Window Help

B e Tt e

® Select

Crosstalh I i

Update
Append...
Delete

S0L Specific +

Parameters...

-

Courses

—Make Mew Table

Tahle Name:

@ Current Database
" Another Datahase;

| =] = el =

‘b Transform theSelect query into
aMake Table query

C Provide a name for the new
(target) table.

Make Table

CoursesBackup j

Cancel |

[

Project all fields (*) into
a the query definition.
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Tutorial exercises

FIGURE 11.2: Run the make-table query.

You can switch to datasheet mode to view the results
set. Note that this does not actually execute the query.

@, Microsoft Access
File Edi Insert

iew Tools  Window Help

Show Tahble...
===

Select
Crosstalh
Make Tahle...
Update
Append...
Delete

2N

S0L Specific +

Parameters. .

Field: | o

A

Microsoft Access

You are about to paste 11 row(s) into a new table. Once you click Yes,
you can't use the Undo command to reverse the changes.

Are you sure you want to create a new takle with the selected records?

To execute the query, you must select
Query > Run. Alternatively, you can
press the “run” (!) icon on the toolbar.

Mo |

/

Tahble:
Sort:
Show
Criteria:

@

The warning box reminds you that you
are about to make permanent changes
to the data in the database.
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replace some of the values in your Courses table
with values from your CoursesBackup table.

» Create a new query based on the Courses and
CoursesBackup tables.

* Since no relationship exists between these
tables, create an ad hoc relationship within the
guery as shown in Figure 11.3.

 Select Query > Update from the main menu. Note
that this results in the addition of an Update To
row in the query definition grid.

* Project Credits into the query definition and fill
in the Update To row as shown in Figure 11.4.

» Save the query as gryRollbackCredits

Now is a good point to stop and interpret what you
have done so far:

1. By creating a relationship between the Courses
table and its backup, you are joining together the
records from both tables that satisfy the condi-

[ M Home | [4Previous |
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FIGURE 11.3: Create an ad hoc relationship
between the table and its backup.

i Queryl : Select Query

/Zéld:
able;

Drag the fields in the key on to their
counterparts in the backup table. -

SIS

ar:

Qa

@

You cannot drag two fields at once or
enforce referential integrity in a QBE
relationship like you can in the main
relationship editor.
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FIGURE 11.4: Fill in the Update To field.

= 1 SelectQuery > Update to make
the query an update query.

CoursesBackup

[ |DeptCode

Title
Credits
Artivity
KN
Field: | Credits
Tahble: | Courses
Update Ta: | [CoursesBackup].[Credits]
Criteria: B 4
/LI_I

Use the<table name>.<field name>
syntax to disambiguate the field name.

Tutorial exercises

tion:

Courses.DeptCode =
CoursesBackup.DeptCode AND
Courses.CrsNum =
CoursesBackup.CrsNum.

2. By projecting Courses.Credits into the query,
you are making it the target for the update. In
other words, the values in Courses.Credits
are going to be modified by the update action.

3. By setting the Update To field to Courses-
Backup.Credits , you are telling Access to
replace the contents of Courses.Credits with
the contents of CoursesBackup.Credits

Whenever this query is run, it will replace whatever is
in the Credits  field of all the records in the
Courses table with values from the backup. You will
use this query to “rollback” updates made later on.

[ M Home | [4Previous | 70f16
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11.3.3 Using an update query to make
selective changes

Now that you have an infrastructure for undoing any
errors, you can continue with the task of updating
credits for the Commerce department.
» Create an update query based on the Courses
table and save it as gryUpdateCredits
 Set the Update To field to [Courses]*1.5
Note that if you do not include the square brack-
ets, Access will interpret Courses as a literal
string rather than a field name.

@

Since this particular query only contains one
table, the <table name>.<field name>
syntax is not required for specifying the
Update To expression.

« Since you only want to apply the change to Com-
merce courses, enter a criterion for the Dept-
Code field, as shown in Figure 11.5.

Tutorial exercises

FIGURE 11.5: Create an update query that
updates a subset of the records.

& qrylpdateCredits : Update Query

Set theUpdate
a To field to replace

Credits  with
Credits x1.5
KN
: J
/
Field: [Credits # DeptCode
Table: | Courses Courses
Update To: [[Cradits]*1.5

Criteria:

ar:
l

‘b Add a criteria to limit the scope of
the update. Note th&teptCode is
not changed in any way by this query.

O
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* Run the query and verify that update has been
performed successfully.

11.3.4 Rolling back the changes

While testing the qryUpdateCredits query, your
exuberance may have led you to execute it more
than once. To return the Courses table to its state
before any updates, all you need to do it run your
rollback query.
* Run gryRollback  credits by double-clicking its
icon in the database window.

@

Once an action query is created, it has more
in common with subroutines written in Visual
Basic than standard select queries. As such, it
is best to think of action queries in terms of
procedures to be executed rather than virtual
tables or views. Double-clicking an action
query executes it.

Tutorial exercises

11.3.5 Attaching action queries to
buttons

As a designer, you should not expect your users to
understand your query naming convention, rum-
mage through the queries listed in the database win-
dow, and execute the queries that need to be
executed. As such, it is often useful to create buttons
on forms and “attach” the action queries to the but-
tons. When the button is pressed, the query is exe-
cuted.

Although we have not yet discussed buttons (or
events in general), the button wizard makes the cre-
ation of this type of form object straightforward.

* Modify gryUpdateCredits so that it updates
only those departments matching the DeptCode
value in the frmDepartments  table (see
Figure 11.6).

« Save the resulting action parameter query as
pgryUpdateCredits and close it.

9 of 16
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FIGURE 11.6: Create an action parameter query to update
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Credits for a particular department.

! grylUpdateCredits : Update Query

Ll |

B Departments

Deparment code ICOMM

Deparment name |Cummerce and Business Administr

=] E3

Building IANGU
Field: | Credits DBptCDdB Eecaord: 14 I 4 II 2k IN |P*I of 7 A
Table: | Courses Courses T
Update Ta: [[Credits]1 5 |

I

a2 The update operation
specifies the action to
perform on the records.

[Forms][frmDepartments][DeptCode]

hN

‘b The criterion limits the scope of the

update to those records matching
the current parameter value
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» Switch to the design view of frmDepartments
and add a button as shown in Figure 11.7.

« Attach the pgryUpdateCredits guery to the
button as shown in Figure 11.8.

* Provide a caption and a name for the button as
shown in Figure 11.9.

» Switch to form view. Press the button to run the
guery (alternatively, use the shortcut key by
pressing Alt-U) as shown in Figure 11.10.

11.4 Application to the assignment

11.4.1 Rolling back your master tables

As you begin to implement the transaction process-
ing component of your system, it is worthwhile to
have a means of returning your master tables to their
original state (i.e., their state when you started devel-
oping the system).

Application to the assignment

« Create backup copies of your Products and
BackOrders tables using make-tables queries.
Save these queries but note that they only need
to be run once.

 Create a rollback query that allows you to return
your Products table to its original state.

Rolling back the BackOrders table is more complex
than rolling back the Products table. This is
because we are making the assumption that no
products are ever added or deleted to the system. As
such, all the information needed for the rollback is in
the backup copy of Products

In contrast, records are added to the BackOrders
table on a regular basis. As a result, the Back-
Orders table and its backup may contain a different
number of records. If so, the match-and-replace pro-
cess used for rolling back Products is inappropri-
ate.

11 of 16
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Application to the assignment

FIGURE 11.7: Add a button to the form using the button wizard.

= If there is insufficient space for a button, drag
the border of the detail section to the right

= frmDepartments : Form

NI

Ensure that the

* Form Header

I:“.||]|||2|||'3|||4|||5|||E|||N.|.S|||]D|||H|

wizard button in the

# Detail

toolbox is

T
_ Depy rtmentcude”DeptCt
- I
1 ID.:Pu‘u...:..t.._A....:HDeptName

depressed (wizards
are activated).

N | Building IEluiIdinu
|

# Form Footer

C

Select the “command button” tool and click
on an appropriate location on the form detail

section. The button wizard should appear
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11. Action Queries Application to the assignment

FIGURE 11.8: Use the wizard to attach an action query to the button.

Command Button Wizard

‘What action do you want to happen when the buttan is pressed? a Buttons can be 'Created to )
_ _ _ perform many different actions
Difterent actions are available for each category. in Access. The button wizard
organizes these actions into
» categories. Select
Categories: Actions: Miscellaneous > Run Query.

Fecord MNavigation AutoDialer
Fecord Operations
Form Operations
Feport Cperations
Application

What queny would you like the command buttan ta run?

Cancel |

The wizard lists all the available
gueries (including non-action queri

gryCourselengths
grCourses

grvCoursesBackup
gryRollbackCredits

SelectpgryUpdateCredits gryUpdatelredits
[Berore] Moo ] 130136
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FIGURE 11.9: Use the wizard to attach a query to a button (continued)

C You can show either a picture (icon) or a caption @ Including an ampersand (&) in
on the button. Enter a suitable caption. the caption creates a shortcut
7 key from the letter immediately

following the ampersand.

Command Button Wizard

Do wou want text or & picture on the button? ShOI’tCUt keys can be invoked
using theAlt-<letter>
If yiuchoose Text you cantypEthe textto display. Ifyod choose combination (the letter is
dea_te Ficture yay can ol ijghBfwse to find & picture to displey. underlined). In this C&SAlt-U
Credits & Text  [8Update Credits moves the focus directly to the
button.
T Picture: |Append Cluery ;I EEe

Command Button Wizard

Undate
Credits

YWhat do you wantto name the button?

A meaningful name will help you to refer to the button later.

IcmdUpdateCredits

That's all the inform%\nthe wizard needs to create your
command buttan.

d Provide a meaningful name for the
button. Thecmd prefix indicates a
command button.

Cancel
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Application to the assignment

FIGURE 11.10: Execute the action query by pressing the button.

Press the button to execute the action query

A (or pressAlt-U to use the shortcut).

5= Departments

4 Deparment code ICOMM

Department narme |Commerce and Business Administrs

Building IANGU

Recard 1| Z > [

Update Credits

Microsoft Access [ |

& You are about to run an update query that will modify data in your table.
Are wou sure wou want to run this action query?

Click Help for information on how to prevent this message from displaying every time
YOu run an action queny.

Xes No Heln
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The easiest way to rollback the BackOrders table is
to delete all the records it contains and use an
append query to replace the records from the
backup.

» Open your BackOrders table in datasheet mode
and select Edit > Select All Records from the
menu (alternatively, press Control-A)

* Press the Delete key.

» Create an append query that adds the records
in the backup table to the BackOrders table.

Once you learn the Access macro language or
Visual Basic for Applications, you will be able to write
a small procedure to execute these steps for you.
For the assignment, however, this “manual rollback”
is sufficient.

11.4.2 Processing transactions

You are now in a position to combine parameter que-
ries and action queries into parameter-action que-

[ M Home | [4Previous |
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ries. These queries will allow you to perform
reasonably complex transaction processing opera-
tions on your master tables.
« Create an update query to add all products in a
shipment to inventory.

Note that this query should only process ship-
ment details for the current shipment (i.e., it
should be based on a parameter query similar
to the one you created in Section 10.4).

* Create a button on the shipments form to perform
this update.

« Create an update query to subtract items from
inventory when you process an order from your
customers. Do not attach this query to a button at
this point.

This query should only process order details
from the current order.

16 of 16
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Access Tutorial 12: An Introduction to Visual Basic

12.1 Introduction: Learning the
basics of programming

Programming can be an enormously complex and
difficult activity. Or it can be quite straightforward. In
either case, the basic programming concepts remain
the same. This tutorial is an introduction to a handful
of programming constructs that apply to any “third
generation” language, not only Visual Basic for
Applications (VBA).

f Strictly speaking, the language that is
included with Access is not Visual Basic—it is

a subset of the full, stand-alone Visual Basic
language (which Microsoft sells separately).
In Access version 2.0, the subset is called
“Access Basic”. In version 7.0, it is slightly
enlarged subset called “Visual Basic for Appli-
cations” (VBA). However, in the context of the

© Michael Brydon (brydon@unixg.ubc.ca)
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In the second part of the tutorial, you are going to
create a couple of VBA modules to explore looping,
conditional branching, and parameter passing.

12.2 Learning objectives

0 What is the debug/immediate window? How
do | invoke it?

O What are statements, variables, the
assignment operator, and predefined
functions?

O How do | create a module containing VBA
code?

O What are looping and conditional branching?
What language constructs can | use to
implement them?

a

How do | use the debugger in Access?

O What is the difference between an interpreted
and compiled programming language?

simple programs we are writing here, these
terms are interchangeable.

12.1.1 Interacting with the interpreter

Access provides two ways of interacting with the
VBA language. The most useful of these is through
saved modules that contain VBA procedures. These
procedures (subroutines and functions) can be run to
do interesting things like process transactions
against master tables, provide sophisticated error
checking, and so on.

The second way to interact with VBA is directly
through the interpreter. Interpreted languages are
easier to experiment with since you can invoke the
interpreter at any time, type in a command, and
watch it execute. In the first part of this tutorial, you
are going to invoke Access’ VBA interpreter and exe-
cute some very simple statements.

[P [mmms] 1o

Learning objectives

12.3 Tutorial exercises

12.3.1 Invoking the interpreter

» Click on the module tab in the database window
and press New.

This opens the module window which we will use in
Section 12.3.3. You have to have a module window
open in order for the debug window to be available
from the menu.
 Select View > Debug Window from the main
menu. Note that Control-G can be used in ver-
sion 7.0 and above as a shortcut to bring up the
debug window.

In version 2.0, the “debug” window is called
the “immediate” window. As such, you have to
use View > Immediate Window. The term
debug window will be used throughout this
tutorial.
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12.3.2 Basic programming constructs

In this section, we are going to use the debug win-
dow to explore some basic programming constructs.

12.3.2.1 Statements

Statements are special keywords in a programming
language that do something when executed. For
example, the Print  statement in VBA prints an
expression on the screen.
* In the debug window, type the following:
Print “Hello world!” O

(the O symbol at the end of a line means “press the
Return or Enter key”).

@ In VBA (as in all dialects of BASIC), the ques-
tion mark (?) is typically used as shorthand for

the Print statement. As such, the statement:

? “Hello world!” Ois identical to the
statement above.

Tutorial exercises

12.3.2.2 Variables and assignment

A variable is space in memory to which you assign a
name. When you use the variable name in expres-
sions, the programming language replaces the vari-
able name with the contents of the space in memory
at that particular instant.
* Type the following:

s = “Hello” O

? s & “world” O

?“s” & “ world” O
In the first statement, a variable s is created and the

string Hello is assigned to it. Recall the function of
the concatenation operator (&) from Section 4.4.2.

@ Contrary to the practice in languages like C
and Pascal, the equals sign (=) is used to
assign values to variables. It is also used as
the equivalence operator (e.g., does x=y 7?).
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When the second statement is executed, VBA recog-
nizes that s is a variable, not a string (since it is not
in quotations marks). The interpreter replaces s with
its value (Hello ) before executing the Print com-
mand. In the final statement, s is in quotation marks
so it is interpreted as a literal string .

Within the debug window, any string of char-
A acters in quotations marks (e.g., “COMM) is
interpreted as a literal string. Any string with-
out quotation marks (e.g., COMMs interpreted
as a variable (or a field name, if appropriate).
Note, however, that this convention is not uni-
versally true within different parts of Access.

12.3.2.3 Predefined functions

In computer programming, a function is a small pro-
gram that takes one or more arguments (or param-
eters) as input, does some processing, and returns
a value as output. A predefined (or built-in) function

Tutorial exercises

is a function that is provided as part of the program-
ming environment.

For example, cos(x) is a predefined function in
many computer languages—it takes some number x
as an argument, does some processing to find its
cosine, and returns the answer. Note that since this
function is predefined, you do not have to know any-
thing about the algorithm used to find the cosine, you
just have to know the following:

1. what to supply as inputs (e.g., a valid numeric
expression representing an angle in radians),

2. what to expect as output (e.g., a real number
between -1.0 and 1.0).

@ The on-line help system provides these two
pieces of information (plus a usage example
and some additional remarks) for all VBA pre-
defined functions.
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In this section, we are going to explore some basic
predefined functions for working with numbers and
text. The results of these exercises are shown in
Figure 12.1.
* Print the cosine of 2mradians:
pi=3.14159 O
? cos(2*pi) O
» Convert a string of characters to uppercase:
s = “basic or cobol” O
? UCase(s) O
 Extract the middle six characters from a string
starting at the fifth character:
? mid (s,5,6) 0

12.3.2.4 Remark statements

When creating large programs, it is considered good
programming practice to include adequate internal
documentation—that is, to include comments to
explain what the program is doing.

Tutorial exercises

FIGURE 12.1: Interacting with the Visual Basic
interpreter.

B Debug Window

I<Ready>

pi = 3.14159 _
? cos(2xpi) The argument contains
0.999999999985917 ~®— an expression.

s = "basic or cobol”

? UCase(s) ‘
BASIC OR COBOL

UCase() converts a
string to uppercase.

? mid (s,5,8)

¢ or ¢ Mid() extracts

characters from the
string defined earlier.
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Comment lines are ignored by the interpreter when
the program is run. To designate a comment in VBA,
use an apostrophe to start the comment, e.g.:

‘ This is a comment line!

Print “Hello” ‘the comment starts

here

The original REM (remark) statement from BASIC
can also be used, but is less common.

REM This is also a comment (remark)

12.3.3 Creating a module

« Close the debug window so that the declaration
page of the new module created in
Section 12.3.3 is visible (see Figure 12.2).

The two lines:

Option Compare Database

Option Explicit

are included in the module by default. The Option
Compare statement specifies the way in which

Tutorial exercises

FIGURE 12.2: The declarations page of a Visual
Basic module.

% Modulel : Module M=l B3
Ohject: I(General) j Froc: I(declﬂrﬂtinns)
Option Compare Database -

Option Explicit

strings are compared (e.g., does uppercase/ lower-
case matter?). The Option Explicit statement

forces you to declare all your variables before using
them.

In version 2.0, Access does not add the
Option Explicit statement by default. As
such you should add it yourself.

6 of 16
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A module contains a declaration page and one or
more pages containing subroutines or user-defined
functions . The primary difference between subrou-
tines and functions is that subroutines simply exe-
cute whereas functions are expected to return a
value (e.g., cos() ). Since only one subroutine or
function shows in the window at a time, you must
use the Page Up and Page Down keys to navigate
the module.

The VBA editor in version 8.0 has a number of
enhancements over earlier version, including
the capability of showing multiple functions
and subroutines on the same page.

Tutorial exercises

12.3.4 Creating subroutines with looping
and branching

In this section, you will explore two of the most pow-
erful constructs in computer programming: looping
and conditional branching
¢ Create a new subroutine by typing the following
anywhere on the declarations page:
Sub LoopingTest() O

Notice that Access creates a new page in the mod-
ule for the subroutine, as shown in Figure 12.3.

12.3.4.1 Declaring variables

When you declare a variable, you tell the program-
ming environment to reserve some space in memory
for the variable. Since the amount of space that is
required is completely dependent on the type of data
the variable is going to contain (e.g., string, integer,
Boolean, double-precision floating-point, etc.), you

7 of 16
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FIGURE 12.3: Create a new subroutine.

~ Modulel : Module =] E3
COhject: I(General) j Froc: ILl:ll:lpingTest
Sub LoopingTest() -
End Sub

@ You can use the procedure
combo box to switch between
procedures in a module.

have to include data type information in the declara-
tion statement.

In VBA, you use the Dim statement to declare vari-
ables.
 Type the following into the space between the
Sub... End Sub pair:
Dim i as integer
Dim s as string

Tutorial exercises

« Save the module as basTesting

One of the most useful looping constructs is For
<condition>... Next . All statements between
the For and Next parts are repeated as long as the
<condition>  partis true. The index i is automati-
cally incremented after each iteration.
« Enter the remainder of the LoopingTest  pro-
gram:
s = “Loop number: ”
Fori=1To 10
Debug.Prints & i
Next i
« Save the module.

@ It is customary in most programming lan-
guages to use the Tab key to indent the ele-
ments within a loop slightly. This makes the
program more readable.

8 of 16
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Note that the Print  statement within the subroutine
is prefaced by Debug. This is due to the object-ori-
ented nature of VBA which will be explored in greater
detail in Tutorial 14.

12.3.4.2 Running the subroutine

Now that you have created a subroutine, you need to
run it to see that it works. To invoke a subroutine, you
simply use its name like you would any statement.
 Select View > Debug Window from the menu (or
press Control-G in version 7.0).
» Type: LoopingTest [in the debug window, as
shown in Figure 12.4.

12.3.4.3 Conditional branching

We can use a different looping construct, Do Until
<condition>... Loop , and the conditional
branching construct, If <condition> Then...

Else , to achieve the same result.

Tutorial exercises

FIGURE 12.4: Run the LoopingTest
subroutine in the debug window.

- basTesting : Module

Ohject  |(General) | Proc ILuupingTest
Sub LoopingTest() l
Dim i As Integer
Dim s As String [<Reec>
LoopingTest
s = "Loop number: " Loop number: 1
Loop number: 2
For i = 1 To 10 Loop number: 3
Debug.Print s /& i | Loop humber: 4
Next i Loop number: 5
Loop number: &
End Sub Loop number: 7
Loop number: 8
Loop number: 9
Loop number: 10
subroutine

=2 Invoke theLoopingTest
by typing its name in the debug window.
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* Type the following anywhere under the End Sub
statement in order to create a new page in the
module:

Sub BranchingTest O
 Enter the following program:
Dim i As Integer
Dim s As String
Dim intDone As Integer
s = “Loop number: “
i=1
intDone = False
Do Until intDone = True
Ifi > 10 Then
Debug.Print “All done”
intDone = True
Else
Debug.Print s & i
i=i+1
End If

Tutorial exercises

Loop
¢ Run the program

12.3.5 Using the debugger

Access provides a rudimentary debugger to help you
step through your programs and understand how
they are executing. The two basic elements of the
debugger used here are breakpoints and stepping
(line-by-line execution).

* Move to the s =“Loop number: " line in your
BranchingTest  subroutine and select Run >
Toggle Breakpoint from the menu (you can also
press F9 to toggle the breakpoint on a particular
line of code).

Note that the line becomes highlighted, indicating the
presence of an active breakpoint. When the program
runs, it will suspend execution at this breakpoint and
pass control of the program back to you.

[ M Home | [4Previous | 100f16
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* Run the subroutine from the debug window, as
shown in Figure 12.5.
* Step through a couple of lines in the program
line-by-line by pressing F8.
By stepping through a program line by line, you can
usually find any program bugs. In addition, you can
use the debug window to examine the value of vari-
ables while the program’s execution is suspended.
* click on the debug window and type
?i 0
to see the current value of the variable i .

12.3.6 Passing parameters

In the BranchingTest  subroutine, the loop starts
at 1 and repeats until the counter i reaches 10. It
may be preferable, however, to set the start and fin-
ish quantities when the subroutine is called from the
debug window. To achieve this, we have to pass
parameters (or arguments ) to the subroutine.

Tutorial exercises

FIGURE 12.5: Execution of the subroutine is
suspended at the breakpoint.

‘- basTesting : Module
Object: I(General) j

Proc: IBranchingTest

Sub BranchingTest() ZI

|[univ0_v7 mdb] basTesti

Dim i As Integer
Dim s As String
Dim intDone As Integer

BranchingTest

s = "Loop number: "]

i=1
intDone = False

Do Until intDc

The outlined box indicates the
current location of the

If lnzble interpreter in the program. Press
intngf F8 to execute the line of code.

Else
Debug.Print s & i
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The main difference between passed parameters
and other variables in a procedure is that passed
parameters are declared in the first line of the sub-
routine definition. For example, following subroutine
declaration

Sub BranchingTest(intStart as

Integer, intStop as Integer)

not only declares the variables intStart and
intStop  as integers, it also tells the subroutine to
expect these two numbers to be passed as parame-
ters.

To see how this works, create a new subroutine
called ParameterTest based on Branch-
ingTest
» Type the declaration statement above to create
the ParameterTest  subroutine.
» Switch back to BranchingTest  and highlight all
the code except the Sub and End Sub state-
ments, as shown in Figure 12.6.

[ M Home | [4Previous |
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FIGURE 12.6: Highlight the code to copy it.

Object: I(Generﬁl)

Sub BranchingTest()

Dim i As Integer
Dim s As String
Dim intDone As Integer

“"Loop number:
intDone = False
Do Until intDone = True
If 1 > 10 Then

Debug.Print "All done”
intDone = True

Debug.Print s & i

End Sub

12 0of 16
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» Copy the highlighted code to the clipboard (Con-
trol-Insert), switch to ParameterTest , and
paste the code (Shift-Insert) into the Parame-
terTest procedure.

To incorporate the parameters into ParameterT-
est , you will have to make the following modifica-
tions to the pasted code:
* Replacei=1 withi=intStart
* Replacei> 10 withi> intStop
* Call the subroutine from the debug window by
typing:
ParameterTest 4, 12 g

@ If you prefer enclosing parameters in brack-
ets, you have to use the Call <sub

name>(parameter 4, ..., parameter n)
syntax. For example:
Call ParameterTest(4,12) O

Tutorial exercises

12.3.7 Creating the Min() function

In this section, you are going to create a user-
defined function that returns the minimum of two
numbers. Although most languages supply such a
function, Access does not (the Min() and Max()
function in Access are for use within SQL statements
only).
« Create a new module called basUtilities
* Type the following to create a nhew function:
Function MinValue(nl as Single, n2
as Single) as Single O
This defines a function called MinValue that returns
a single-precision number. The function requires two
single-precision numbers as parameters.

@ Since a function returns a value, the data type
of the return value should be specified in the
function declaration. As such, the basic syn-
tax of a function declaration is:

13 0of 16

[ M Home | [4Previous |

12. An Introduction to Visual Basic

Function <function

name>(parameter ; As <data type>,
..., parameter |, As <data type>) As
<data type>

The function returns a variable named
<function name>

 Type the following as the body of the function:
If N1 <=n2 Then
MinValue = nl1
Else
MinValue = n2
End If
* Test the function, as shown in Figure 12.7.

Discussion

12.4 Discussion

12.4.1 Interpreted and compiled
languages

VBA is an interpreted language . In interpreted lan-
guages, each line of the program is interpreted (con-
verted into machine language) and executed when
the program is run. Other languages (such as C,
Pascal, FORTRAN, etc.) are compiled , meaning
that the original (source) program is translated and
saved into a file of machine language commands.
This executable file is run instead of the source
code.

Predictably, compiled languages run much faster
then interpreted languages (e.g., compiled C++ is
generally ten times faster than interpreted Java).
However, interpreted languages are typically easier
to learn and experiment with.

14 of 16
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FIGURE 12.7: Testing the MinValue() function.

=2 Implement theMinValue()
function using conditional branchi

.- basUtilities : Module

Ohbject: I(General) hd| Proc; IMinVaIue
Function MipYalue(nl As Single, n2 As Single) As Single b Test the function by passing it
various parameter values.
If n1 <= n2 Then & Debug Window
MinUalue = ni <FPieady> |
Else I . —& _l
MinValue = n2 ? MinUalue(8,12) @ According to the function
End If 8 declarationMinValue()
lA ) expects two single-precision
End FuRfction ? MinUalue(0.001, -0.001) numbers as parameters.
-0.001 Anything else generates an error.
? MinUalue("ten”, "tuwelue”) [MHEtirir ooy

& Run-time errar 13"

Twpe mismatch

These five lines could be replaced with one line: ok ] tew |

MinValue = iif(n1 <= n2, n1, n2)
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12.5 Application to the assignment

You will need a MinValue()  function later in the
assignment when you have to determine the quantity

to ship.
» Create a basUitilities module in your assign-
ment database and implement a MinValue()
function.

A To ensure that no confusion arises between

your user-defined function and the built-in
SQL Min() function, do not call you function
Min() .
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Access Tutorial 13: Event-Driven Pro grammin g
Using Macros

13.1 Introduction: What is event-
driven programming?
In conventional programming, the sequence of oper-
ations for an application is determined by a central
controlling program (e.g., a main procedure). In
event-driven programming, the sequence of opera-
tions for an application is determined by the user’s
interaction with the application’s interface (forms,
menus, buttons, etc.).

For example, rather than having a main procedure
that executes an order entry module followed by a
data verification module followed by an inventory
update module, an event-driven application remains
in the background until certain events happen: when
avalue in a field is modified, a small data verification
program is executed; when the user indicates that

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 25-Aug-1997
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FIGURE 13.1: In a tri gger, a procedure is
attached to an event.

/ interface object \

An object, such as the
button created in

A procedure (such as an
action query, macro, or VBA
function or subroutine) can be
attached to an event. When
the event occurs, the
procedure is executed.

cmdUpdateCredits Section 11.3.5, has
X predefined properties and
properties events. For a button, the
Caption most important event is
Enabled On Click.
events procedure
On Click = e——
On Got Focus

the order entry is complete, the inventory update
module is executed, and so on.

Event-driven programming, graphical user interfaces
(GUIs), and object-orientation are all related since
forms (like those created in Tutorial 6) and the
graphical interface objects on the forms serve as the
skeleton for the entire application. To create an
event-driven application, the programmer creates
small programs and attaches them to events associ-
ated with objects, as shown in Figure 13.1. In this
way, the behavior of the application is determined by
the interaction of a number of small manageable pro-
grams rather than one large program.

[P o] 1or2s

Introduction: What is event-driven programming?

13.1.1 Triggers

Since events on forms “trigger” actions, event/proce-
dure combinations are sometimes called triggers.

For example, the action query you attached to a but-
ton in Section 11.3.5 is an example of a simple, one-
action trigger. However, since an action query can
only perform one type of action, and since you typi-
cally have a number of actions that need to be per-
formed, macros or Visual Basic procedures are
typically used to implement a triggers in Access.

13.1.2 The Access macro language

As you discovered in Tutorial 12, writing simple VBA
programs is not difficult, but it is tedious and error-
prone. Furthermore, as you will see in Tutorial 14,
VBA programming becomes much more difficult
when you have to refer to objects using the naming
conventions of the database object hierarchy. As a
consequence, even experienced Access program-

20f26
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13. Event-Driven Programming Using Macros

mers often turn to the Access macro language to
implement basic triggers.

The macro language itself consists of 40 or so com-
mands. Although it is essentially a procedural lan-
guage (like VBA), the commands are relatively high
level and easy to understand. In addition, the macro
editor simplifies the specification of the action argu-
ments (parameters).

13.1.3 The trigger design cycle

To create a trigger, you need to answer two ques-
tions:

1. What has to happen?
2. When should it happen?

Once you have answered the first question (“what”),
you can create a macro (or VBA procedure) to exe-
cute the necessary steps. Once you know the
answer to the second question (“when”), you can

Learning objectives

attach the procedure to the correct event of the cor-
rect object.

Selecting the correct object and the correct
event for a trigger is often the most difficult
part of creating an event-driven application. It
is best to think about this carefully before you
get too caught up in implementing the proce-
dure.

13.2 Learning objectives

O What is event-driven programming? What is a
trigger?

How do | design a trigger?
How does the macro editor in Access work?

How do | attach a macro to an event?

aaaaq

What is the SetValue action? How is it used?

[ M Home | [4Previous | 30f26
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0 How do | make the execution of particular
macro actions conditional?

O What is a switchboard and how do | create
one for my application?

O How to | make things happen when the
application is opened?

O What are the advantages and disadvantages
of event-driven programming?

13.3 Tutorial exercises

In this tutorial, you will build a number of very simple
triggers using Access macros. These triggers, by
themselves, are not particularly useful and are
intended for illustrative purposes only.

Tutorial exercises

13.3.1 The basics of the macro editor

In this section, you are going to eliminate the warn-
ing messages that precede the trigger you created
Section 11.3.5.

As such, the answer to the “what” question is the fol-

lowing:

1. Turn off the warnings so the dialog boxes do not
pop up when the action query is executed;

2. Run the action query; and,

3. Turn the warnings back on (it is generally good
programming practice to return the environment
to its original state).

Since a number of things have to happen, you can-
not rely on an action query by itself. You can, how-
ever, execute a macro that executes several actions
including one or more action queries.

4 of 26
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13. Event-Driven Programming Using Macros

* Select the Macros tab from the database window
and press New. This brings up the macro editor
shown in Figure 13.2.

» Add the three commands as shown in
Figure 13.3. Note that the OpenQuery command
is used to run the action query.

» Save the macro as mcrUpdateCredits
close it.

and

13.3.2 Attaching the macro to the event

The answer to the “when” question is: When the
cmdUpdateCredits  button is pressed. Since you
already created the button in Section 11.3.5, all you
need to do is modify its On Click property to point the
mcrUpdateCredits macro.

* Open frmDepartments  in design mode.

» Bring up the property sheet for the button and

scroll down until you find the On Click property,

Tutorial exercises

FIGURE 13.4: Bring up the On Click property for
the button.

e |
Update Credits E—

¥ Command Button: cmdUpdateCredits

ControlTip Text. .. ..
Help ContextId . . ...
Tag................
OnEnter... . ... . ..
OnExit.............
On GotFocus ... ...
On LostFocus . ... .
OnClick............
On Dbl Click ... ..
On Mouse Down . .
On Mouse bMowve
On bouse Up . ...
O Key Down .. /.
OnkeyUp. ... /...
On Key Press /... ..

Formatl Data | Ewent | Cther

All |

=]

[Ewvent Procedure]

g

The button wizard attached a
VBA procedure to the button.

@

as shown in Figure 13.4.

50f26
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FIGURE 13.2: The macro editor.

Macro actions can be selected from a list. The
SetWarnings command is used to turn the warning

| In the comment column, you can
messages (e.g., before you run an action query) on and off.

document your macros as required

Tutorial exercises

& Macrol : Macro

Multiple commands are Action CEmmE =
executed from top to P [Setiamings -] [~
bottom.

Most actions have one or -
more a_rguments that p— =
determine the specific etion Argurnents

behavior of the action. In Wamings On No

his case. the Turns all systern MEssages oh ar
t g . . off. Pressents modal warnings from
SetWarnlngs action Is stopping the macto (athough

set to turn warnings off. errar messages and dialogs that

recuire user input still appear).
. This has the same effect as

The area on the rlght > pressing Enter in each message
displays information about box (typically an OK or Yes).
the action. Fress F1 for help on this action.

[ Home | [4Previous |
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Tutorial exercises

FIGURE 13.3: Create a macro that answers the “what” question.

A

the macro.

The arguments for the two
SetWarnings actions
are straightforward. For the
OpenQuery command,
you can select the query to
open (or run) from a list.

To

Add the three commands to

# mcrUpdateCredits | Macro

Action Cormment -

Setarnings

OpenQuery

Setwarnings

Action Argurnents

Cluery Mame porylUpdateCredits ;l
i e Diatashest
Data Mode Edit

Since this is an action
query, the second and third
arguments are not
applicable.

this argument,

MCours.com

13. Event-Driven Programming Using Macros

* Press the builder button (1=]) beside the existing

procedure and look at the VBA subroutine cre-
ated by the button wizard. Most of this code is for

error handling.

@

Unlike the stand-along VBA modules you cre-
ated in Tutorial 12, this module (collection of

functions and subroutines) is embedded in

the frmDepartments

form.

 Since you are going to replace this code with a
macro, you do not want it taking up space in your
database file. Highlight the text in the subroutine
and delete it. When you close the module win-
dow, you will see the reference to the “event pro-

cedure” is gone.

* Bring up the list of choice for the On Click prop-
erty as shown in Figure 13.5. Select mcrUp-

dateCredits

7 0f26
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Selectthe name of the guenyto
open. The list shows all gueries in
the current database. Required
argurnent. Press F1 for help on
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On Click property.

¥’ Command Button: cmdUpdateCredits

Formatl Diata | Ewent | Other All |
Shortcut Menu Bar . .

ControlTip Text. . ...

Help Contextld . . ... 0

T ]
c A Press the arrow to get a list
c of available macros

On GotFocus ...
OnLostFocus ... ...

OnClick............ = [

On Dbl Click........
On bouse Down .. ul=gSlsEEeeEtis
On Mouse Maowve ...
OnMouse Up ... ..
On Kewy Down .. ...,
OnKeyUp. ... ..

[Ewvent Pracedure]

FIGURE 13.5: Select the macro to attach to the

=]

mn
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» Switch to form view and press the button. Since
no warnings appear, you may want to press the
button a few times (you can always use your roll-
back query to reset the credits to their original
values).

13.3.3 Creating a check box to display
update status information

Since the warning boxes have been disabled for the
update credits trigger, it may be useful to keep track
of whether courses in a particular department have
already been updated.

To do this, you can add a field to the Departments
table to store this “update status” information.
* Edit the Departments table and add a Yes/No
field called CrUpdated .

If you have an open query or form based on
the Departments table, you will not be able

Tutorial exercises

to modify the structure of the table until the
query or form is closed.

» Set the Caption property to Credits updated?
and the Default property to No as shown in
Figure 13.6.

Changes made to a table do not automatically carry
over to forms already based on that table. As such,
you must manually add the new field to the depart-
ments form.

e Open frmDepartments  in design mode.

» Make sure the toolbox and field list are visible.
Notice that the new field (CrUpdated ) shows up
in the field list.

» Use the same technique for creating combo
boxes to create a bound check box control for the
yes/no field. This is shown in Figure 13.7.

9 o0f26
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FIGURE 13.6: Add a field to the Departments
table to record the status of updates.

# Departments : Table

| Field Name Data Type
% |DeptCode Text
DeptMame Text
Building Text
Crlpdated YesfMo

General | Lookup |

Format “egiMNo

Caption Credits updated?
Defaultvalue R=}

Walidation Rule

Walidation Text

Regquired Mo

Inclexed Mo

13.3.4 The SetValue command

So far, you have used two commands in the Access
macro language: SetWarnings and OpenQuery. In

Tutorial exercises

this section, you are going to use one of the most
useful commands—SetValue —to automatically
change the value of the CrUpdated check box.

¢ Open your mcrUpdateCredits ~ macro in design
mode and add a SetValue command to change
the CrUpdated check box to Yes (or True , if
you prefer). This is shown in Figure 13.8.

« Save the macro and press the button on the form.
Notice that the value of the check box changes,
reminding you not to update the courses for a
particular department more than once.

13.3.5 Creating conditional macros

Rather than relying on the user not to run the update
when the check box is checked, you may use a con-
ditional macro to prevent an update when the
check box is checked.

10 of 26
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FIGURE 13.7: Add a check box control to keep track of the update status.

=, Selectthe check box tool

|_||'I']'I'2'I'3'I'4'I'5'I'B'I'?'I'g'l'a'l'm'l fromthet00|box.
¥ Form Header
... [
_ |DBpE nmentcude”D?pth ITR
1 iDcpuu...:..t..4...ciiDeptName —r Update A |abl
_ Builéing IEﬂLJIiIdinu v Credits pupdateq? B I;Z] _':I<
_l 8 Departme. .. e
- =i A check box is a control
EEE that can be bound to fields
NE] of the yes/no data type.
NI[= When the box is checked,
True is stored in the
table; when the box is
‘b Drag theCrUpdated field from the uncheckedFalse is
field list to the detail section. stored.

[P o] toi
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FIGURE 13.8: Add a SetValue command to set the value of the update status field when the
update is compete.

=2 Pick theSetValue command
from the list or simply type it in.

# mcrUpdateCredits : WMacro
Rl \ Expression Builder [ %]

gztxgﬂien@gxs Formsl[frmDepartments][Crlpdated] = Ok
Setwarnings Cancel
Setvalue
;l Undo |
+ - *|ﬁ = > < <>| And  Or Mot leel Faste | Help
tem [Cripdated] |<F0rm> | Buildin
Expression Yes -~
DeptCode Label DeptCode
- DeptCode Narthlama
- 1 & Losded Forms DeptName Le TheExpression argument is the
b Theltem argument is the thing you= [T value you want th&etValue
want theSetValue action to set theiForms gul:gmg L8B3 action to set the value of thtem
A g o o
value of. You can use the builder Obts o dupgdateol to. Type inYes (no quotation
simply type inCrUpdate . ictions _ILI CrUpdated marks are required sindes is
R b |Labeld recognized as a constant in this
context).
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« Select View > Conditions to display the condi-
tions column in the macro editor as shown in
Figure 13.9.

FIGURE 13.9: Display the macro editors
condition column

@, Microsoft Access

File  Edit Inset Bun Tools “Window Help
El tacro Names

¥ Conditions

& ml::rUp UAT LA SIS L TiuL Y

Condition

tamings
Openlueny
Setarnings
Setvalue

SelectView > Conditions or press the
“conditions” button on the tool bar.

Tutorial exercises

13.3.5.1 The simplest conditional macro

If there is an expression in the condition column of a
macro, the action in that row will execute if the condi-
tion is true. If the condition is not true, the action will
be skipped.
« Fill in the condition column as shown in
Figure 13.10. Precede the actions you want to
execute if the check box is checked with [CrUp-
dated] . Precede the actions you do not want to
execute with Not [CrUpdated]

@

Since CrUpdated is a Boolean (yes/no) vari-
able, you do not need to write [CrUpdated]
=True or [CrUpdated] = False . The
true and false parts are implied. However, if a
non-Boolean data type is used in the expres-
sion, a comparison operator must be included
(e.g., [DeptCode] = “COMM” | [Cred-

its] < 3 , etc.)

13 0f 26
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FIGURE 13.10: Create a conditional macro to control which actions execute.

a The expressiomot [CrUpdated] # mcrUpdateCredits : Macro (O] x|
is true if theCrUpdated check box is | Canditian Actian Camment l
not checked. Use this expression in EE} Eggpgggg% geg“:;’gu”;"gs
front of the actions you want to executg—, ° [CrUE Seted SStWarninrgs
in this situation. Not[CrUpdated] | Sefvalue
[Crlpdated] hsgBox
‘b The expressiofCrUpdated] is Action Arguments -
true if theCrUpdated check box is
checked. In this situation, you shoul Message Courses for this depanment hawve alre Enter the text
indicate to the user that the update is = BeeP ves of the
not being performed. e hione message o
itle display in the
C TheMsgBox action displays a e P
standard Windows message box. You F1 far help
can set the message and other message an this
box features in the arguments section. argument
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» Switch to the form and test the macro by pressing
the button. If the CrUpdated check box is
checked, you should get a message similar to
that shown in Figure 13.11.

FIGURE 13.11: The action query is not executed
and the message box appears instead.

B Departments

4 Department code ICOMM

Department name |Cummerce and Business Administr

Building IANGU

Microsoft Access

¥ Credits updated?

Courses for this deparment have already been updated.

Tutorial exercises

13.3.5.2 Refining the conditions

The macro shown in Figure 13.10 can be improved
by using an ellipsis (...) instead of repeating the
same condition in line after line. In this section, you
will simplify your conditional macro slightly.

Move the message box action and condition to the
top of the list of actions by dragging its record selec-
tor (grey box on the left).
« Insert a new row immediately following the mes-
sage and add a StopMacro action, as shown in
Figure 13.12.

The macro in Figure 13.12 executes as follows: If
CrUpdate is true (i.e., the box is checked), the
MsgBox action executes. Since the next line has an
ellipsis in the condition column, the condition contin-
ues to apply. However, that action on the ellipsis line
is StopMacro , and thus the macro ends without
executing the next four lines.
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FIGURE 13.12: Rearrange the macro actions and
insert a new row.

Click the record selector and drag the

Qa

# mcrUpdaieCredits : Macro

| 4 Condition Action c Add an eIIipsis
_ (...)and a
SIS StopMacro
L penCuery i
_ SetWamings action.
_ Setvalue
— Conghfion

Copy
PEEtE

Stophacro ©
SetWarnings

OpenCuery

SetWarnings

Setvalue

E Cruwéted

nght -click where you would like
to insert a new row and select
Insert Row from the popup menu.

message box action to the top of the list.
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If the CrUpdate box is not checked, the first two
lines are ignored (i.e., the lines with the false condi-
tion and the ellipsis) and the update proceeds.

13.3.5.3 Creating a group of named macros

It is possible to store a number of related macros
together in one macro “module”. These group mac-
ros have two advantages:

1. Modular macros can be created — instead of
having a large macro with many conditions and
branches, you can create a small macro that call
other small macros.

Similar macros can be grouped together  — for
example, you could keep all you Departments -
related macros or search-related macros in a
macro group.

In this section, we will focus on the first advantage.
 Select View > Macro Names to display the macro
name column.

16 of 26
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13. Event-Driven Programming Using Macros

 Perform the steps in Figure 13.13 to modularize
your macro.

» Change the macro referred to in the On Click
property of the cmdUpdateCredits  button from
mcrUpdateCredits  to
mcrUpdateCredits.CheckStatus

* Test the operation of the button.

13.3.6 Creating switchboards

One of the simplest (but most useful) triggers is an
OpenForm command attached to a button on a form
consisting exclusively of buttons.

This type of “switchboard” (as shown in
Figure 13.14) can provide the user with a means of
navigating the application.
» Create an unbound form as shown in
Figure 13.15.

Tutorial exercises

« Remove the scroll bars, navigation buttons, and
record selectors from the form using the form’s
property sheet.

« Save the form as swbMain .

There are two ways to add button-based triggers to a
form:

1. Turn the button wizard off, create the button, and
attach an macro containing the appropriate
action (or actions).

2. Turn the button wizard on and use the wizard to
select from a list of common actions (the wizard
writes a VBA procedure for you).

@ Since the wizard can only attach one action to
a button (such as opening a form or running
an action query) it is less flexible than a
macro. However, once you are more comfort-

able with VBA, there is nothing to stop you
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FIGURE 13.13: Use named macros to modularize the macro.

= SelectView > Macro Names to display
the macro names column.

Create a named macro called
CheckStatus that contains the
conditional logic for the procedure.

C Create two other macrodpdated and
NotUpdated that correspond to the
logic in theCheckStatus macro.

TheRunMacro action executes a
particular macro. Select the macro to
execute from a list in the arguments pahe-
Note the naming convention for macros
within a macro group.

@ A macro executes until it encounters a
blank line. Use blank lines to separate the
named macros within a group.

# mcrUpdateCredits : Macro

Macro MName Condition Action

\’_ CheckStatus [CrJpdated]
Mot [Crlpdated]

-

Runtdacro
Rurntdacro

Updated MsgBox

MNotUpdated Setarnings
CpenQuery
SetWarnings
Sefvalue

Action Arguments

bMacro Mame |
Fepeat Count merlpdateCredits
eat Expression mcrlpdate Credits. CheckStatus

mcrl pdate Credits. Updated

mctpdate Credits NotUpdated
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13. Event-Driven Programming Using Macros Tutorial exercises

FIGURE 13.14: A switchboard interface to the application.

The command buttons are placed on an Although it is not shown here, switchboards can
unbound form. Note the absence of scroll bars call other switchboards, allowing you to add a
record selectors, or navigation buttons. hierarchical structure to your application.

\ & Main Switchboard

14

Gratuitous clip art can be used to Shortcut keys are include on each
clutter your forms and reduce the button to allow the user to navigate
application’s overall performance. the application with keystrokes.

O] x|
| poen ey Univargity Infarmation System |

View Departments. Rollback Credit Update

View Courses View Sections
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New Form 2IX]  FIGURE 13.15: Create an unbound form as the
.................................................. SWitCthard background.
- FD rm leard
.EL..'.. AutoForm: Calumnar
AutoForm: Tabular
: : AutoForm: Datashest SelectDesign View (no wizard) and
e CREKUENG | Chant Wizerd A jcave the “rgecord so(urce” box )em ty
awizard. PivofTable Wizard Ply.
The result is a blank form on which
you can build your switchboard.
Choose the table or query where I y
the object's data comes from:

(0]4 I Cancel |
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from editing the VBA modules created by the
wizard to add additional functionality.

13.3.6.1 Using a macro and manually-created
buttons

» Ensure the wizard is turned off and use the but-
ton tool to create a button.

» Modify the properties of the button as shown in
Figure 13.16.

» Create a macro called
mcrSwitchboard.OpenDept and use the
OpenForm command to open the form frmDe-
partments

 Attach the macro to the On Click event of the
cmdDepartments  button.

* Test the button.

13.3.6.2 Using the button wizard
« Turn the button wizard back on and create a hew
button.

Tutorial exercises

 Follow the directions provided by the wizard to
set the action for the button (i.e., open the frm-
Courses form) as shown in Figure 13.17.

» Change the button’s font and resize it as
required.

You can standardize the size of your form

@ objects by selecting more than one and using
Format > Size > to Tallest and to Widest com-
mands. Similarly, you can select more than
one object and use the “multiple selection”
property sheet to set the properties all at
once.

13.3.7 Using an autoexec macro

If you use the name autoexec to save a macro (in

lieu of the normal mcr<name> convention), Access

will execute the macro actions when the database is
opened. Consequently, auto-execute macros are

13. Event-Driven Programming Using Macros
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FIGURE 13.16: Create a button and modify its appearance.

= Use the button tool to create a button
(ensure the wizard activated).

‘b Give the button a meaningful name
(e.g.cmdDepartments ) and caption
(including a shortcut key.).

B swbMain : Form
D|-|-1-|-2-|-§\-|-4-
[ J[#Deti
- B | |. | A |abl |_" =2 F I Event I Other All |
- = * Detail
- : Comrﬂandﬂ E ] I j | | | Mame.............. cmdDeptatments =l
! ol 1 _ = n Caption............ YWiew &Departments =
- EH - View | Picture......... {none)
2 ) [ | / Departments Picture Type ... Embedded
- e | e - - = Transparent........ Mo
- /{ Defadlt............. Mo
r us - B oo oe No
q = - Auto Fepeat ... Ma
jr Status Bar Text. ...
4 Visible ..o Yes

DisplayWhen .. .. .. Always
C Scroll down the property sheet and change Enabled........... Yes
the value of the buttonBont Size property. ~ T2250p......... s
Resize the button by dragging its handles. =~ T82ndex......... 0
_eft ................ 0 Bﬁ?cm ;I
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FIGURE 13.17: Use the command button wizard to create a button for the switchboard.

a SelectForm Operations > Open Form as

the action type associated with the button.

Actions:

Provide a caption
C for the button.
-\

Command Button Wizard

Feport Operations
Application
Command Button Wizard

Apply Form Filter
Close Form
3 dit Farm Filter

Frinta Form

What form would you like the command b

Do wou wanltext or a picture on the button?

[fwou choose\ Text, you can tvpe the textta
Ficture, vou oS click Browse to find a pich

i e
Courses

& Text \iew &Caurses

' Picture: cess Form

Deparments

frmCourses
frmCoursesha
frmCoursesl B
frimDeparments
sfrrSections
swhhdain

Select the correct for
from the list.

I | St Al Pictures
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often used to display a switchboard when the user
starts the application.

Another typical auto-execute operation is to hide the
database window. By doing this, you unclutter the
screen and reduce the risk of a user accidentally
making a change to the application (by deleting a
database object, etc.).

To unhide the database window, select Win-
dow > Unhide from the main menu or press

the database window icon (&) on the toolbar.

The problem with hiding the database window using
a macro is that there is no HideDatabaseWindow
command in the Access macro language. As such,
you have to rely on the rather convoluted DoMenu-
Iltem action.

As its name suggests, the DoMenultem action per-
forms an operation just as if it had been selected

o] [Greviows |

Tutorial exercises

from the menu system. Consequently, you need to
know something about the menu structure of Access
before you create your macro.

é In version 8.0, the DoMenultem action has
been replaced by the slightly more intuitive
RunCommandaction. See on-line help for
more information on RunCommand

 Create an auto-execute macro

« Add the DoMenultem and OpenForm actions to
hide the database window and open the main
switchboard, as shown in Figure 13.18.

* Close the database and reopen it after a short
delay to test the macro.

@ In version 7.0 and above, you do not need to

use an autoexec macro to hide the database
window and open a form. Instead, you can
right-click on the database window, select

24 0of 26
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FIGURE 13.18: Create an auto-execute macro.

# autoexec : Macro

I Action
P |DoMenultern |
OpenForm
henu Bar Database

kMenu MName Window
Command Hidle
Sub mand

= For theDoMenultem action, select the

Window > Hide commands from the
Database menu (i.e., the menu that is active
when the database window is being used).

Startup, and fill in the properties for the appli-
cation.

Discussion
13.4 Discussion

13.4.1 Event-driven programming versus
conventional programming

The primary advantages of event-driven program-
ming are the following:

1. Flexibility — since the flow of the application is
controlled by events rather than a sequential pro-
gram, the user does not have to conform to the
programmer’s understanding of how tasks should
be executed.

2. Robustness — Event-driven applications tend to
be more robust since they are less sensitive to
the order in which users perform activities. In
conventional programming, the programmer has
to anticipate virtually every sequence of activities
the user might perform and define responses to
these sequences.
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The primary disadvantage of event-driven programs
is that it is often difficult to find the source of errors
when they do occur. This problem arises from the
object-oriented nature of event-driven applications—
since events are associated with a particular object
you may have to examine a large number of objects
before you discover the misbehaving procedure.
This is especially true when events cascade (i.e., an
event for one object triggers an event for a different
object, and so on).

13.5 Application to the assignment
» Add “update status” check boxes to you transac-
tion processing forms (i.e., Orders and Ship-
ments )
* Create a conditional macro for your Shipments
form to prevent a particular shipment from being
added to inventory more than once.

Application to the assignment

e Create a main switchboard for you application. It
should provide links to all the database objects
your user is expected to have access to (i.e., your
forms).
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Access Tutorial 14: Data Access Objects

14.1 Introduction: What is the DAO
hierarchy?

The core of Microsoft Access and an important part
of Visual Basic (the stand-alone application develop-
ment environment) is the Microsoft Jet database
engine. The relational DBMS functionality of Access
comes from the Jet engine; Access itself merely pro-
vides a convenient interface to the database engine.

Because the application environment and the data-
base engine are implemented as separate compo-
nents, it is possible to upgrade or improve Jet
without altering the interface aspects of Access, and
vice-versa.

Microsoft takes this component-based approach fur-
ther in that the interface to the Jet engine consists of
a hierarchy of components (or “objects”) called Data
Access Objects (DAO). The advantage of DAO is

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 25-Aug-1997

14. Data Access Objects

Unfortunately, the DAO hierarchy is somewhat more
complex than this. However, at this level, it is suffi-
cient to recognize three things about DAO:

1. Each object that you create is an instance of a
class of similar objects (e.g., univO_v x is a par-
ticular instance of the class of Database objects).

2. Each object may contain one or more Collec-
tions of objects. Collections simply keep all
objects of a similar type or function under one
umbrella. For example, Field objects such as
DeptCode and CrsNum are accessible through a
Collection called Fields ).

3. Objects have properties and methods (see
below).

14.1.2 Properties and methods

You should already be familiar with the concept of
object properties from the tutorial on form design
(Tutorial 6). The idea is much the same in DAO:

that its modularity supports easier development and
maintenance of applications.

The disadvantage is that is you have to understand a
large part of the hierarchy before you can write your
first line of useful code. This makes using VBA diffi-
cult for beginners (even for those with considerable
experience writing programs in BASIC or other
3GLs").

14.1.1 DAO basics

Although you probably do not know it, you already
have some familiarity with the DAO hierarchy. For
example, you know that a Database object (such as
univO_v x.mdb) contains other objects such as
tables (TableDef objects) and queries (QueryDef
objects). Moving down the hierarchy, you know that
TableDef objects contain Field objects.

* Third-generation programming languages.

[ M Home | [4Previous | 1of22

Introduction: What is the DAO hierarchy?

every object has a number of properties that can be
either observed (read-only properties) or set (read/
write properties). For example, each TableDef (table
definition) object has a read-only property called
DateCreated and a read/write property called Name.
To access an object’s properties in VBA, you nor-
mally use the <object name>.<property

name> syntax, e.g.,

Employees.DateCreated

To avoid confusion between a property called
DateCreated and a field (defined by you)
called DateCreated , Access version 7.0
and above require that you use a bang (!)
instead of a period to indicate a field name or
some other object created by you as a devel-
oper. For example:
Employees!DateCreated.Value

identifies the Value property of the DateCre-
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ated field (assuming one exists) in the
Employees table.

Methods are actions or behaviors that can be
applied to objects of a particular class. In a sense,
they are like predefined functions that only work in
the context of one type of object. For example, all
Field objects have a method called FieldSize  that
returns the size of the field. To invoke a object’s

Introduction: What is the DAO hierarchy?

object summaries in the on-line help if you are
unsure.

A more obvious example of a method is the Cre-
ateField method of TableDef objects, e.g.:
Employees.CreateField("Phone”,

dbText, 25)

This creates a field called Phone, of type dbText (a
constant used to represent text), with a length of 25

methods, you use the characters.
<object name>.<method> [parameter 1)
..., parameter nl syntax, e.g.,:

DeptCode.FieldSize

14.1.3 Engines, workspaces, etc.

A confusing aspect of the DAO hierarchy is that you
cannot simply refer to objects and their properties as
done in the examples above. As Figure 14.1 illus-
trates, you must include the entire path through the
hierarchy in order to avoid any ambiguity between,
say, the DeptCode field in the Courses TableDef
object and the DeptCode field in the gryCourses
QueryDef object.

@ A reasonable question at this point might be:
Isn’t FieldSize  a property of a field, not a
method? The answer to this is that the imple-
mentation of DAO is somewhat inconsistent in
this respect. The best policy is to look at the
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14. Data Access Objects

FIGURE 14.1: Navigating the DAO hierarchy.

To access a particular field, you ‘ DBEngine ‘ @ By creating a database object at
have to understand the structure ‘ the start of your VBA
of the DAO hierarchy. programs, you bypass the top

‘ Workspaces ‘ part of the hierarchy.
[
| |
‘ Databases ‘ other classes... ‘
[
[ | [ |
TableDefs ‘ ‘ QueryDefs ‘ ‘ Recordsets ‘ ‘other classes...‘
[ [
| | | |
Courses other tables... gryCourses other queries...
Fields | Fields |
DeptCode DeptCode Legend
‘ TableDefs object or collection
Indexes ‘ Indexes ‘
Courses instance
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Working down through the hierarchy is especially
confusing since the first two levels (DBEngine and
Workspaces ) are essentially abstractions that have
no physical manifestations in the Access environ-
ment. The easiest way around this is to create a
Database object that refers to the currently open
database (e.g., univ0_v x.mdb) and start from the
database level when working down the hierarchy.

Section 14.3.1 illustrates this process for version 2.0.

14.2 Learning objectives
O What is the DAO hierarchy?

O What are objects? What are properties and
methods?

8 How do | create a reference to the current
database object? Why is this important?

a

What is a recordset object?

O How do | search a recordset?

Learning objectives

14.3 Tutorial exercises

14.3.1 Setting up a database object

In this section you will write VBA code that creates a
pointer to the currently open database.

» Create a new module called basDAOTest (see
Section 12.3.3 for information on creating a new
module).

« Create a new subroutine called PrintRecords

 Define the subroutine as follows:
Dim dbCurr As DATABASE

Set dbCurr =
DBENgine.Workspaces(0).Databases(0)

Debug.Print dbCurr.Name
¢ Run the procedure, as shown in Figure 14.2.

Let us examine these three statements one by one.

1. Dim dbCurr As DATABASE
This statement declares the variable dbCurr as
an object of type Database. For complex objects

5o0f22
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FIGURE 14.2: Create a pointer to the current database.

.- basDAOTest : Module

Ohject: I(General)

|

a2 Declare and set the point
(dbCurr ) to the current
database.

v
o Add a line to print the nam/ Eng’ Sub

of the database.

@ Although you can use the

Print statement by itself
in the debug window, you
must invoke thérint
method of the Debug object
from a module—hence the
Debug.Print  syntax.

Sub PrintRecords()

% Dim dbCurr As DATABASE
™ Sot dbCurr : DBEngine.llorkspaces(0) .Databases(0)
Debug.Print dbCurr.Name

&1 Debug YYindow

|<Ready>

PrintRecords
E:\uniu@_u?.mmi\c Run the procedure to

ensure it works.

@ Version 7.0 and above support a less
cumbersome way referring to the current
database—th€urrentDb function:
Set dbCurr = CurrentDb
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(in contrast to simple data types like integer,
string, etc.) Access does not allocate memory
space for a whole database object. Instead, it
allocates space for a pointer to a database
object. Once the pointer is created, you must set
it to point to an object of the declared type (the
object may exist already or you may have to cre-
ate it).

2. Set dbCurr = DBEngine.Work-
spaces(0).Databases(0)
(Note: this should be typed on one line). In this
statement, the variable dbCurr (a pointer to a
Database object) is set to point to the first Data-
base in the first Workspace of the only Database
Engine. Since the numbering of objects within a
collection starts at zero, Databases(0) indi-
cates the first Database object. Note that the first
Database object in the Databases collection is
always the currently open one.

Tutorial exercises

Do not worry if you are not completely sure

A what is going on at this point. As long as you
understand that you can type the above two
lines to create a pointer to your database,
then you are in good shape.

3. Debug.Print dbCurr.Name
This statement prints the name of the object to
which dbCurr refers.

14.3.2 Creating a Recordset object

As its name implies, a TableDef object does not con-
tain any data; instead, it merely defines the structure
of a table. When you view a table in design mode,
you are seeing the elements of the TableDef object.
When you view a table in datasheet mode, in con-
trast, you are seeing the contents of Recordset
object associated with the table.
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To access the data in a table using VBA, you have to
invoke the OpenRecordset method of the Data-
base object. Since most of the processing you do in
VBA involves data access, familiarity with Recordset
objects is essential. In this section, you will create a
Recordset object based on the Courses table.
 Delete the Debug.Print dbCurr.Name line
from your program.
* Add the following:
Dim rsCourses As Recordset
Set rsCourses =
dbCurr.OpenRecordset(“Courses”)
The first line declares a pointer (rsCourses )to a
Recordset object. The second line does two things:

1. Invokes the OpenRecordset method of dbCurr
to create a Recordset object based on the table
named “Courses” . (i.e., the name of the table is
a parameter for the OpenRecordset method).

Tutorial exercises

2. Sets rsCourses
recordset.

to point to the newly created

Note that this Set statement is different than the pre-
vious one since the OpenRecordset method
results in a new object being created (dbCurr points
to an existing database—the one you opened when
you started Access).

14.3.3 Using a Recordset object

In this section, you will use some of the properties
and methods of a Recordset object to print its con-
tents.
¢ Add the following to PrintRecords
Do Until rsCourses.EOF

Debug.Print rsCourses!DeptCode & “”
& rsCourses!CrsNum

rsCourses.MoveNext
Loop
e This code is explained in Figure 14.3.

8of 22
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Tutorial exercises

FIGURE 14.3: Create a program to loop through the records in a Recordset object.

- basDAOTest : Module

EOFis a property of the recordset.

Ohject I(Generﬁl)

j Proc: IE

It is true if the record counter has

Sub PrintRecords()

Dim dbCurr As DATABASE
Set dbCurr = DBEngine.lWorkspaces(0).Datab
Dim rsCourses As Recordset

Set rsCourses = dbCurr.OpenRec

Do Until rsCourses.EOF
Debug.Print rsCourses!DeptCode & " *

et("Courses”)

reached the “end of file” (EOF)
marker and false otherwise.

The exclamation mark (!) indicates
thatDeptCode is a user-defined
field (rather than a method or
property) of the recordset object.

& rsCourses!CrsNum

rsCourses.MoueNext
Loop
81 Debug Wind -
s @ of a field, you do not have to use the

Since the Value property is the default property

End Sub I(Ready)

<recordset>!<field>.Value syntax.

PrintRecords
COMM 290
COMM 291
COMM 351
MATH 407
MATH 303
CRWR 496

TheMoveNext method moves the
record counter to the next record in
the recordset.
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14.3.4 Using the FindFirst  method

In this section, you will use the FindFirst  method
of Recordset objects to lookup a specific value in a
table.
» Create a new function called MyLookUp() using
the following declaration:
Function MyLookUp(strField As
String, strTable As String,
strWhere As String) As String
An example of how you would use this function is to
return the Title  of a course from the Courses
table with a particular DeptCode and CrsNum. In
other words, MyLookUp() is essentially an SQL
statement without the SELECT FROMand WHERE
clauses.

The parameters of the function are used to specify
the name of the table (a string), the name of the field
(a string) from which you want the value, and a

Tutorial exercises

WHEREondition (a string) that ensures that only one
record is found.

For example, to get the Title  of COMM 351 from
the Courses table, you would provide MyLookUp()
with the following parameters:

1. *“Title” — a string containing the name of the
field from which we want to return a value;

2. "Course” — a string containing the name of the
source table; and,

3. “DeptCode = 'COMM’ AND CrsNum =
‘335" — a string that contains the entire
WHERE clause for the search.

Note that both single and double quotation
marks must be used to signify a string within a
string. The use of quotation marks in this
manner is consistent with standard practice in
English. For example, the sentence:

“He shouted, ‘Wait for me."” illus-
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trates the use of single quotes within double
quotes.

* Define the MyLookUp() function as follows:

Dim dbCurr As DATABASE
Set dbCurr = CurrentDb

If you are using version 2.0, you cannot use
the CurrentDb method to return a pointer to
the current database. You must use long form
(i.e., Set dbCurr = DBEngine... )

Dim rsRecords As Recordset

Set rsRecords =
dbCurr.OpenRecordset(strTable,
dbOpenDynaset)

In version 2.0, the name of some of the pre-
defined constants are different. As such, you
must use DB_ OPEN_DYNASE®Gther than
dbOpenDynaset to specify the type of

Tutorial exercises

Recordset object to be opened (the Find-
First method only works with “dynaset” type
recordsets, hence the need to include the
additional parameter in this segment of code).

rsRecords.FindFirst strWWhere

VBA uses a rather unique convention to
determine whether to enclose the arguments
of a function, subroutine, or method in paren-
theses: if the procedure returns a value,
enclose the parameters in parentheses; oth-
erwise, use no parentheses. For example, in
the line above, strWhere is a parameter of
the FindFirst  method (which does not
return a value).

If Not rsRecords.NoMatch() Then
MyLookUp =
rsRecords.Fields(strField).Value

11 of 22
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Else
MyLookUp = *"
End If
» Execute the function with the following statement
(see Figure 14.4):
? MyLookUp(“Title”, “Courses”,
“DeptCode = 'COMM' AND CrsNum =
'351")
As it turns out, what you have implemented exists
already in Access in the form of a predefined func-
tion called DLookUp() .
» Execute the DLookUp() function by calling it in
the same manner in which you called
MyLookUp() .

14.3.5 The DLookUp() function

The DLookUp() function is the “tool of last resort” in
Access. Although you normally use queries and
recordsets to provide you with the information you

Tutorial exercises

need in your application, it is occasionally necessary
to perform a stand-alone query—that is, to use the
DLookUp() function to retrieve a value from a table
or query.

When using DLookUp() for the first few times, the
syntax of the function calls may seem intimidating.
But all you have to remember is the meaning of a
handful of constructs that you have already used.
These constructs are summarized below:

e Functions — DLookUp() is a function that
returns a value. It can be used in the exact same
manner as other functions, e.g.,

X = DLookUp(...) is similar to
X = cos(2*pi)

* Round brackets () — In Access, round brackets
have their usual meaning when grouping
together operations, e.g., 3*(5+1) . Round
brackets are also used to enclose the arguments
of function calls, e.g., x = cos(2*pi)

12 of 22
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FIGURE 14.4: MyLookUp() : A function to find a value in a table.

.- basDAOTest : Module

Ohject: I(General) j Proc: IMyLnukUp

Function MyLookUp(strField As String, strTable As String, strlhere As String) As String

Dim dbCurr As DATABASE
Set dbCurr = CurrentDb

Dim rsRecords As Recordset
Set rsRecords = dbCurr.OpenRecordset

rsRecords.FindFirst strihereg
If Not rsRecords.NoMatch() Then

MyLookUp = rsRecords.Fields(strField).Ualue

TheNoMatch() method returns True if the
FindFirst  method finds no matching records,
and False otherwise.

rTable, dbOpenDynaset)

SincestrField contains the name of a valid
Field object Title ) in the Fields collection,
this notation returns the value title

Else
MyLookUp = ™"
End If

B <Feachy>
End Function I

Financial Accounting

? MyLookUp(“Title"”,"Courses”, "DeptCode = 'COMM' AND CrsHum = '351'"):§

14. Data Access Objects

e Square brackets [] — Square brackets are not
a universally defined programming construct like
round brackets. As such, square brackets have a
particular meaning in Access/VBA and this
meaning is specific to Microsoft products. Simply
put, square brackets are used to signify the name
of a field, table, or other object in the DAO hierar-
chy—they have no other meaning. Square brack-
ets are mandatory when the object names
contain spaces, but optional otherwise. For
example, [Forms]![frmCourses]![Dept-

Code] is identical to Forms!frm-
Courses!DeptCode

Quotation marks *“” — Double quotation marks
are used to distinguish literal strings from names
of variables, fields, etc. For example,

X = “COMM"means that the variable x is equal
to the string of characters COMM. In contrast,
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x = COMMneans that the variable x is equal to
the value of the variable COMM

Single quotation marks ‘' — Single quotation
marks have only one purpose: to replace normal
guotation marks when two sets of quotation
marks are nested. For example, the expression
x ="[ProductID] = ‘123" means that the
variable x is equal to the string ProductID =
“123”. In other words, when the expression is
evaluated, the single quotes are replaced with
double quotes. If you attempt to nest two sets of
double quotation marks (e.g., x = “[Produc-

tID] = “123™ ) the meaning is ambiguous
and Access returns an error.

The Ampersand & — The ampersand is the con-
catenation operator in Access/VBA and is unique
to Microsoft products. The concatenation opera-
tor joins two strings of text together into one
string of text. For example,
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X = “one” & “ _two means that the variable
X is equal to the string one_two.

If you understand these constructs at this point, then
understanding the DLookUp() function is just a mat-
ter of putting the pieces together one by one.

14.3.5.1 Using DLookUp() in queries

The DLookUp() function is extremely useful for per-
forming lookups when no relationship exists between
the tables of interest. In this section, you are going to
use the DLookUp() function to lookup the course
name associated with each section in the Sections
table. Although this can be done much easier using a
join query, this exercise illustrates the use of vari-
ables in function calls.
» Create a new query called gryLookUpTest
based on the Sections table.
* Project the DeptCode , CrsNum, and Section
fields.

Tutorial exercises

« Create a calculated field called Title  using the
following expression (see Figure 14.5):
Title: DLookUp(“Title”, “Courses”,

“DeptCode =& [DeptCode] & AND
CrsNum =" & [CrsNum] & ")

14.3.5.2 Understanding the WHERE clause

The first two parameters of the DLookUp() are
straightforward: they give the name of the field and
the table containing the information of interest. How-
ever, the third argument (i.e., the WHEREIlause) is
more complex and requires closer examination.

At its core, this WHERIElause is similar to the one
you created in Section 5.3.2 in that it contains two
criteria. However, there are two important differ-
ences:

1. Sinceitis a DLookUp() parameter, the entire
clause must be enclosed within quotation marks.
This means single and double quotes-within-
quotes must be used.
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FIGURE 14.5: Create a query that uses DLookUp() .

= Create a query based on thections
table only (do not includ€ourses ).

B Zoom

|__——

‘b Use theDLookUp() function to get the
correct course title for each section.

A

EPETTOSENEE |(AND CrsNum =" & [CrsNum] & ™)

Title: DLookUp("Title" "Gourses","DeptGode = " & [DeptGode] & " oK |

Cancel

CrsNum
Section
Session & grylookUpTest : Select Query
Cataloghium =] Department code|Course number| Section Title
| |COMM 351 aoz Financial Accourting
| | COMM 357 ao3 Financial Accounting
Field [DepCode (|| COMM 439 001 Advanced Topics in Information Systems
Takle: |Sections i |CRWR 202 ao1 Creative Forms
St CRWR 202 a01 Creative Forms
Show [ [CRWR 202 902 Creative Forms
CRWR 496 01 Poetry Tutorial
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2. It contains variable (as opposed to literal) criteria.
For example, [DeptCode] is used instead of
“COMM’. This makes the value returned by the
function call dependent on the current value of
the DeptCode field.

In order to get a better feel for syntax of the function
call, do the following exercises (see Figure 14.6):

Switch to the debug window and define two string
variables (see Section 12.3.1 for more information
on using the debug window):

strDeptCode = “COMM”

strCrsNum = “351”
These two variables will take the place the field val-
ues while you are in the debug window.

» Write the WHERIElause you require without the
variables first. This provides you with a template
for inserting the variables.

» Assign the WHERElause to a string variable
called strWhere (this makes it easier to test).

Discussion

e Use strWhere in a DLookUp() call.

14.4 Discussion

14.4.1 VBA versus SQL

The PrintRecords  procedure you created in
Section 14.3.3 is interesting since it does essentially
the same thing as a select query: it displays a set of
records.

You could extend the functionality of the Print-
Records subroutine by adding an argument and an
IF-THEN condition. For example:
Sub PrintRecords(strDeptCode as
String)
Do Until rsCourses.EOF
If rsCourses!DeptCode = strDeptCode
Then
Debug.Print rsCourses!DeptCode & “”
& rsCourses!CrsNum

17 of 22
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Discussion

FIGURE 14.6: Examine the syntax of the WHERE clause.

Create string variables that refer to valid

Write theWHERElause using literal

a values ofDeptCode andCrsNum. b criteria first to get a sense of what is
required.
Bl Debug Window
|<Ready>
" " Use the variables in the WHERE
s:rgep;cc’df .'.35?9”" - € (jause and assign the expression to a
strirsiium = string variable calledtrWhere .
"DeptCode = "COMM' AND CrsNum = '351°" /
strilhere = "DeptCode = '" & strDeptCode & " AND CrsNum = "™ & strCrsNum & """
4? strilhere
DeptCode = 'COMM’ AND CrsNum = '351° ]
d To save typing, usetrWhere as the
? DLookUp("Title”, "Courses™”, strihere) - third parameter of thBLookUp()
Financial Accounting call.

@

When replacing a literal string with a variable, you

have to stop the quotation marks, insert the variable
(with ampersands on either side) and restart the
guotation marks. This procedure is evident when the
literal and variable version are compared to each other.

18 of 22
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End If

rsCourses.MoveNext

Loop

rsCourses.Close

End Sub
This subroutine takes a value for DeptCode as an
argument and only prints the courses in that particu-
lar department. It is equivalent to the following SQL
command:

SELECT DeptCode, CourseNum FROM

Courses WHERE DeptCode =
strDeptCode

14.4.2 Procedural versus Declarative

The difference between extracting records with a
guery language and extracting records with a pro-
gramming language is that the former approach is
declarative while the latter is procedural .

Discussion

SQL and QBE are declarative languages because
you (as a programmer) need only tell the computer
what you want done, not how to do it. In contrast,
VBA is a procedural language since you must tell the
computer exactly how to extract the records of inter-
est.

Although procedural languages are, in general, more
flexible than their declarative counterparts, they rely
a great deal on knowledge of the underlying struc-
ture of the data. As a result, procedural languages
tend to be inappropriate for end-user development
(hence the ubiquity of declarative languages such as
SQL in business environments).
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14.5 Application to the assignment

14.5.1 Using a separate table to store
system parameters

When you calculated the tax for the order in

Section 9.5, you “hard-coded” the tax rate into the
form. If the tax rate changes, you have to go through
all the forms that contain a tax calculation, find the
hard-coded value, and change it. Obviously, a better
approach is to store the tax rate information in a
table and use the value from the table in all form-
based calculations.

Strictly speaking, the tax rate for each product is a
property of the product and should be stored in the
Products table. However, in the wholesaling envi-
ronment used for the assignment, the assumption is
made that all products are taxed at the same rate.

Application to the assignment

As a result, it is possible to cheat a little bit and cre-
ate a stand-alone table (e.g., SystemVariables )
that contains a single record:

Value
0.07

VariableName
GST

Of course, other system-wide variables could be
contained in this table, but one is enough for our pur-
poses. The important thing about the SystemVari-
ables table is that it has absolutely no relationship
with any other table. As such, you must use a
DLookUp() to access this information.

 Create atable that contains information about the
tax rate.

* Replace the hard-coded tax rate information in
your application with references to the value in
the table (i.e., use a DLookUp() in your tax cal-
culations). Although the SystemVariables
table only contains one record at this point, you
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should use an appropriate WHERElause to
ensure that the value for GST is returned (if no
WHERElause is provided, DLookUp() returns
the first value in the table).

The use of a table such as SystemVari-

A ables contradicts the principles of relational
database design (we are creating an attribute
without an entity). However, trade-offs
between theoretical elegance and practicality
are common in any development project.

14.5.2 Determining outstanding
backorders

An good example in your assignment of a situation
requiring use of the DLookUp() is determining the
backordered quantity of a particular item for a partic-
ular customer. You need this quantity in order to cal-
culate the number of each item to ship.

Application to the assignment

The reason you must use a DLookUp() to get this
information is that there is no relationship between
the OrderDetails and BackOrders tables.

Any relationship that you manage to create
between OrderDetails and BackOrders
will be nonsensical and result in a non-updat-
able recordset.

* In the query underlying your OrderDetails
subform, create a calculated field called QtyOn-
BackOrder to determine the number of items on
backorder for each item added to the order. This
calculated field will use the DLookUp() function.

There are two differences between this DLookUp()
and the one you did in Section 14.3.5.1

1. Both of the variables used in the function (e.g.,
CustID and ProductID ) are not in the query.
As such, you will have to use a join to bring the
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missing information into the query.

2. ProductIlD is a text field and the criteria of text
fields must be enclosed in quotation marks, e.g.:
ProductID =*“123"
However, CustiD
ria for numeric fields is not enclosed in quotations
marks, e.g.:

CustiD =4

Not every combination of CustID and Pro-
ductIlD will have an outstanding backorder.
When a matching records is not found, the
DLookUp() function returns a special value:
Null . The important thing to remember is
that Null  plus or minus anything equals

Null . This has implications for your “quantity
to ship” calculation.

» Create a second calculated field in your query to
convert any Null s in the first calculated field to

is a numeric field and the crite-

Application to the assignment

zero. To do this, use the iif() and IsNull()

functions, e.g.:

QtyOnBackOrderNoNull:
iif(IsNull([QtyOnBackOrder]),0,[Qty
OnBackOrder])

» Use this “clean” version in your calculations and
on your form.

It is possible to combine these two calculated
fields into a one-step calculation, e.g.:
iif(IsNull(DLookUp(...)),0,

DLookUp(...)) .

The problem with this approach is that the
DLookUp() function is called twice: once to
test the conditional part of the immediate if
statement and a second time to provide the
“false” part of the statement. If the Back-
Orders table is very large, this can result in
an unacceptable delay when displaying data
in the form.

22 of 22
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Access Tutorial 15;: Advanced Tri

15.1 Introduction: Pulling it all
together

In this tutorial, you will bring together several of the
skills you have learned in previous tutorials to imple-
ment some sophisticated triggers.

15.2 Learning objectives
O How do | run VBA code using a macro?

O How do | use the value in one field to
automatically suggest a value for a different
field?

O How do | change the table or query a form is
bound to once the form is already created?

O What is the After Update event? How is it
used?

O How do | provide a search capability for my
forms?

© Michael Brydon (brydon@unixg.ubc.ca)
Last update: 25-Aug-1997
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cute functions (not subroutines) you must do one of
two things before you create the macro:

1. Convert ParameterTest to a function — you do
this simply by changing the Sub at the start of the
procedure to Function

2. Create a new function that executes Parame-
terTest and call the function from the macro.

15.3.1.1 Creatin g a wrapper

Since the second alternative is slightly more interest-
ing, it is the one we will use.
» Open your basTesting

Tutorial 12.
» Create a new function called ParameterTest-
Wrapper defined as follows:

module from

Function
ParameterTestWrapper(intStart As
Integer, intStop As Integer) As
Integer

ggers

O How do | create an unbound combo box?

O Can | implement the search capability using
Visual Basic?

15.3 Tutorial exercises

15.3.1 Using a macro to run VBA code

There a some things that cannot be done using the
Access macro language. If the feature you wish to
implement is critical to your application, then you
must implement it using VBA. However, since it is
possible to call a VBA function from within a macro,
you do not have to abandon the macro language
completely.

In this section, you are going to execute the Param-
eterTest subroutine you created in Section 12.3.6
from within a macro. Since the RunCode action of
the Access macro language can only be used to exe-

10f33
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'this function calls the
ParameterTest subroutine

ParameterTest intStart, intStop

ParameterTestWrapper = True
'return a value

End Function
* Call the function, as shown in Figure 15.1.

Note that the return value of the function is
declared as an integer, but the actual assign-
ment statement is ParameterTestWrap-

per = True . Thisis because in Access/
VBA, the constants True and False are
defined as integers (-1 and O respectively).

15.3.1.2 Using the RunCode action
» Leave the module open (you may have to resize
and/or move the debug window) and create a
new macro called mcrRunCodeTest .

20f33
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FIGURE 15.1: Create a function that calls the ParameterTest subroutine.

- basTesting : Module
Ohject I(General] j Proc; IParﬁmeterTesMrapper

Function ParameterTestWrapper(intStart As Integer, intStop As Integer)
"this function calls the ParameterTest subroutine
ParameterTest intStart, intStop

ParameterTestliggpper = True ‘return a value
End Function
H Debug YWindow

=2 Create a function to call |<F79ady,
the ParameterTest
subroutine. ? ParameterTestlWrapper(18,15)

Loop number: 10
Loop number: 11

Use thePrint  statement to

@ SinceParameterTest Loop number: 12 invoke the function (do not forget
does not return a value }é Loop number: 13 th
, e parameters).

arguments are not in Loop number: 14
brackets. Loop number: 15
All done

Tree @«— The return value of
ParameterTestWrapper()
is True, so this is printed when
the function ends.

o] [mme] 5o
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» Add the RunCode action and use the expression » Select Run > Start to execute the macro as
builder to select the correct function to execute, shown in Figure 15.3.

as shown in Figure 15.2.
15.3.2 Using activity information to

f The expression builder includes two parame- determine the number of credits
ter place holders (<<intStart>> and

<<intStop>> ) in the function name. These
are to remind you that you must pass two

In this section, you will create triggers attached to the
After Update event of bound controls.

parameters to the ParameterTestWrap- 15.3.2.1 Scenario
per() function. If you leave the place holders  Assume that each type of course activity is generally
where they are, the macro will fail because associated with a specific number of credits, as
Access has not idea what <<intStart>> shown below:
and <<intStop>> refer to. Activity Credits
» Replace the parameter place holders with two lecture 3.0

numeric parameters (e.g. 3 and 6). Note that in lab 30

general, the parameters could be field names or tutorial 10

any other references to Access objects contain- .

ing (in this case) integers. seminar 6.0
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FIGURE 15.2: Use the expression builder to select the function to execute.

Add aRunCode
a action to the macro.

' Expression Builder

# mcrRunCodeTest : Macrg
| Action

E‘RunCude

FarameterTestWrapper («intStarts, «intStops:)

+-;*|ﬂ=><<>| nd Or Mot Like| ( )]

Function Marme

vV

(=] Functions
I:tl Built-ln Functions
=

|bas DADTest

basltilities

Note the<<intStart>> and
<<intStop>> parameter place
holders. These must be replaced
with expressions that Access
understands.

ParameterTestWrapper(intStart, intStop)

‘b Use the expression builder to drill
down to the user-defined functions in
your database file.

50f33
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FIGURE 15.3: Execute the RunCode macro.

# mcrRunCodeTest : Macro
I Action

| » |RunCode

Function MNarne

ParameterTesti'rapper (3, B)

B Debug Window

I<Ready>

Loop number: 3
a2 Replace the Loop number: Y4
parameter place | Loop number: 5
holders. Loop number: 6

= All deone

‘b SelectRun > Start (or press théicon in
the tool bar) to execute the macro.

[ M Home | [4Previous |
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Assume as well that the number of credits for a par-
ticular type of course is not cast in stone. As such,
the numbers given above are merely “default” val-
ues.

You want to use the default credit values when you
create a new course or modify an existing course.
However, the user may override this default if neces-
sary for a particular course. The basic requirement is
illustrated in Figure 15.4.

15.3.2.2 Designing the trigger

Based on the foregoing, the answer to the “what”
question is the following:

1. Look up the default number of credits associated
with the course activity showing in the form’s
Activity field.

2. Copy this number into the Courses.Credits
field.

6 0f 33
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FIGURE 15.4: Inserting a default value into a new record.

Create a new record for a lecture-based
course: COMM 437: Database Technology

H Courses
L Department |COMM
Course number: |43?
Title: |Database Technology
Activity W—_,
Credits: |

Since this is a new record, the default
value ofCredits  (like any numeric
field) is zero. You want to use the
information you just specified in the
Activity field to automatically

look up the correct default number of
credits for a lecture course and insert
it in theCredits field.

=2 Create a macro to find the default number
of credits and copy the value it into the
Credits field.

Select “Lecture” from the list of list of
course activities created Trutorial 8.

Activity | Description | Credits

e Lab 30
LEC Lecture 3.0

C

0
/ | |SEM Seminar 0
| TUT Tutoriag 1.0

0.0

d Once théActivity field is updated, the

macro executes. The value in the
Credits
user.

field can be changed by the

7 of 33
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There are several possible answers to the “when”
guestion (although some are better than others). For
example:

1. When the user enters the Credits field (the On
Enter event for Credits ) — The problem with
this choice is that the user could modify the
course’s activity without moving the focus to the

Activity field. In such a case, the trigger would
not execute.

2. When the user changes the Activity field (the
After Update event for Activity ) — This choice

guarantees that whenever the value of Activ-
ity is changed, the default value will be copied
into the Credits field. As such, it is a better
choice.

15.3.2.3 Preliminary activities
* Modify the Activities table to include a single-
precision numeric field called Credits . Add the
values shown in the table in Section 15.3.2.1.

Tutorial exercises

« Ensure that you have a courses form (e.g., frm-
Courses ) and that the form has a combo box for
the Activity  field. You may wish to order the
fields such that Activity precedes Credits in
the tab order (as shown in Figure 15.4).

é If your move fields around, remember to
adjust the tab order accordingly (recall
Section 8.3.4).

15.3.2.4 Looking up the default value

As you discovered in Section 14.3.5, Access has a
DLookUp() function that allows you to go to the
Activities table and find the value of Credits

for a particular value of Activity . A different
approach is to join the Activities table with the
Courses table in a query so that the default value of
credits is always available in the form. This is the
approach we will use here.

8 of 33

[ M Home | |[4Previous |




15. Advanced Triggers Tutorial exercises

» Ensure you have a relationship (in the main rela-
tionship window) between Courses.Activity
and Activities.Activity

 Create a new query called gryCoursesAnd- & gryCoursesAndCredits : Select Query
Credits based on the Courses and Activi-
ties tables (see Figure 15.5).

FIGURE 15.5: Use a join to make the default
value available.

@ Notice that you have two credits fields:
Courses.Credits (the actual number of
credits for the course) and Activi-

ties.Credits (the “default” or “suggested”
number of credits based on the value of _ :
.. Field: | Courses* Credits

Activity ). Access uses the <table Tahle: [Courses Aciviios

name>.<field name>  notation whenever a SE i qryCoursesAndCredits - Select Query

guery contains more than one field with the Crite| | Courses.Credits | Activities.Credits| Departr

same name. ia 2 3 MUSC

= 3 3 COMM

Since you already have forms based on the - i g ggmm
Courses table that expect a field called Credits — 3 3 MATH

(rather than one called Courses.Credits ), itisa o
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good idea to rename the Activities.Credits
field in the query. You do this by creating a calculated
field.

* Rename Activities.Credits to Default-
Credits as shown in Figure 15.6. Note that this
eliminates the need for the <table
name>.<field name> notation.

FIGURE 15.6: Rename one of the Credits fields.

! gryCoursesAndCredits | Select Query

15.3.2.5 Changing the Record Source of the
form

Rather than create a new form based on the qgry-

CoursesAndCredits guery, you can modify the Field: [ Courses* DefaultCradits: Credits

Record Source property of the existing frmCourses Teble | Courses il

form so it is bound to the query rather than the Show = e 'D;f'aultc':eait; ' Depz

Courses table. o | [P 3 3 MUSC

» Bring up the property sheet for the frmCourses 3 3/ COMM

form and change the Record Source property to 4 3 COMM
gryCoursesAndCredits as shown in 3 3| COMM
Figure 15.7. =2 RenameCredits  form theActivities

table toDefaultCredits
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FIGURE 15.7: Change the Record Source
property of an existing form.

Bring up the form’s property list and

A change itdRecord Source property.
E |1|-2N-\3-|-4-|-5-|5|7|3|
j # Detail s Form
- || |[Depafiment FDrmatl Data ) Ewvent I Other All |
1 !Cour E pumbar Fecord Source . gryCoursesAndCredits |
- : Filter............. ..
- OrderBy...........
: mj AIIDW Filters ... ... Ves
- Caption ............ Courses
Credita DefaultVWiew ... ..., Single Form
Wiews Allowed . ... Both
=l Course...
= IS Allow Edits ... . Ves
DeptZode Allow Deletions ... res
Crshlum Allow Additions ... Yes
Title _ Data Entry .. ....... Mo
|| Eredits Fecordset Type ... Dynaset
Activity Recard Locks ... Mo Locks

DefaultCredits ScrollBars . ..., .. Both

@ The field list now contains all
N the fields in the new query.

Tutorial exercises

The advantage of using a join query in this manner is
that DefaultCredits is now available for use
within the form and within any macros or VBA mod-
ules that run when the form is open.

15.3.2.6 Creating the SetValue macro
The SetValue macro you require here is extremely

simple once you have DefaultCredits available
within the scope of the form.
 Create the mcrCourses.SetCredits macro
as shown in Figure 15.8.
15.3.2.7 Attaching a procedure to the After

Update event

The On Click event of a button is fairly simple to
understand: the event occurs when the button is
clicked. The events associated with non-button
objects operate in exactly the same way. For exam-
ple, the After Update event for controls (text box,
combo box, check box, etc.) occurs when the value

11 of 33
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FIGURE 15.8:; Create the SetValue macro.

= Create a macro group callettrCourses
and a named macro call&&tCredits
# mcrCourses : Macro

tMacro Mame
P |SetCredits

Action
Setvalue

[tem [Credits]

Expression/( [DefaultCredits]

You can use the builder to set the arguments
or simply type in the names of the fields.

To

of the control is changed by the user. As a result, the
After Update event is often used to trigger data verifi-
cation procedures and “auto-fill” procedures like the

one you are creating here.

[ M Home | [4Previous |

Tutorial exercises

* Attach the mcrCourses.SetCredits
the After Update event of the Activity
* Verify that the trigger works properly.

macro to
field.

15.3.3 Use an unbound combo box to
automate search

As mentioned in Tutorial 8, a combo box has no
intrinsic search capability. However, the idea of scan-
ning a short list of key values, selecting a value, and
having all the information associated with that record
pop on to the screen is so basic that in Access ver-
sion 7.0 and above, this capability is included in the
combo box wizard. In this tutorial, we will look at a
couple of different means of creating a combo boxes
for search from scratch.

15.3.3.1 Manual search in Access

To see how Access searches for records, do the fol-
lowing:

¢ Open your frmDepartments ~ form.

12 0f 33
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» Move to the field on which you want to search
(e.g., DeptCode );

« Select Edit > Find (or press Control-F);

* Fill out the search dialog box as shown in
Figure 15.9.

In the dialog box, you specify what to search for
(usually a key value) and specify how Access should
conduct its search. When you press Find First,
Access finds the first record that matches your
search value and makes it the current record (note
that if you are searching on a key field, the first
matching record is also the only matching record).

15.3.3.2 Preliminaries

To make this more interesting, assume that the frm-
Departments form is for viewing editing existing
departmental information (rather than adding new
departments). To enforce this limitation, do the fol-
lowing:

* Set the form’s Allow Additions property to No.

Tutorial exercises

» Set the Enabled property of DeptCode to No (the
user should never be able to change the key val-
ues of existing records).

15.3.3.3 Creating the unbound combo box

The key thing to remember about the combo box
used to specify the search criterion is that it has
nothing to do with the other fields or the underlying
table. As such, it should be unbound.
* Create an unbound combo box in the form
header, as shown in Figure 15.10.
» Change the Name property of the combo box to
cboDeptCode .
* The resulting combo box should resemble that
shown in Figure 15.11.

When you create an unbound combo box,
Access gives it a default name (e.g.,
Combob). You should do is change this to
something more descriptive (e.g., cboDept-
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FIGURE 15.9: Search for a record using the “find” dialog box.

B Departments

Deparment code ICOMM

Move the cursor to

A

M= E3

the field you wish to
search and invoke
the search box
usingControl-F.

Building |ANGU
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Depatment e |Commerce and Business Administr

Find in field: 'Department cod'

Update Credits |

¥ Credits updated?
[ 2] %]

Find First

Find VWhaggy [MUSC
Enter the value you wish to fiM
and set the other search garch: Al

j " Match Case
" Search Fields As Formatted

parameters as required.
katch:

imi & Departments
Limit the search to the current EECIEE

field (i.e., the field with the
focus when the search box was
opened).

Department

Pres<=ind First to move to the first
(or only) record that matches the
search condition.

[Whole Field

[ —
Department co de IMUSC

Building IMUSC

Close |

¥ Search Only Current Field

Update Credits |

[} IMusic

5 updated?

» |H|P¥| of 7

14 of 33

[ M Home | |[4Previous |




15. Advanced Triggers Tutorial exercises

FIGURE 15.10: Create an unbound combo box.

a2 Drag the separator for the detail EERIIN EUTIIERISIT [=] E3
down to make room in the form [ s s et r e e i A
header ;‘
_ ﬁarc fDrad}epartmEmHUanund j
| | |
# Detail

‘b Create an unbound combo box by |
selecting the combo box tool and[—
clicking in the header area, ~ —f|= | (DoPiment gode|[Depte

1 {Dcpu‘u..c..t.._A....:HDeptName — LUpdate Credits I—

} ; - | Building IEiuiIdin- W |Credits ipdated? |
C Use the wizard in the usual way || - |

to get a list of validDeptCode SRR
VEILES Sl GEECBIENS, TG
bound column for the combo box
should beDeptCode 5 Microsoft Access can store the selected value from wour combo box
invour database, or remember the value so you can use it [ater ta
perform a task.
Since the combo box is unbound e = __gp- * Rememberthe value for later use.
its value has to be stored for latef—T{ims s " Store that value in this field: -]
use rather than stored in a field. K !
i o v
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15.3.3.4 Automating the search procedure
using a macro

When we implement search functionality with a

combo box, only two things are different from the
manual search in Figure 15.9:

FIGURE 15.11: An unbound combo box.

RN e R W= R =TaE=tu =] (o mmerce and Business Administration|iig

{BasketWeaving

1. the search dialog box does not show up, and
2. the user selects the search value from the combo
box rather than typing it in.

Creative Writing
Education
English

tath

husic

The basic sequence of actions, however, remains
Although theDeptCode column hasbeen  the same. As a result, the answer to the “what” ques-
hidden, itis the “bound” column. As aresult, . . he following:

the value of the combo box as it appears here 110N I the following:

is “COMM?”, not “Commerce and ...” 1. Move the cursor to the DeptCode field (this
allows the “Search Only Current Field” option to
Code). The advantage of the prefix cbo is be used, thereby drastically cutting the search
that it allows you to differentiate between the time).
bound field DeptCode and the unbound 2. Invoke the search feature using the current value
combo box. of cboDeptCode as the search value.
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3. Move the cursor back to cbhoDeptCode or some
other field.

The only problem with this procedure is that the
DeptCode text box is disabled. As a result, you must
include an extra step at the beginning of the macro
to set its Enabled property to Yes and another at the
end of the macro to return it to its original state.

* Create a new macro called mcrSearch.Find-
Department

» Use the SetValue action to set the Dept-
Code.Enabled property to Yes. This can be
done using the expression builder, as shown in
Figure 15.12.

» Use the GotoControl  action to move the cursor
to the DeptCode text box. Note that this action
will fail if the destination control is disabled.

» Use the FindRecord action to implement the
search as shown in Figure 15.13.

Tutorial exercises

FIGURE 15.13: Fill in the arguments for the
FindRecord action.

= Create a named macro called
mcrSearch.FindDepartment

# mcr3earch - Macro

Macro Mame Action
FindDeparment | Setvalue enable the DeptCode field
GoToContral mowe to the DeptCode field
FindRecord search
Action Arguments
Find Yhat =[choDeptCode] Walue
tatch YWhole Field
hatch Case Mo A 5
T Al SinceValue is
Search Az Farmated Mo the default
Only Current Fiel ‘Yes property, its use
Find First ‘es Is optional_

b Enter the action arguments. Do not forget the
equals sign before the name of the combo box.

15. Advanced Triggers
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FIGURE 15.12: Use the builder to specify the name of the property to set.

' Expression Builder

To set thdtem argument, use the
a o

expression builder to drill down Forms![frmDepanments][choDeptCode].Enabled ;l
to the correct form. Cancel |
;l Undao |
@ The middle pane shows all the - *| 8] = > < of And or Not like| (3] _Easte | Helo |
objects on the form including
labels and buttons (hence the ——= T#bles =l b Default/alue [
df d . ® Queres <Field List> Displayvvhen
nee OI’- a gooa naming &EF Search for a deparme
conventlon). nrms choDeptCaode EwgntProcPrefix
(1 Loaded Forms DeptCods Label FelbEald [
(W e 171 D it its DeptCode Fipntlitalic
‘b Select the unbound combo box & Al Forms Depthame Laoel Ponilame
o =] antslZe
(CbODept_COde ) from_the middle Ep. uilding Lakel FontUnderline
pane. A list of properties for the | pPFund _ILI Building Font/eight
selected object is displayed in the [«] J v | |omdUpdateCredits =] |ForeColor =

pane on the right.

[ M Home | [4Previous | 180733




15. Advanced Triggers

AN

Access interprets any text in the Find What
argument as a literal string (i.e., quotation
marks would not be required to find COMM To
use an expression (including the contents of a
control) in the Find What argument, you must
precede it with an equals sign (e.g.,
=[cboDeptCode]

* You cannot disable a control if it has the focus.
Therefore, include another GotoControl  action
to move the cursor to cboDeptCode before set-
ting DeptCode.Enabled = No

 Attach the macro mcrSearch.FindDepart-
ment to the After Update event of the cboDept-
Code combo box.

 Test the search feature.

Tutorial exercises

15.3.4 Using Visual Basic code instead of

a macro

Instead of attaching a macro to the After Update
event, you can attach a VBA procedure. The VBA
procedure is much shorter than its macro counter-
part:

1.

a copy (clone) of the recordset underlying the
form is created,

the FindFirst ~ method of this recordset is used
to find the record of interest.

the “bookmark” property of the clone is used to
move to the corresponding bookmark for the
form.

To create a VBA search procedure, do the following:

» Change the After Update event of cboDeptCode

to “Event Procedure”.
Press the builder (=) to create a VBA subrou-
tine.

[ M Home | [4Previous | 190133
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* Enter the two lines of code below, as shown in
Figure 15.14.
Me.RecordsetClone.FindFirst
“DeptCode =" & cboDeptCode & “”
Me.Bookmark =
Me.RecordsetClone.Bookmark
This program consists of a number of interesting ele-
ments:

» The property Merefers to the current form. You
can use the form's actual name, but Meis much
faster to type.

» A form’s RecordsetClone  property provides a
means of referencing a copy of the form's under-
lying recordset.

* The FindFirst method is straightforward. It
acts, in this case, on the clone.

» Every recordset has a bookmark property that
uniquely identifies each record. A bookmark is
like a “record number”, except that it is stored as

Application to the assignment

a non-human-readable data type and therefore is
not of much use unless it is used in the manner
shown here. Setting the Bookmark property of a
record makes the record with that bookmark the
current record. In the example above, the book-
mark of the records underlying the form is set to
equal the bookmark of the clone. Since the clone
had its bookmark set by the search procedure,
this is equivalent to searching the recordset
underlying the form.

15.4 Application to the assignment

15.4.1 Triggers to help the user

e Create a trigger on your order form that sets the
actual selling price of a product to its default
price. This allows the user to accept the default
price or enter a new price for that particular trans-
action (e.g., the item could be damaged). You will

20 of 33
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FIGURE 15.14: Implement the search feature using a short VBA procedure.

& Combo Box: cboDeptCode

= Change thé\fter Update event to
reference an event procedure.

Farmat | Diata | Ewent | Other All |

Before Update .. . .. ;l

pterpoatE o el ] Press the builder button to invoke the VBA
n Change ......... [Ewent Procedure] \ di

On Notin List. ... merCourses [ I editor.

OnEnter ... ... mcrCourses. SetCradits

OnExit.. ... merSearch :

O Gzt Faocus .. mcrSearch FindDepart c Access automatlcally names the

mecrlJpdateCredits
mcrUpdateCredits. Che

subroutine. Enter the two lines of code.

8: gll;cl:ll(;llck """" merlJpdateCradits. Upc +
Ui . Form_frmDepartments : Module
Ohject: IchnDEptCude } j Proc: IAﬂerUpdﬁte j
Private Sub choDeptCode_AfterUpdate() -
Me.RecordsetClone.FindFirst "DeptCode = '" & cboDeptCode & """

End Sub

Me .Bookmark = Me.RecordsetClone.Bookmark
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have to think carefully about which event to
attach this macro to.

* Create a trigger on your order form that calcu-
lates a suggested quantity to ship and copies this
value into the quantity to ship field. The sug-
gested value must take into account the amount
ordered by the customer, any outstanding backo-
rders for that item by that customer, and the cur-
rent quantity on hand (you cannot ship what you
do not have). The user should be able to override
this suggested value. (Hint: use the MinValue()
function you created in Section 12.5.)

* Provide you customer and products forms with
search capability.

15.4.2 Updating the BackOrders table

Once a sales order is entered into the order form, it
is a simple matter to calculate the amount of each
product that should be backordered (you did this in

[ M Home | [4Previous | 210733
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Section 10.4). The problem is updating the Back-
Orders table itself because two different situations
have to be considered:

1. Arecord for the particular customer-product
combination exists inthe  BackOrders table --
If a backorder record exists for a particular cus-
tomer and a particular product, the quantity field
of the record can be added-to or subtracted-from
as backorders are created and filled.

2. A customer-product record does not exist in
the BackOrders table -- If the particular cus-
tomer has never had a backorder for the product
in question, then there is no record in the Back-
Orders table to update. If you attempt to update
a nonexistent record, you will get an error.

What is required, therefore, is a means of determin-
ing whether a record already exists for a particular
customer-product combination. If a record does
exist, then it has to be updated,; if a record does not
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exist, then one has to be created. This is simple
enough to talk about, but more difficult to implement
in VBA. As a result, you are being provided with a
shortcut function called UpdateBackOrders()

that implements this logic.

The requirements for using the UpdateBackO-
rders()  function are outlined in the following sec-
tions:

15.4.2.1 Create the pqryltemsToBackOrder
query

If you have not already done so, create the pgry-

ltemsToBackOrder query described in

Section 10.4. The UpdateBackOrders() proce-

dure sets the parameter for the query and then cre-

ates a recordset based on the results.

f If you did not use the field names OrderID
and ProductID in your tables, you must use
the calculated field syntax to rename them

Application to the assignment

(see Section 15.3.2.4 to review renaming
fields in queries).

Note that if the backordered quantity is positive,
items are backordered. If the backordered quantity is
negative, backorders are being filled. If the backor-
dered quantity is zero, no change is required and
these records should no be included in the results of
the query.

15.4.2.2

Import the Visual Basic for Applications (VBA) mod-

ule containing the code for the

UpdateBackOrders() function. This module is

contained in an Access database called

BOSC_W.mdb that you can download from the

course home page.

*« BOSC_V2.mdbis for those running Access ver-

sion 2.0. To import the module, select File >

Import the shortcut function
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Import, choose BOSC_V2.mdh and select Mod-
ule as the object type to import.

* BOSC_V7.mdbis for those running Access ver-
sion 7.0 or higher. To import the module, select
File > Get External Data > Import, choose
BOSC_V7.mdh and select Module as the object
type to import.

15.4.2.3 Use the function in your application
The general syntax of the function call is:
UpdateBackOrders(OrderID, CustomerID)

The OrderID and CustomerID are arguments and
they both must be of the type Long Integer. If this
function is called properly, it will update all the backo-
rdered items returned by the parameter query.

15.4.2.4 Modifying the UpdateBackOrders()
function

The UpdateBackOrders() function looks for spe-
cific fields in three tables: BackOrders , Custom-

Application to the assignment

ers , and Products . If any of your tables or fields
are named differently, an error occurs. To eliminate
these errors, you can do one of two of things:

1. Edit the VBA code. Use the search-and-replace
feature of the module editor to replace all
instances of field names in the supplied proce-
dures with your own field names. This is the rec-
ommended approach, although you need an
adequate understanding of how the code works
in order to know which names to change.

2. Change the field names in your tables (and all
queries and forms that reference these field
names). This approach is not recommended.

15.4.3 Understanding the
UpdateBackOrders() function
The flowchart for the UpdateBackOrders() func-

tion is shown in Figure 15.15. This function repeat-
edly calls a subroutine, BackOrderltem , which

24 0f 33
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updates or adds the individual items to the BackO-
rders table. The flowchart for the BackOrderltem
subroutine is shown in Figure 15.16.

There are easier and more efficient ways of imple-
menting routines to update the BackOrders table.
Although some amount of VBA code is virtually inev-
itable, a great deal of programming can be elimi-
nated by using parameter queries and action
gueries. Since queries run faster than code in
Access, the more code you replace with queries, the
better.

To get full marks for the backorders aspect of
the assignment, you have to create a more
elegant alternative to the shortcut supplied
here.

15. Advanced Triggers

Application to the assignment

FIGURE 15.15: Flowchart for

UpdateBackOrders()

run pqgryltemsToBackOrder
to get list of items to backorder

is
the list
empty?

yes

error message

no

do until end of list

Y

call BackOrderltems
(CustID,ProductID,Qty)
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FIGURE 15.16: Flowchart for the BackOrderltem subroutine.

search BackOrders table for
matching CustiD & ProductID

yes
update Qty

no

check Customer table to
ensure valid CustID

no
error message

Lyes

check Products table to
ensure valid ProductID

error message

yes

add new record with
CustlD , ProductlD & Qty
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15.4.4 Annotated source code for the
backorders shortcut module.

In the following sections, the two procedures in the
shortcut module are examined. In each case, the
code for the procedure is presented followed by
comments on specific lines of code.

15.4.4.1 The UpdateBackOrders()

Function UpdateBackOrders(ByVal
IngOrdID As Long, ByVal IngCustID As
Long)

Set dbCurr = CurrentDb

Dim rsBOltems As Recordset

dbCurr.QueryDefs!pgryltemsToBackOrder.
Parameters!pOrderID = IngOrdID

Set rsBOltems =
dbCurr.QueryDefs!pgryltemsToBackOrder
.OpenRecordset()

If rsBOItems.RecordCount = 0 Then

function

Application to the assignment

MsgBox “Back order cannot be processed:
order contains no items”

Exit Sub

End If

Do Until rsBOItems.EOF

Call BackOrderltem(IngCustID,
rsBOIltems!ProductID, rsBOIltems!Qty)

rsBOIltems.MoveNext
Loop
rsBOltems.Close

End Function

15.4.4.2 Explanation of the
UpdateBackOrders()

Function UpdateBackOrders(ByVal IngOr-

dID As Long, ByVal IngCustID As Long) —
This statement declares the function and its parame-
ters. Each item in the parameter list contains three
elements: ByVal or ByRef (optional), the variable's
name, and the variable's type (optional). The ByVal

function
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keyword simply means that a copy of the variables
value is passed the subroutine, not the variable
itself. As a result, variables passed by value cannot
be changed by the sub-procedure. In contrast, if a
variable is passed by reference (the default), its
value can be changed by the sub-procedure.

Set dbCurr = CurrentDb — Declaring a vari-
able and setting it to be equal to something are dis-
tinct activities. In this case, the variable dbCurr
(which is declared in the declarations section) is set
to point to a database object. Note that the database
object is not created, it already exists.

CurrentDb is a function supported in Access ver-
sion 7.0 and higher that returns a reference to the
current database. In Access version 2.0, this function
does not exist and thus the current database must
be found by starting at the top level object in the
Access DAO hierarchy, as discussed in

Section 14.3.1.

Application to the assignment

Dim rsBOltems As Recordset — In this decla-
ration statement, a pointer to a Recordset object is
declared. This recordset contains a list of all the
items to add to the BackOrders table.

dbCurr.QueryDefs!pgryltemsToBackOrder
.Parameters!pOrderID = IngOrdID — This
one is a bit tricky: the current database (dbCurr )
contains a collection of objects called QueryDefs
(these are what you create when you use the QBE
guery designer). Within the collection of QueryDefs,
there is one called pqgryltemsToBackOrder

(which you created in Section 15.4.2.1).

Within every QueryDef, there is a collection of zero
or more Parameters . In this case, there is one called
pOrderID and this sets the value of the parameter
to the value of the variable IngOrderID  (which was
passed to the function as a parameter).

Set rsBOItems = dbCurr.QueryDefs!pqry-

IltemsToBackOrder.OpenRecordset() — Here
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is another set statement. In this one, the variable
rsBOIltems is set to point at a recordset object.
Unlike the current database object above, however,
this recordset does not yet exist and must be created

by running the pgryltemsToBackOrder parame-
ter query.
OpenRecordset is a method that is defined for

objects of type TableDef or QueryDef that creates an
image of the data in the table or query. Since the
guery in question is a parameter query, and since the
parameter query is set in the previous statement, the
resulting recordset consists of a list of backordered
items with an order number equal to the value of
pOrderID .

If rsBOltems.RecordCount =0 Then — The
only thing you need to know at this point about the
RecordCount property of a recordset is that it returns
zero if the recordset is empty.

Application to the assignment

MsgBox “Back order cannot be processed:

order contains no items” — The MsgBox
statement pops up a standard message box with an
Okay button in the middle.

Exit Sub — If this line is reached, the list contains
no items. As such, there is no need to go any further
in this subroutine.

EndIf — The syntax for If... Then... Else... state-
ments requires an End If  statement at the end of
the conditional code. That is, everything between the
If andthe End If executes if the condition is true;
otherwise, the whole block of code is ignored.

Do Until rsBOItems.EOF — The EOFproperty

of a recordset is set to true when the “end of file” is
encountered.

Call BackOrderltem(IngCustID, rsBOI-
tems!ProductID, rsBOItems!Qty) — A sub-
routine is used to increase the modularity and
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readability of this function. Note the way in which the
current values of ProductID and Qty from the
rsBOltems Recordset are accessed.

rsBOltems.MoveNext — MoveNext is a method
defined for recordset objects. If this is forgotten, the
EOFcondition will never be reached and an infinite
loop will be created. In VBA, the Escape key is usu-
ally sufficient to stop an infinite loop.

Loop — All Do While /Do Until
with the Loop statement.

loops must end

rsBOltems.Close = — When you create a new
object (such as a Recordset using the Open-
Recordset method), you should close it before exit-
ing the procedure. Note that you do not close
dbCurr because you did not open it.

— All functions/subroutines need
/End Sub statement.

End Function
an End Function

Application to the assignment

15.4.4.3 The BackOrderltem() subroutine

Sub BackOrderltem(ByVal IngCustID As
Long, ByValstrProdID As String, ByVal
intQty As Integer)

Set dbCurr = CurrentDb

Dim strSearch As String

Dim rsBackOrders As Recordset

Set rsBackOrders =
dbCurr.OpenRecordset(“BackOrders”,
dbOpenDynaset)

strSearch ="CustID =“ & IngCustID & “
AND ProductID =™ & strProdID &

rsBackOrders.FindFirst strSearch

If rsBackOrders.NoMatch Then

Dim rsCustomers As Recordset

Set rsCustomers =
dbCurr.OpenRecordset(“Customers”,
dbOpenDynaset)

strSearch = “CustID =* & IngCustID

rsCustomers.FindFirst strSearch
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If rsCustomers.NoMatch Then

MsgBox “An invalid Customer ID number
has been passed to BackOrderltem”

Exit Sub
End If
Dim rsProducts As Recordset

Set rsProducts =
dbCurr.OpenRecordset(“Products”,

dbOpenDynaset)
strSearch =“ProductID =" & strProdID
& wm

rsProducts.FindFirst strSearch
If rsProducts.NoMatch Then

MsgBox “An invalid Product ID number
has been passed to BackOrderltem”

Exit Sub

End If

rsBackOrders.AddNew
rsBackOrders!CustID = IngCustID
rsBackOrders!ProductID = strProdID

Application to the assignment

rsBackOrders!Qty = intQty

rsBackOrders.Update

Else

rsBackOrders.Edit

rsBackOrders!Qty = rsBackOrders!Qty +
intQty

rsBackOrders.Update

End If

End Sub

15.4.4.4 Explanation of the BackOrderltem()
subroutine

Since many aspects of the language are covered in
the previous subroutine, only those that are unique
to this subroutine are explained.

Set rsBackOrders = dbCurr.OpenRecord-
set(“BackOrders”, dbOpenDynaset) — The
OpenRecordset method used here is the one
defined for a Database object. The most important
argument is the source of the records, which can be
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a table name, a query name, or an SQL statement.
The dbOpenDynaset argument is a predefined con-
stant that tells Access to open the recordset as a
dynaset. You don't need to know much about this
except that the format of these predefined constants
is different between Access version 2.0 and version
7.0 and higher. In version 2.0, constants are of the
form: DB_OPEN_DYNASET

strSearch = “CustID = "& IngCustID & “

AND ProductID =" & strProdID & “" —
A string variable has been used to break the search
process into two steps. First, the search string is
constructed; then the string is used as the parameter
for the FindFirst ~ method. The only tricky part here
is that IngCustID is along integer and strProdID

is a string. The difference is that the value of str-
ProdID has to be enclosed in quotation marks when
the parameter is passed to the FindFirst method. To

Application to the assignment

do this, single quotes are used within the search
string.

rsBackOrders.FindFirst strSearch —
FindFirst is a method defined for Recordset
objects that finds the first record that meets the crite-
ria specified in the method's argument. Its argument
is the text string stored in strSearch

If rsBackOrders.NoMatch Then — The
NoMatch property should always be checked after
searching a record set. Since it is a Boolean variable
(True / False) it can be used without an comparison
operator.

rsBackOrders.AddNew — Before information can
be added to a table, a new blank record must be cre-
ated. The AddNewmethod creates a new empty
record, makes it the active record, and enables it for
editing.
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rsBackOrders!CustID = IngCustID — Note
the syntax for changing a variable’s value. In this
case, the null value of the new empty record is
replaced with the value of a variable passed to the
subroutine.

rsBackOrders.Update — After any changes are
made to a record, the Update method must be
invoked to “commit” the changes. The AddNew /
Edit and Update methods are like bookends
around changes made to records.

rsBackOrders.Edit — The Edit method allows
the values in a record to be changed. Note that these
changes are not saved to the underlying table until
the Update method is used.
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